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Introduction

son (you are looking at the right book, after all), but it seems like

technology evolves faster than we do. Even the magical Mac — the
symbol of all things easy in the computer world — is chock full of features
and gadgets and bells and whistles and pretty lights. (Okay, the lights are
on the outside, but . . .) Make no mistake: You'll love these things, once
you know what they all are and how to use them, that is. So the question
is How do I get from point A (merely having the features) to point B (doing
what I want/need to do, quickly and easily)?

We’re fairly smart people, and presumably you're a really smart per-

By reading this book, of course!

But if that isn’t enough to convince you (and we can’t imagine why not;
after all, we've never lied to you before), take a moment or two to read
through this introduction. We tell you where we're coming from, what this
book offers, and how it’ll make you fall in love with your Mac all over again.

Saving Time with This Book

The Timesaving Techniques For Dummies books focus on high-payoff tech-
niques that save you time, either immediately or over the long haul. And
these books get to the point in a hurry, with step-by-step instructions to
take you through the tasks you need to do, without any of the fluff you
don’t want. We've identified more than 60 techniques that Mac OS X Tiger
users need to know to make the most of their computers. In addition, each
technique includes lots of figures that make following along a breeze.
Decide for yourself how to use this book: Read it cover to cover if you
like, or skip right to the technique that interests you the most.

In Mac OS X Tiger Timesaving Techniques For Dummies, you can find out
how to

v Tame time-consuming tasks: Because we demystify the inner workings
of Mac OS X Tiger for you, letting you in on more than 60 tips and
tricks along the way, you can spend more time making computer magic
and less time fussing around.

v Take your skills up a notch: You're already familiar with the basics of
using Mac OS X. Now this book takes you to the next level, helping you
become an even savvier Mac user. The things you'll discover will amaze
your friends, scare your enemies, and duly impress your boss.



2 Introduction

v Customize Mac OS X to meet your needs:
Spending some upfront time customizing Mac OS
X so that it works faster, more reliably, and more
like how you work on a daily basis can save you
time (and aggravation) later. Even if you're not
an organized person by habit, rest assured that
at least your Mac will be in shipshape condition.

What's New in Tiger

Tiger has big new features and applications as well
as nice, little additions to existing software. On the
big scale, there is Spotlight, a most excellent search
tool for finding things on your computer (see
Technique 21). There is also Dashboard, a widget
mechanism that’s part of Exposé (Technique 15),
which is both cool and useful. Last, in Part IX of the
book, you find out how to use Automator, our new
best friend.

If you're the kind of person that appreciates the little
things, you'll like the Safari changes, like the ability to
access RSS feeds (in you don’t know what these are,
march on over to Technique 30). You might also enjoy
the transformation of iChat AV, which can now do
video or audio conferencing (Technique 36). These
are just a few of the 150 changes Apple says are in
Tiger. We haven’t counted them all ourselves, but we
do like what we see and think you will, too.

Apple also added a whole slew of other behind-the-
scenes features to Tiger: new graphics and video tech-
nology; support for 64-bit processors (like the G5); a
new kernel (the very, very heart of the operating sys-
tem); and improved support for multi-processor Macs.
Yes, these additions are nice and new and they’ll pos-
sibly make your computer do some things faster, but
that’s all we really have to say about them with
respect to timesaving techniques in this book.

What's New in This Book

When Apple says “Jump,” we say “How high?” When
Apple releases a new version of its glorious OS, we,

well, we release a new version of this book. And for
good reason, too: There’s oodles of new information
you ought to have.

For starters, there are five entirely new techniques in
this book. The first is a guide for users switching
from Windows to a Mac. (We know you’re out there.)
The second offers interface suggestions to those
Mac users with special needs, a strong suit of Tiger
and one that many people aren’t aware of. Third,
we’ve been using the Address Book more and more
and feel you should, too, so we now give that appli-
cation its own treatment. The same goes for Safari:
We use other Web browsers, yes, but Safari really
earns its Mac dominance. Therefore, we dedicate a
second Safari chapter to customizing and tweaking
the application, adding features you won'’t believe
you lived without. The fifth new chapter shows you
how to use Automator, Tiger’s scripting tool. If you
have sequences you often do, knowing how to auto-
mate them goes a long way towards increasing your
productivity.

Beyond the new techniques, we did revamp all the
other existing material so that it continues to show
you the most accurate, timesaving ideas we know of.
In some cases, this means highlighting new features of
the operating system (like searching for files by using
Spotlight). In other cases, this means showing you
how to use some great piece of free- or shareware.

All in all, every single page has been reviewed, re-read,
checked for accuracy, and partially rewritten. Besides

being more up to date, a rough calculation determined
that this book is now 37 percent more timesaving-y.

Foolish Assumptions

Every book is written with certain assumptions
about the reader, and this one is no exception. Don’t
be alarmed: We aren’t looking for an advanced
degree in computer science or the ability to recall
long lists of Mac trivia at parties. We do expect two
things of you:



v A Macintosh, running Tiger (Mac OS X v.4):
Well, to be perfectly frank, if you aren’t running
Tiger (but are running another version of Mac OS
X), you can still get a lot of things out of this
book; you just can’t do everything this book says
you can do. This requirement is more of a highly
advisable suggestion.

v Basic familiarity with your computer: In some
ways, this is the same kind of For Dummies book
you've come to know and love, but it isn’t the
kind that shows you how to plug in a printer or
save a document. (It shows you how easy it is to
share a printer on a network and how you can
save documents faster, though.) We promise that
you won'’t be overwhelmed by anything in this
book, but keep in mind that you won’t be spoon-
fed, either.

Having a fast Internet connection will help you get
the most out of this book, and so will a little extra
spending money (but just a little). But neither of
these are required as long as you have a Mac and a
willingness — or a need — to discover how to use
your computer better.

How This Book Is Organized

As devoted Mac users, we've amassed a gazillion
pieces of useful knowledge. By sheer luck, it turned
out that these little pieces could be organized

into techniques, which are chapter-like sections
grouped by application or the general concept
being discussed. These techniques were then
herded together into larger parts, which we’re
calling (appropriately enough) parts (we're clever
that way). Right here we give you the highlights

as to what each part is all about, but remember

that you can approach this book the way you want
to. Read a part straight through, skip from technique
to technique, or just pick out the little pieces most
relevant to the way you work. This book has a struc-
ture, but you can be a free thinker. You own a Mac,
after all!

How This Book Is Organized 3

Part |: Starting, Stopping, and Running
Your Mac Faster

This first part of the book focuses exclusively on how
to get the machine and operating system to load and
run faster — in other words, how to speed up the
process between pushing the power button and actu-
ally doing anything. While we’re at it, we also discuss
some faster aspects of the installation process and
the easiest ways to shut down and log out. These
might be the basics of using your computer, but even
here, you find ways to do things more efficiently.
Finally, if you're new to the Mac world, the chapter
on making the conversion from a Windows mindset
should help ease that transition. (Here’s a preview:

It isn’t as big of a jump as you might think.)

Part II: Optimizing Your Interface

Comprehending how best to interact with your com-
puter is the foundation for just about everything.
Hence, this is the general guide to doing anything
better. The heart of Part Il is navigation techniques,
both with the keyboard and the mouse. You also dis-
cover how to customize the Finder, windows, and
the Dock. All in all, the absolutely most-universal
and most-helpful timesaving techniques are here.

Part lll: Handling Files (And Other Stuff) Quickly

Like a teenager’s closet, your Mac is full of stuff. Who
knows what it all is? Okay, we know, and we think
you should, too. Although your hard drive might not
yet be bursting, there’s always going to be a lot of
junk in there. This third part of the book demon-
strates how to best organize, manage, and find your
(and your computer’s) stuff. You also see how to
save hard drive space and remove clutter by trash-
ing unnecessary files.

Part IV: Improving Application Performance

Included on your computer (see Part IIl) are
applications — software that does stuff with other
stuff (not to be too technical about it). The focus
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isn’t on any one specific application here but rather
on some useful knowledge for using any application
more efficiently.

Part V: Cranking Up Your Internet Activities

As Homer Simpson says, “They have the Internet on
computers now.” Well, the man’s never been more
correct. Accessing e-mail and the World Wide Web
are why many people have computers. Most folks
spend a decent portion of their computing life in this
realm. Part V covers Web browsers, performing
searches, using e-mail, and other online timesaving
techniques. Tips on stopping spam and using Google
effectively can save you minutes per day — minutes
you could spend surfing the Internet.

Part VI: Optimizing Your Network

The networking section of the book is Part V’s coun-
terpart. Although not every user has advanced net-
working needs, most could benefit from using
locations, working with an iDisk, and knowing how
to easily connect to other computers when the time
comes. You have a network of some sort, you have a
bunch o’ wires (or not), and you need to make them
all play nicely together.

Part VII: Fast and Furious Multimedia

Apple markets itself as the multimedia machine, and
with good reason: The free software that comes with
the operating system is exceptional. In the multi-
media section of the book, we take a few of these
applications and demonstrate how to more efficiently
use them. For you lucky iPod users, you see what
else that beautiful little toy can do for your day-to-
day productivity.

Part VIII: Security and Maintenance

Okay, so your Mac pretty much takes care of itself.
Still, a little TLC couldn’t hurt. Part VIII (that’s eight
to you and me) offers you all the motherly advice
you can use on viruses, creating backups, keeping

your software up to date, and the like. Think of this
as the An ounce of prevention is worth a pound of
cure section of the book.

Part IX: The Scary Or Fun Stuff

Whether you know it or not, your Mac is a powerful
machine capable of some really, really cool things.
The final part of the book strongly emphasizes our
friend, the Terminal, and gives a nod to Automator,
a tool for making your own timesaving techniques.
If you're looking for something more fun and less
scary, check out the technique on using your cell
phone with your Mac or the one on screen savers.

Conventions Used in This Book

This book has a lot of visual stuff in it to help guide
you along the way. You know . . . different fonts and
icons, indentations, and a few funny characters.
Here’s a Rosetta Stone as to what they all mean:

v Keyboard shortcuts: This book has a healthy
amount of keyboard shortcuts in it. These use a
conjoining minus sign to indicate that two (or
more) keys should be pressed in harmony. So
when you see something like 88-A (the Select All
shortcut), you should press and hold 88, press A
once, and then release both. Something like
Control-click means that you hold down the
Control key while clicking the mouse button once.

v Menu bar: The menu bar is the thing going
across the entire top of your window. It has all
the, you know, menus, but in bar form.

v Menu sequences: Sequences of menus are refer-
enced with an arrow. For example, Go=>Recent
Folders means that you should click the Go
menu (on the menu bar) and then choose the
Recent Folders submenu from there.

v Apple menu: The Apple menu, represented by
the & symbol, is that blue Apple symbol in the
upper-left corner of your window. (It’s shaded
differently from the rest of the menu bar in Tiger.)
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Application menus: When we refer to an applica-
tion menu, we mean the menu that has the title of
the application and appears between the Apple
menu and the File menu. So in the Finder, it’s
called Finder; in Microsoft Word, it’s called Word;
in iTunes, it’s called iTunes.

Monospace font: Web sites (URLs) and e-mail
addresses are in their own special monospace
font, which looks like www.apple.com. On-screen
messages and text in the Terminal also 1ook
like this.

User entry: Stuff you should type appears in
bold, like this: Type How now, brown cow?.

Icons Used in This Book

This b
notes,

ook is littered with lots of little tidbits and
set aside by different icons. In due time, you’ll

probably identify the pattern for what each icon rep-

resent

4
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s, but here’s a quick heads-up:

Tips are just extra ideas that we think you'll
appreciate. Although not life-altering, tips are
our way of saying, “Hey, you know what else
you could try?”

These icons reemphasize the timesaving point
we’re making in a certain section. If you don’t
feel like reading through all those pesky words
and get tired of our trite jokes, look for these.

This icon means that you've seen this idea
before, you'll see this idea again, and you
ought to keep it in mind. These are publish-
ing’s version of sticky notes or Stickies, in Mac
terms.

For crying out loud, pay close attention to any-
thing marked with this icon! If you don’t believe
anything else that we say, trust us on these
warning icons. Think curiosity and cat here and
how that went. You won’t see many warnings
in this book, but when you do, understand that
you might be about to take an irrevocable step.

Comments and Questions 5

Comments and Questions

We'd like to think that this book was everything you
wanted or needed, and that you have no more com-
ments, problems, questions, and the like. But writing
can be a cruel mistress (we don’t know what that
means, either, but it sounds bad), and no book is
ever comprehensive. If you have something to say or
ask, here are some places to turn:

v Wiley (www.dummies.com): You can contact Wiley,
the publisher of this book, at its For Dummies
Web site. Feel free to leave all sorts of feedback,
including praise (Woo-hoo!), complaints (D’oh!),
and requests (that’s okay, too).

v Mac OS X Tiger Timesaving Techniques For
Dummies, the Web site (www.dmcinsights.
com/mactst): At Larry’s Web site, we're maintain-
ing a separate section that focuses solely on this
book and its predecessor (Mac OS X Panther
Timesaving Techniques For Dummies). Its con-
tents will vary, but basically you can find news,
links to useful Web pages and software, and so
forth. Plus, you can also find our contact infor-
mation and the link to the supporting forum.

v Mac OS X Tiger Timesaving Techniques For
Dummies, the support forum (www.entropy.
ch/mactst): Marc has established a forum at his
Web site where you can ask questions about the
book, about us, and about your Mac. Not only
will we reply (probably faster than we’ll get to an
e-mail), but you’ll also hear what other readers
have to say. Make sure, though, that you mention
what version of OS X you're using (Panther,
Tiger, and so on), just to be clear.

v E-mail the authors: If you'd like to contact
us directly, you can e-mail us at mactst@
dmcinsights.com. Although we do respond to
every e-mail we receive, there’s no guaranteeing
how quickly that’ll happen. Don’t get us wrong:
We absolutely appreciate the feedback, but there
are only so many hours in the day. And, again,
it’s best if you're specific about what version of
OS X you're running.
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Keep in mind that normally the quickest way to manufacturer of that application. But still, if you
answer a general Mac question is to search Google. drop us a line via one of the previously mentioned
Also, if you're having problems with a particular methods, trust that we’ll do our best to help out.

application, you’ll have the best luck contacting the
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Installing Tiger
without the Hassle

Technique

Save Time By

v~ Discovering the benefits
of Tiger

v~ Selecting the appropriate
installation method

v~ Using Disk Utility
v~ Installing Tiger

v Working with the Setup
Assistant

v+~ Transferring your existing
files to a new installation

system, you need a version of it running on your Mac. You might

even wonder whether Mac OS X Tiger is right for you. Because
you’re holding this book, the answer is presumably yes, but to explain why,
we begin this technique by discussing some of Tiger’s benefits and new
technologies.

Before you can discover the magic of Apple’s latest, greatest operating

The installation process itself has a few variables, and comprehending
the different choices can not only save you time during the installation
process but give you a more appropriate version of the operating system.
You should also be able to make knowledgeable decisions about format-
ting and partitioning your hard drive before you install the OS. Finally, we
show you how to breeze through the Setup Assistant (Apple’s program for
easing you through the startup process) and then wrap up with a discus-
sion of foolproof file transfers.

What Tiger Can Do for You

Whereas Panther added a ton of obvious new features to the operating
system and Apple applications, Tiger’s additions are more subtle,
although no less useful. Compared to its predecessor (Panther), what
you find new in Tiger is

v Spotlight, a great search tool

v Automator, for creating sequences of common steps within Apple
applications

Many new features in Mail
An improved version of Safari, which can now handle newsfeeds
The ability to perform video and/or audio conferencing in iChat

Xcode 2, the latest version of the most excellent development tool

A W W W W N

Dashboard, a quick way to access different little utilities
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Apple has also made quite a few behind-the-scenes
alterations that you probably aren’t aware of but
which might make for a faster Mac. Tiger supports
64-bit addressing (a good but very geeky thing); dual
processors (like the higher end G5); a new kernel (an
even geekier thing); and new graphics and video infra-
structure. There’s really nothing more to say about
these new features in this book (because, well, they
just do their thing behind the scenes), but we wanted
you to know that Tiger adds more than just the visible
applications and features that we mention.

All these improvements and new features can be
yours for the low, low cost of . . . okay, the not-so-low
cost of $129. But it is a beauty of an operating system.

The price of Tiger ($129) is the same whether
you're upgrading from an earlier version of
OS X or buying a version of OS X for the first

time.

To further convince you, consider that an overriding
benefit of installing Tiger is that you’ll be using the
most current version of Apple’s operating system.
This means that you can take advantage of all of
Apple’s future development of applications and
patches, which will be designed with Tiger in mind.

If you own more than one Mac, consider the
Family Pack version of Tiger, which gives you
license to install the OS on up to five machines
for the bargain price of $199. If time truly is
money, this tip alone could save you hours!

Minimum System Requirements

To use Tiger, Apple recommends that you have one of the
following computers:

v Power Mac G5
Power Mac G4
Power Mac G3 (Blue and White)
PowerBook G4
PowerBook G3 with built-in USB

A W W W

iMac
eMac
iBook
¥ Mac mini

X Y\

Apple also recommends that you have at least 128MB of
RAM (we recommend 256MB or more, but you can get
away with less if you never use Tiger’s Classic mode), a sup-
ported display, and at least 2GB of available hard drive
space. (You need 3.5GB if you want to install the Developer
Tools, as well) You're welcome to attempt to install Tiger
even if you don't meet the requirements, but you do risk
having a bum computer and wasting a whole heck of a lot
of time in the process.

Choosing an Installation Method

If you just purchased a brand new Mac, making
yourself the envy of the neighborhood, you should
be sitting there with a fresh copy of Tiger purring
away. In that case, you can skip ahead to the section
“Working with Setup Assistant” to see how to whip
through the Setup Assistant. If you don’t have Tiger
installed yet but are the proud owner of some shiny
new installation discs (or a single shiny DVD), it’s
time to put them to use.

Before you begin, take a minute to think about what
type of installation you want. You have three options:

v Upgrade a previous version of Mac OS X:
Upgrading is the easiest and least time-consuming
option to use — in the short run, that is. One
drawback, however, to upgrading an existing OS is
that your hard drive becomes bloated with dead-
wood files. The resulting OS can be a little buggy,
inheriting problems from its predecessor.

7 If you want to install Tiger and get on with
e- { <@ your life with a minimum of fuss, choose the
& upgrade option.



v Erase and Install: This option is the most taxing,
time-consuming, and drastic of the three. On the
bright side, you do end up with an untouched
hard drive and a brand spankin’ new OS. On the
other hand, you wipe out all your files and appli-
cations in the process.

Absolutely, positively do not use the Erase and
Install option unless you've got multiple back-
ups of all your files, drivers, and software. This

option does exactly what it says: erases the
contents of your entire hard drive.

v Archive and Install: This happy medium between
the other two installation choices creates a new
system folder with new copies of all the OS stuff,
but it also allows you to maintain all the user files
and non-Apple applications. Although Apple
doesn’t promote this feature as the recommended
type of installation, we’re quite fond of it our-
selves. It gives you the benefit of a clean system
folder (minus the deadwood created by an
upgrade) without the serious drawback of having
to reinstall all your applications and files.

The Archive and Install option throws all the
existing system files and Apple applications in
a folder called Previous Systems. After you're

convinced that no valuable information has
been overwritten by the recent installation,
delete this folder to clear up space on your
hard drive.

Managing Your Hard Drives

Along with deciding what type of installation you
want to perform, another topic worth your consider-
ation before you install Tiger is the formatting and

partitioning of your hard drive (or drives). To clarify:

v Formatting a hard drive is the process of erasing
its contents and telling the blank drive how to
structure the files that will later be stored on it.

Managing Your Hard Drives ’ ’

v Partitioning a hard drive is the process of break-
ing a single drive into multiple volumes. Your
computer still has the same number of physical
hard drives, but the operating system behaves as
if there were more. (Each volume appears as a
separate drive in Finder and other software.)

Practically anything you do with the Disk
Utility application requires erasing your entire
hard drive. Although Disk Utility warns you

before it does anything so drastic, we advise
you not to use the application unless you've
first backed up everything that you need.

You accomplish both of these tasks by using the
Disk Utility application (see Figure 1-1), which you
can find in the Utilities folder and on the first (or
only) Tiger installation disc. If you have multiple
drives or volumes, Disk Utility can format or parti-
tion any volume except for the one on which it
resides (because it can’t erase itself). If you want to
format or partition the drive that contains Disk
Utility, you need to boot your Mac from the installa-
tion discs.

Baon FUJITSU MHTZOBOAT =

a w

New Image Ine Log

] 74.5 GO FLJITSL MHT20...
2 Primavera

= 2.5 Gl MATSHITADVD-R
o Mac 05 X Install VD

Verify Duk Permissions Verity Ditk
! Rrpair Disk Permissioms Repair Disk

3

Total Capacity : 74.5 GB (80,026, 161,856 Bytes)
Wirite Status © Read/Write
SMART, Status © Not Supported

— Disk Description : FURTSU MHTZOBOAT
i Connection Bus : ATA
= Connection Type : internal
Connetion 1D Device 0

T,

¢ Figure 1-1: The Disk Utility application manages your
hard drives.
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If you plan either an Upgrade or an Archive and
Install installation, do not reformat or partition
your hard drive because there will be nothing

to upgrade or archive. If you're performing an
Erase and Install, the installer can handle basic
formatting (but not partitioning) for you.

1. Start your computer with the first (or only)
Tiger installation disc.

2. At the first screen that appears (for language
selection), choose Utilities=>Disk Utility (see
Figure 1-2).

3. Follow the appropriate steps in one of the next
two sections to either format or partition your
drives and volumes.

L] atal M 053

Welcome to the Mac 05 X Installer E

¢ Figure 1-2: Open the Utilities menu to access Disk Utility.

Formatting a Volume

To format a volume with Disk Utility:

1. Click the volume icon in the left column.

A hard drive’s volumes appear under the hard
drive’s icon.

Click the Erase button.

N

3. Select a Volume Format.

The volume formats are:

» Mac OS Extended (Journaled): You don’t
really need to understand the details of what
journaling does to appreciate that it allows
you to more accurately recover your com-
puter in the event of a disaster. Feel free to
use this format because Apple now uses it as
the default.

» Mac OS Extended: This used to be the default
format and is also a safe choice.

» MS-DOS: MS-DOS . .. a Windows-compatible
format. Yuck.

» UNIX File System: If you choose to format
with UFS, you render the hard drive unrecog-
nizable by some operating systems (in partic-
ular, OS 9). For this reason, we advise you to
stay away from it.

4. Enter the volume’s name (see Figure 1-3) in the
Name text box.
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¢ Figure 1-3: Reformatting a hard drive’s volume.
4. Click Erase to reformat the volume.

When reformatting a hard drive, you can
choose from several options by clicking the
Security Options button. The options range
from Don't Erase Data to 35-Pass Erase.
Choosing anything other than Don't Erase



Data exponentially increases how long it takes
to reformat the drive, but it’s the best way to
both clean the drive and ensure that it's work-
ing properly. If you're very security conscious
and/or a little paranoid, the 35-Pass Erase
option rewrites your disk 35 times, making the
data virtually impossible to recover. It also
takes hours or days to complete!

Partitioning a hard drive

To partition a hard drive into multiple volumes:

1. Click the drive’s icon in the left column.

The drive will have a strange name consisting of
the size and model of the device.

2. Click the Partition tab.

The Partition tab is an option only when you
select the entire hard drive.

3. Select a scheme from the Volume Scheme drop-
down list (see Figure 1-4).

A volume’s scheme refers to how many parti-
tions you want to create. Hard drives 20GB or
larger can be nicely divided into two partitions.

ane FUIITSU MHT2080AT [=]
ad - P
aa 3 5 (7] =]
New Image Infes Log
- First Aid Frave Partition RAID Restare
24 74.5 GB FUJITSU MHT20... SEmAE S Tedien AR o
2} Primavera
g Volume Scheme Volume Information
% 2.5 CB MATSHITADVD-R -
5 Mac 05 X install OVD 2raatons B e Prmavera
Formar: | Mat G Extended ournaied) 9]
size. 37.27 s
Primavera | Lecked far ediving

B irseall Mac OF § Disk Drivers

i To Create 3 volume that an sérve 23 3 Mac 05 8
- $5art D disk, $etect Mac 05 § Drivers installed.

Select the disk you want 10 partition and choose 3
volume scheme. Click each volume reresented in

Dot the seheme and specily 3 volume name, lemat,
and wige. Click Partition.

Sl " Delete [ Reven ) Form ‘\

Disk Description : FURTSU MHTIOB0AT
| Connection Bus: ATA
== Comnection Type : internal
Connestion 1D Device 0

Total Capacity : 74.5 GB (80,026,361,656 Bytes)
Wirite Status : Read Write
SMART, Status © Not Supported

T;

* Figure 1-4: Opting for two partitions as the volume’s
scheme.
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4. One at a time, select every partition in the vol-
ume scheme window (named Primavera and
Data in Figure 1-4).

Disk Utility automatically partitions a hard
drive into equally sized volumes. You can
override this by clicking and dragging the bar
that separates the volumes in the scheme win-
dow. Alternatively, you can specify a size for
each partition (in gigabytes) by using the Size
text box.

5. Type a name in the Name text box and select a
format type in the Format drop-down list for
each partition.

6. Click the Partition button to enact the changes.

Installing Tiger

The installation process is fairly obvious, particu-
larly after you understand the options, but we run
through the steps and highlight a few important con-
siderations nonetheless. To install Tiger:

1. Update your computer’s firmware.

Apple always recommends that you do this, point-
ing you to www.apple.com/support/downloads.
When you're there, click your computer model
under Updates by Product in the right column.
This takes you to a results page where you proba-
bly won’t find an update for your firmware. We're
not suggesting that you skip this step, but don’t
be surprised if it’s less than fruitful.

2. Insert the first Tiger disc into the disc drive
(make sure that you have all three CDs or a sin-
gle DVD), double-click the Install Mac OS X
icon, click Restart (see Figure 1-5), enter your
password if prompted, and then wait for your
Mac to reboot.
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Install Mac OS X

Click the button below to restart
your computer and begin the
installation process.

Mac OS X Tiger

( Restart )

¢ Figure 1-5: Restart your computer to begin installing Tiger.

You can also begin installing Tiger by holding
down the C key while your computer starts up
or selecting Mac OS X Install Disc 1 or Mac OS

X Install DVD in the Startup Disk preferences
panel (assuming the CD/DVD is in the CD/DVD
drive).

3. Select the language that you want to use and
then click the arrow.

4. Read through the introductory text on the first
two pages, and click Continue to go on.

5. Accept the license agreement by clicking
Continue in the main window and then Agree
on the sheet that appears from the top of the
window.

¥ You don't have to accept the license
e («a agreement — unless you want to install Tiger,

) that is. If you click Disagree, you exit the
installer and are returned to your normal
operating system world. One could argue,
therefore, that to save time, you just skip
reading the agreement (because you have to
agree with it regardless). We'd never be so
irresponsible as to suggest that you skip read-
ing the agreement, though. (Cough, cough.)

6. On the Select a Destination page that appears,
select the destination drive for the installation
but don’t click Continue just yet (see Figure 1-6).

The installer presents a list of available volumes
where you can place Tiger. The installer even
marks the recommended destination with a green
arrow and unusable destinations with a red X.

ane Install Mac OS X

Select a Destination

Select a destination volume to install the Mac 0S X

© Introduction software.
© License Pt
/\dl l'\\
© Select Destination ( 7 ]
ﬁ_.,

Pr\r-'navera
74.4GB (69.9GB Free)

You have selected to upgrade Mac OS X on this volume.

( GoBack ) ( Continue }

* Figure 1-6: The destination determines where Tiger will
be installed.

If you have a decent-sized hard drive (20GB or
more), hopefully you partitioned it into two or
more separate volumes. If so, you can do a
clean install of an OS onto the second volume,
maintaining all your files and applications on
the original volume, just in case. See “Managing
Your Hard Drives” for more information on
partitioning.

7. Before you leave the Select a Destination page,

click Options at the bottom of the window.

8. In the Options dialog that appears (see Figure
1-7), select the appropriate installation method
(see the earlier section “Choosing an Installation
Method”).

Your choices are
» Upgrade Mac OS X
» Archive and Install

» Erase and Install



2 Upgrade Mac OS5 X

Upgrades an earlier version of Mac 05 X.

¥ Archive and Install

Mowves existing System files to a folder named Previous System, then
installs a new copy of Mac OS X. You cannot start up your computer
using the Previous System folder.

™ Preserve Users and Network Settings

Imports existing user accounts, their home folders, and your network
settings into the new system. You will skip the Setup Assistant when
installation is complete.

: Erase and Install

Completely erases the destination volume then installs a new copy of
Mac 05 X.

Format disk as: Mac OS Extended (Journaled) =

(" Ccancel . (— oK L)
N

¢ Figure 1-7: The Options dialog is where you select your
installation type.

If you select the Archive and Install option,
you absolutely, positively want to select the
Preserve Users and Network Settings check
box; otherwise, you'll need to recreate all your
files from the archive, which is an unnecessary
hassle.

If you select the Erase and Install option, you have
the choice of formatting with the options pre-
sented earlier in this chapter. You almost certainly
want to use Mac OS X Extended (Journaled), but
read the “Managing Your Hard Drives” section for
more information.

If you perform an Erase and Install of Tiger, all
your existing applications — along with your
files — are wiped out. If you don't have all the
application discs and write down the serial
numbers somewhere, you also lose some soft-
ware in your transition.
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9. Click OK to close the Options dialog, and then
click Continue in the Select a Destination
window.

70. On the Easy Install page that appears, click the
Customize button at the bottom of the screen.

771. In the Customize dialog that appears, deselect
all the features that you won’t use (see
Figure 1-8).

8Ne Install Mac OS X

Custom Install on “Primavera”

Package Name Action Size
© Introduction ¥ Essential System Software Install 1.8GB
Sl » = Printer Drivers 1.1CB

- # Additional Fonts Install 129MB
© Select Destination ¥[E Language Translations 753MB
@ Installation Type @ Japanese Install 78.6MB

# German Install 77.2MB
nstal # French Install 74.8MB
Finish Up \ # Spanish Install 76.0MB
\
I Dutch Skip r
] Danish Skip i

Space Required: 3.8GB Remaining: 66.1GB

“This package contains all of the necessary files to run Mac OS X in

/ Italian.

4 |_' Easy Install \
£

* Figure 1-8: Customize your installation to fit your needs.

The most important timesaving consideration
when installing Tiger is to avoid installing fea-
tures that you'll never need. This saves you time
now and hard drive space in perpetuity. The
options that you can choose to forgo include

» Printer Drivers: If you don’t have a printer,
you won’t need these at all, so deselect this
option and save a whopping 1.1GB of hard
drive space. If you do have a printer, choose
to install the drivers that correspond to the
make and model of your printer.

» Fonts: Although Apple’s been kind enough to
include the fonts, an informal poll of ours con-
cluded that most Tiger users don’t read much
text written in Inuktitut or Gujarati. If that accu-
rately describes you, drop all the fonts, along
with the standard Asian ones (Japanese,
Chinese, and Korean). You save yourself 130MB
of room (possibly for MP3s) in the process.
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» Language Translations: If everyone using the
computer primarily reads and writes English,
deselect the 1GB of language translations that
the OS will never use.

Depending upon what Apple decides to do in
later installers (we were using a beta version
when writing this), you might also be able to
install

» Additional Applications: The Additional

13.

You can quit the installer any time up until
you click the Install button. After you do that,
get out a good book because you'll have to
wait out the installation (easily 15 to 30 min-
utes, depending upon your computer and the
installation choices made).

Wait patiently as the installation happens.

The installation process could easily take

Applications include Internet Explorer, Stufflt
Expander, iTunes, iMovie, iPhoto, iCal, and
iSync. You'll probably want all of these, but go
ahead and drop those you won’t use.

Additional Speech Voices: The speech voices
require only 28MB of space, but that’s 28 more
megabytes than necessary if you never use
them. (You would use them if you have your
Mac speak text and other stuff to you and you
want a variety of speakers.)

X11: This option is admittedly close to our
hearts and requires a meager 82MB of space.
Installing it opens up your Mac to a whole
world of free (free!) software and makes these
geeky authors proud. X11 provides a graphi-
cal user interface to UNIX applications, such
as The GIMP image manipulation tool, games,
various text-editing programs, and a wide
array of scientific tools. Although these UNIX
applications don’t look or act as nice as native
Mac OS X applications, the ability to run them
is still very valuable, and the price is right.

If you don’t install the BSD Subsystem, be
aware that you won’t be able to use many of
the more techie features of Tiger, including a
few that we list in this book. This includes
command line utilities and some Internet and
networking software.

14.

15.

upwards of an hour, so you may want to grab a
good book while you're waiting.

The first step that the installer takes is to check
for problems on the installation disc. Then it
checks for problems on the destination volume.
You have the option of skipping this step (click
Skip in the lower-right corner), but you should
let the installer do its thing.

If the installation process stops because there’s
a problem with the integrity of your hard drive
(you see an obvious error indicating such), you
need to repair the hard drive before installing
Tiger. To do so, reboot your computer from the
Tiger installation disc, then choose Utilities=>
Disk Utility. The Repair option is under the First
Aid tab.

When the installation finishes, your computer
automatically restarts.

You can also click Restart at the prompt.

If necessary, follow the on-screen instructions
to insert discs 2 and 3.

After your computer reboots — and is therefore
running off the new OS on your hard drive — the
installation process might continue if you've
elected to install some of the optional compo-
nents listed in Step 10. For example, if you're
installing extra fonts and printer drivers, the

After you select what you want installed, click
Upgrade or Install to begin the actual installa-
tion process.

The button you see depends upon the installa-
tion type you chose. You can also click Easy
Install to cancel the customization.

installer prompts you for disc 2; if you elected to
install X11, disc 3 is required. Obviously, if you're
using the single DVD, you don’t need to insert
anything else.



You can also use the installer CDs for three
administrative purposes: changing the Startup
Disk, resetting a password, and accessing a
version of Disk Utility not running on the main
hard drive (see “Managing Your Hard Drives”).
Each of these is accessible through the Installer
menu.

Working with Setup Assistant

If you perform an Erase and Install installation of
Tiger or if you're using your computer for the very
first time, you get the magic of the Setup Assistant
when your computer reboots. Like its Windows
counterpart, Setup Assistant asks you a series of
questions intended to make using the computer eas-
ier. Here are the highlights of the process so that you
can whip through it more quickly:

1. Select your country.

2. Answer the Do You Already Have a Mac?
question.

This new feature makes it easier to transfer all
your existing information from your old Mac to
your new one. The three options are

» Yes, Transfer My Information from Another
Mac: This is useful only if you have another
Mac, they both have a FireWire connection,
and you have a FireWire cable. If you have all
three requirements, this is most assuredly the
way to go.

» Yes, Transfer My Information from Another
Partition on This Mac: If you performed a
clean installation of Tiger on another partition
or drive on the same computer, you can easily
move all your personal stuff over.

A very quick and reliable way to install Tiger is
to place the operating system on a separate
partition and then use the transfer feature to
copy over the data from the previous, existing
partition.

@
w<@
&
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» No, Do Not Transfer My Information: Even if
you choose this option, you can move stuff
over manually later. See “Transferring Files
Flawlessly” at the end of this technique.

If you select either of the first two options, the
Setup Assistant then instructs you on what you
should do.

Select your keyboard layout.

For this and for Step 1, the defaults will most
likely work. Apple is kind enough not to display
all the options, but you can get them by clicking
the check box at the bottom of the window.

Decide what you want to do for an Apple ID.
You have three options:

» Enter your existing ID, if you have one.

» Create a new Apple ID.

» None of the above.

You already have an Apple ID if you've registered
for any of the special areas at www.apple.comor
if you have a .Mac account (which will be the
same as your Apple ID).

If you don’t already have an Apple ID or a .Mac
account, we strongly recommend creating one,
which will give you a 60-day trial .Mac account. If
you like the trial, you can pay for a permanent
account. We both have one and think it’s well
worth the $99 yearly price.

You can get a free trial .Mac membership
when you go through Setup Assistant. Because
we refer to some .Mac stuff throughout this

5.

book, you really ought to consider signing up,
even temporarily.

If you want, register.

Unlike Windows XP, which requires activation of
the operating system, you can forgo Tiger registra-
tion entirely. If you don’t feel like registering, press
38-Q to quit the registration application. The

Setup Assistant then gives you the option to skip
registration entirely (and continue with setup
process), shut down the computer, or cancel.
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Answer a few more questions and then check
out Apple’s Privacy Policy.

Create your user account.

To create your account, enter your full name,
your short name (which the computer will treat
as your username), and a password. Ideally, your
short name should consist only of letters, num-
bers, and the underscore, and be eight charac-
ters in length or shorter.

You can skip the password and verify prompts
if you'd rather not have a password. This will
expedite many tasks but will also make your
computer far less secure.

Select your Internet access type and then click
Continue.

You have three options:

» Set Up a Free Trial Account with EarthLink
» Use My Existing Internet Service

» I'm Not Ready to Connect to the Internet

Follow the prompts to complete the Internet
setup.

As long as you didn’t select I'm Not Ready to
Connect to the Internet in Step 8, you're led
through a connection setup wizard. If you're
using an existing service, have your Internet
information written down and ready for when
you go through Setup Assistant. Getting the
information correct here will save you the hassle
of configuring your network later, although you
always have that option.

You need to know some combination of the
following:

» Connection type (telephone modem, cable
modem, and so forth)

» Username

» Password

» Phone number (for telephone dialup)

» Subnet mask, router address, DNS hosts, and

domain names (for DSL, cable modems, and
other networks)
70. Setup Mail.
Depending upon what choices you’ve made thus
far, you might also be able to set up your Mail
accounts at this time. Doing so is just a matter of

using the provided form. You can always do this
in the Mail application later, as well.

Your Internet service provider should give you
detailed connection information to use during
the Internet setup process.

71. Sync your Mac.

A few items can be synced across multiple Macs.
If this is something you’ve used before, you can
immediately sync your new Mac with this old
data by following the prompts.

12.

Select your time zone, confirm the current date
and time, and start using Tiger!

Transferring Files Flawlessly

In Technique 16, we discuss how to organize and
maintain your files and folders. Tiger comes with a
good implicit organization scheme that you really
ought to follow. If you do so, you can restore all your
documents, bookmarks, e-mail, and so forth merely
by copying the contents of your old Home directory
to your new user directory. Even if you use the pain-
less Archive and Install installation option, saving
the contents of the Users folder to an external
source before you begin installation (hard drive,
CD-ROM, DVD) is a prudent move.

While we're at it, we recommend that you have at
least one reliable backup of all your data at all times.
If you're installing a new version of the operating
system, you want two or more backups that use dif-
ferent media. (You can never be too careful.)
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The Backup application is provided free to to get to the data until your computer can read that
.Mac users. Version 2 of the application can format again.
back up files to your iDisk, a CD or DVD, and
even external hard drives. We highly recommend making a CD-ROM of
installed applications that also contains a text
Be sure that your backups aren’t in a proprietary for- document with all your serial numbers. This
mat (for example, the Retrospect Express cataloging fairly simple step makes restoring the software

system; www.dantz.com) because you won’t be able on your computer a snap!



Starting Up
with Speed

Technique

Save Time By

+* Keeping your computer
on at all times

v Scheduling when your
computer turns on and off

»* Managing the login
process

v~ Loading applications
automatically at startup

v~ Getting to a System
Preferences panel
quickly

purr. In this technique, we cover ways to make your computer

usable as quickly as possible. These timesaving ideas focus on the
period from the time you press the power button to using the actual
applications.

ﬁ s soon as you have Tiger running on your Mac, it’s time to make it

We begin by pointing out the benefits of never shutting down your com-
puter, which helps you start faster and is a reasonable option for many
Tiger users. Then we show you how to best manage computers in a
multi-user environment and how to bring up your must-have applications
as soon as you log in to Tiger. This last little technique is a valuable time-
saver for pretty much any Mac user, so we then show you a more specific
example with the System Preferences panel.

Faster Startups: Never Shut Down

Although obvious, many people never think of this: The fastest way to
get your computer to start up is to never shut it down. Even on the
fastest machines, the startup process takes several minutes — minutes
that you don’t need to spend sitting idly. The UNIX operating system —
which is at the heart of Mac OS X — was designed to run 24 hours a day,
and your Mac is perfectly capable of this as well. Granted, keeping your
computer on all the time racks up the electrical bill a few cents per
month, but that minimal extra cost can be easily offset by your increased
productivity. Now, we’re not arguing that you should never shut your
computer down (like if you're going on vacation), but here are some
viable alternatives to shutting down if you use your Mac a lot:

v Put the computer to sleep overnight.

v Whenever you need to, set the sleep mode (see Figure 2-1) by clicking
the Show Details button within the Sleep tab of the Energy Saver panel.



880 Energy Saver
[« » ][ Showal | Q

Settings for: | Power Adapter -

Optimization: | Custom ¥

Your energy settings are optimized for high performance.
Current battery charge: 97%

Sleep | Options

Put the computer to sleep when it is inactive for:

N

1 min 15 min 1hr 3hrs  Never

Put the display to sleep when the computer is inactive for:

=

AV

1 min 15 min 1 hr 3 hrs  Never

@ Put the hard disk(s) to sleep when possible 'f?,'

Il
JW Click the lock to prevent further changes.

( Hide Details ) (Schedule... )

* Figure 2-1: You can adjust your computer’s sleeping
habits in the Energy Saver panel.

You can access the Energy Saver panel by
choosing System Preferences from the Apple
menu and then clicking the Energy Saver icon

in the Hardware section. Figure 2-1 shows the
Energy Saver panel for a laptop, which has a
few more features than the same panel on a
desktop machine.

v Turn off the monitor (desktop users only).

v Close your laptop’s monitor to engage the sleep

mode (laptop users only).

v Leave the computer active but engage the screen

saver.

If you aren’t going to use your computer for
@ days on end (like over a weekend or during a
long holiday), shut it down. But you don’t have

to shut down your computer every night,
especially if you use your computer off and on
all day.

Scheduling Your Startups 2 ’

Scheduling Your Startups

Tiger’s scheduling feature can save time in starting
your Mac. This is particularly useful in labs or offices,
where computers are used in regular intervals. Even if
you're a home Mac user, if you know the Mac is never
used after midnight or before 8 a.m., you can sched-
ule its up time accordingly. This saves you starting or
stopping your computer yourself.

1. Open the System Preferences panel (choose
Apple=>System Preferences).
2. Click the Energy Saver icon, under Hardware.

3. In the Energy Saver panel, click the Schedule
button.

The Schedule button is always available, whether
or not you have the other details displayed.

4. In the resulting prompt (see Figure 2-2), select
the Start Up or Wake check box.

@ Start up or wake '_\l-\i'é_e.!aays Felat  8:00 AM

™ ShutDown |3) Weekdays  |3) ar 12:00 AM |~

(&) oK )

\)

[=d]

¢ Figure 2-2: Use the Schedule window to set when your
Mac should start, wake, sleep, or shut down.

5. In the top-middle drop-down list, choose which
days to schedule your Mac to start.

You can specify an individual day (like if you use
your Mac only on Thursdays), weekends, week-
days, or every day.

6. Set the time by using the box in the top-right
corner.

You can set the hour, minute, and AM/PM fastest
by clicking once on the digit in question and then
typing in the desired value. For example, in
Figure 2-2 you might click the 8 and type 6 — but
only if you're an early bird.



22 Technique 2: Starting Up with Speed

7. Select the check box next to Shut Down to set
either a shut down or sleep time.

8. In the bottom first drop-down list, select either
Shut Down or Sleep.

You can schedule your Mac to either shut
down and start up or sleep and wake up.

9. Use the day of the week and time fields as you
did on the top row.

70. Click OK to exit.

Don’t worry about your Mac shutting down when
you’re in the middle of finishing the Great American
Novel:

v Tiger prompts you well in advance of a regularly
scheduled shut down, as shown in Figure 2-3.

v Tiger can’t shut down if any open application has
an unsaved document.

This computer has been scheduled to shut
down automatically.

If you do nothing, the system will shut down
automatically in 9 minutes and 3 seconds.

'_,I ( Shut Down )

( Cancel

¢ Figure 2-3: Tiger prompts you before performing a
scheduled shut down.

Speeding Up the Login Process

If your computer has multiple users, you have to
deal with the same types of questions as with multi-
ple operating systems:

v Should a user be automatically logged in?

v If a user should be automatically logged in,
which user?

v How do you quickly switch to another user?

Tiger includes many nice touches for using the com-
puter in a multi-user environment. Simplify and
speed up the login process like this:

v If you're the most frequent computer user, set
the computer to automatically log in under your
username by following these steps:

1. Open the System Preferences panel (choose
Applem>System Preferences).

2. Click the Accounts icon, under System.

3. Click the Login Options button at the bottom
of the left column.

4. Select the Automatically Log In As check box.

5. Select your username from the drop-down list

(see Figure 2-4).
8ec Accounts
|« » || showal Q
My Account
g Larry Ullman . _
& admin IE Automatically log in as:  Larry Uliman [ !
Jther Accounts
Marc Livanage Display login window as:
Standard ® List of users

: Name and password
I\_ﬂ Show the Restart, Sleep, and Shut Down buttons
| Show Input menu in login window

Use VoiceOver at login window

HILEN

| Show password hints

@ Enable fast user switching
View as: | Name m

+

0 @
7] Click the lock to prevent further changes. o

¢ Figure 2-4: Use the Login Options link in the Accounts
panel to secure and speed up access to your
computer.

6. Click the lock in the bottom-left corner to
make this setting permanent.

Any locked System Preferences panel needs to
@ be unlocked in order for changes to be made.
Unlocking a panel requires an administrator’s

password. If you are the only administrator of



your Mac, using the lock on any System
Preferences page means that no one else can
change that setting.

If you log in automatically, anyone who has
6 physical access to your computer can now use
your computer without restraint. If your com-

puter stays at home and you trust your dog,
this might not be an issue; if security may be
an issue for you, though, do not use the auto-
matic login feature.

v If you must use the login prompt, select the List
of Users radio button in the Login Options sec-
tion of the Accounts panel. You can skip typing

your username while still requiring a password: a

reasonable security compromise.

Security versus convenience

You might have to compromise security for greater con-
venience (or speed). In many of the examples of this book,
you need to decide whether you want something to be eas-
ier or more secure. Factors in making this decision include

v Whether you share your Mac
v What information is stored on your Mac
v Who might have physical access to your computer

v Whether your computer is likely to be stolen

For example, the most secure login method is to require
users to enter both a username and password to log in to
the computer, but this is really annoying if you're the only
one who can access your Mac. In this case, automatically
logging in as yourself but password-protecting sensitive
files on your computer (such as a Quicken document) and
keeping regular backups of everything makes sense.

This book has many techniques for making things conven-
ient and many for making things secure. In the end, only
you can decide where your total Mac usage falls on that
scale.

Starting Applications Automatically 2 3

Starting Applications
Automatically

After your computer is up and running and you’ve
logged in, you're ready to use applications. Part IV
covers applications in detail, but we give you a
related technique here. From the Accounts panel,
you can set applications to launch automatically
when you log in to your computer. This saves you
from waiting while Mail, Safari, and whatever else
loads.

Your computer must expend some time and a
@ bit of power to start up applications. You
should add applications to your list of startup

items only if you always use them every time
you start the computer.

1. Open the System Preferences panel (choose
Apple=>System Preferences).

Click the Accounts icon, under System.

Select your username from the list of users on
the left (if you have multiple users).

N WN

If the panel is locked, unlock it to make
changes.

To unlock, click the lock icon in the lower-left
corner and enter the administrative password.

5. Click the Login Items tab (see Figure 2-5).
At this stage, you have two options:

» Open your Applications folder, and then drag
and drop the application(s) into the Accounts
panel.

This first method is much, much faster than
the second.

» Click the plus sign under the list of Login
Items, navigate to the application by using the
Open sheet that appears, select the applica-
tion, and press Return.
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eeon Accounts
[« » ][ showan | a

! Password | Picture | Loginitems | Parental Controls '

These items will open automatically when you log in:

Larry Ullman
Admin

er Accounts Hide | Item Kind
Marc Liyanage 1 Snapz Pro X Application
Standard O @ mail Application
] @safari Application
O # System Preferences Application

To hide an application when you log in, dlick its Hide checkbox.

.+.

‘m Login Options

+

()

il
Jﬂ Click the lock to prevent further changes.

¢ Figure 2-5: Larry’s list of must-be-running applications is
included in his list of startup items.

6. After you finish, click the lock icon to finalize
the changes.

Speed up the startup process by disabling
automatic startup applications when you won't
need them: Hold down Shift after logging in.
This trick works only if you've gone through
the login panel. (It doesn’t work with auto-
matic logins.)

Start the day with a song

Have your Mac greet you with a song. It won’t save you a
lick of time, but it might brighten up your day. Here’s how:

1. Open the Login Items panel by using the previous
instructions.

2. Switch over to iTunes.
3. Find the song du jour in iTunes.
4. Select Filez>Show Song File or press 38-R.

This highlights the actual song file as it exists on your
computer.

5. Drag the song file into the Login Items panel.

Now your Mac plays that tune while it's starting up. When
you're sick of hearing “Good Day, Sunshine,” switch to
“Happiness is a Warm Gun” instead.

This trick works with any kind of file. You can automatically
open a Word document at startup (that novel you've been
hacking away at) or an Xcode project.

While you're messing around with System Preferences,
it’s a good time to make the autoloading applications
do their things. For example:

v Set Mail to automatically check for new e-mail
every so many minutes.

Use Mail’s General preferences panel (see Figure
2-6), accessed through Mail=>Preferences.

808 General (=)

] e @ ®© wm [/ /4 W

General Accounts Junk M Manually psing Signatures Rules

Default Email Readet Every minute B

Every 5 minutes
Check for new mai

Every 30 minutes
Downloads Folder Every hour B
New mail sound: T New M2 !]
Add invitations to iCal: rAu[cma[icailv i ]

4] Play sounds for other mail actions

" Index decrypted messages for searching

Synchronize with other computers using .Mac:
| Rules, Signatures, and Smart Mailboxes

| Accounts

()
—r

( -Mac... ) (

¢ Figure 2-6: Have Mail automatically fetch new messages
if you have an always-on Internet connection.

v Set Safari to automatically open a specific URL
when it’s launched.

Use Safari’s General preferences panel (choose
Safaric>Preferences) to set a Home page and indi-
cate that all new windows should open with that.



Keeping the System

Keeping the System Preferences Handy

v || System Preferences

.Mac
Preferences Handy
Appearance
. . . . . CDs & DVDs
Many of the techniques in this book involve going to Date & Time
one of the System Preferences panels. And it’s not g_“klmp & Screen Saver
uncommon to change some setting in some panel at ng(m
least once every day. For this reason, we make the Energy Saver
Exposé

entire System Preferences application more readily
available with these steps:

International
Keyboard & Mouse
Network

1. Add System Preferences to the list of automati- g&?c[:‘nf::
cally opened applications (refer to Figure 2-5). Security
Sharing
See the instructions in the preceding section for Software Update
specifics. The System Preferences application :"“”dh
itself is in your Applications folder. sf:r:fm Disk
. iversal
2. If you want, select the Hide check box. e
Remove from Dock
This step hides the System Preferences window Open at Login
after it opens so that it doesn't clutter your screen. et
3. To access a specific System Preferences pane, st

Control-click the System Preferences Dock icon
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QN & ¥ W
* Figure 2-7: Control-click the System Preferences Dock

icon to bring up a contextual menu.

(see Figure 2-7).

The Dock icon presents panes in alphabetical
order, which is easier to navigate.

4. Select the specific pane you want from the list
that appears.



Running Tiger
Faster

Technique

Save Time By

v Performing a little
maintenance

v Turning off OS options
and features

v Extending your laptop
battery’s life

v~ Spending your hard-
earned money wisely on
speed-enhancing
improvements

in this technique show you how to save time primarily by adjusting

system-wide settings. They’re of the “do it once and forget about it”
variety, except for the first list of steps, which is more of a “do it monthly
and you’ll be happier” kind.

I ike many of the other techniques in the first part of the book, steps

First, we show you how routine maintenance can improve your Mac’s
performance. Much in the same vein, you then see some best practices
that help Tiger run most effectively. For laptop users, we give some atten-
tion to the related ideas of energy management and extending your bat-
tery’s life. Finally, we cover the best ways to improve your computer’s
performance by adding hardware. (As you might expect, throwing some
money at a sluggish computer can go a long way.)

Optimizing Your System through Maintenance

Your Mac is a complex machine with lots of software and moving parts
and doodads and cogs. Using your Mac inevitably adds extra clutter and
confusion to the machine, which slows it down. This sounds bad, but it’s
perfectly normal. We don’t advocate that you leave your computer off
(although, ironically, never turning on your Mac is the best way to keep it
running quickly), but we recommend some routine maintenance to
improve its performance.

We haven’t experienced any problems during optimization, but you'll
be working on your system files and removing some cached data, so

you can never be too careful. One very good idea is running a thor-

ough backup before optimizing the system. (See Technique 49 about

that backup.) This way, should there be a problem, you won't lose
your valuable data.



We demonstrate the optimization steps by using the
Disk Utility application and the Finder, but you’ll
probably find it a lot easier to use a shareware appli-
cation, such as Cocktail (www.macosxcocktail.com,
$15), if you're willing to spend the money. Cocktail
provides a simple interface for you to do most of
these tasks easily.

L Mac OS X sets maintenance tasks to run when
(8 («a you aren'’t using the computer. Most of these
& are scheduled to run during the middle of the
night or early morning. Often, these routines
are never executed because the computer is
off or asleep overnight. If you normally shut
down your machine overnight, shareware
tools such as Cocktail also address these main-
tenance needs.

We recommend periodically running the Disk Utility
application and clearing caches.

To run the Disk Utility, follow these steps:

1. Open the Disk Utility application.

Disk Utility can be found in the Applications=>
Utilities folder, as you might expect.

2. Click your main hard drive’s name in the left
column (see Figure 3-1).

Click the name of the hard drive (Hard Drive,
Main, Tiger, or Macintosh HD), not the hard drive
icon above that (which is the size and model of
the hard drive).

If you have multiple hard drives or partitions,
click the name of the hard drive or partition
where Tiger runs.

3. Click the Repair Disk Permissions button under
the First Aid tab.

4. Read ahead a few pages of this book while Disk
Utility does its thing (see Figure 3-2).

The permissions repairs could take a while with
a large drive or slower Mac.

5. After the repairs are complete, quit Disk Utility.

Optimizing Your System through Maintenance
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LI Tiger =
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New Image Info Log

[EFwstA Erase  RAID  Restore

& 74.5 GB TOSHIBA MKBD.
& Panthes » To repair a disk or volume, select s con in the list on the left and dick Repair Disk

* Ta repair disk permission problems on a disk or volume that has Mac 05 X installed,

sebect its beom and click Repair Disk Pesmissions

= Click the Verily buttons 1o test the disk or permissions without changing anything.

» Ta repais your startup disk, $1art up from yeur Mac OF X Install dise (CD cr DVD, then
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3 Sruft
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Number of Folders | 16,667 Mumber of Files . 143,088

(7

* Figure 3-1: Tiger’s hard drive is selected in the Disk
Utility application.
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LI Tiger
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* Ta repair disk permission problems on a disk or volume that has Mac 05 X installed,

= crult sebect its beom and click Repair Disk Pesmissions

=i = Click the Verily buttons 1o test the disk or permissions without changing anything.

» Ta repais your startup disk, $1art up from yeur Mac OF X Install dise (CD cr DVD, then

choate Utilities > Disk Utilay

Repairing permissions for “Tiger
Delrmining codrect fie pammissEons

{ S0 Permission Repair )
Bapaining ptrmissions T
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* Figure 3-2: The Disk Utility window shows the status of
the repairs.

Tiger stores caches in a Caches folder within a
Library folder (/Library/Caches). The /Library/
Caches folders are at the top of the main Tiger hard
drive or partition and in your Home directory.
Deleting your caches might temporarily slow down
some actions, such as loading common Web sites for
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the first time. But overall, deleting these files should
help your Mac do that thing it does. Use the follow-
ing steps to clear each /Library/Caches folder:

1. Open a new Finder window if one isn’t already

open.
] Part 2 shows oodles of ways to get to the

- { <@ Finder, such as clicking the Finder icon in the
& Dock, using Exposé, and pressing 88-Tab. The

same goes for creating a new Finder window:
pressing 38-N, choosing Filer>New Finder
Window, and so on.

2. Navigate to the /Library/Caches folder that
you want to clear.

You can find the folder in one of two places:

» At the top of the main Tiger hard drive or
partition.

The easiest way to get here is to click the
main Tiger hard drive icon in the Sidebar
(assuming it’s there), open the Library folder,
and then open the Caches folder within it.

» In your own Home directory (/Users/
yourusername).

The easiest way to get here is to click your
Home directory icon in the Sidebar (a house
next to your username, assuming it’s there),
open the Library folder, and then open the
Caches folder within it (see Figure 3-3).

ana Caches =
[« = [z o] &-] a-

g IDisk
(I:i Metwork

ol ard orive
e

(] eshtcn

¥ ——— com.apple Composent  com.apple Component  com.apple Component
i L s2.localC . mpanems 52 LocalC . mpanems 52 LocalC_mpanents

9 Documents

& Mavies
o musc " . -

| Pictures

com.apple ATS com.apple.colorsyne.pr  com.apple.colorsyn.pr
ofiles.0 ofiles. 50

com.apple.dockiconca  comappleinuDatsCac  com.appielnuiDataCac
the 301 he d2a406 7250 he. 801

tom.apple. IntiDataCac

com.apple. IntiDataCac com.apple. IntiDataCac
he. 502 Pt sbdl 501

Bt shal 4294967294
17 iterm, 35.03 GB avallable

¢ Figure 3-3: Your computer’s cache contains miscellaneous
stored files that can be deleted.

3. Press 3-A or choose Edit->Select All to select
everything in the folder.

4. Press 8-Delete to send it all to the Trash (or
choose File=>Move To Trash).

5. Enter your password at the prompt (see

N
Figure 3-4).
‘ALANAl 3 -
;e e Q-
g Disk Authenticate -~
[ Y Finder requires that you type your password. |
— Ak Rapple.colorsyne. pr
| vard O : afiies. 501
p—
!an‘.ou Name: Larry Ullman |
-~ Password: |eessssns -anple Component
it worenna | i |
e Aopcasd :
fie 7) Cancel ) (E5OK) |
9 Documents_ I
tom.appie. niDatkCac
h Manies he.501
é Mussc =
§ Pictures
= com_apple niDateCac  comapple ntiDatsCac  com apple IntiDataCac
he.502 i Abal 4294967294 Bit.sbdl. 501

* Figure 3-4: Deleting system files requires administrative
authentication.

6. Press 3-Shift-Delete to empty the Trash (or
choose Finder~>Empty Trash).

7. [If the Are you sure you want to remove the
items in the Trash permanently? prompt
appears, click OK or press Return.

When emptying the Trash, click the Continue
button if you see this error: The operation
cannot be completed because the item
someitem is in use. The next time you
log into your computer you can finish empty-
ing the Trash.

If running the Disk Utility and clearing caches (or
using something like Cocktail) don’t return your Mac
to full speed, you can take the more drastic step of
zapping your PRAM. The PRAM stores system set-
tings. Resetting this bit of memory can get rid of
some gremlins, although you have to re-establish
some settings afterwards. Here’s what you do:

1. Restart your Mac while holding down 38-Option-
P-R (yes, all at the same time).



2. Wait until you hear the special chime two or
three times.

3. Release all the keys to let your Mac boot
normally.

Speeding up specific applications

You can improve the performance of your favorite applica-
tions by giving processor priority to specific ones. The Speed
Freak utility from Big Fat Stinking Software (http://home.
comcast.net/~jeff.ulicny/software, donationware)
can do this for you. Tiger gives all applications (processes, in
technical terms) the same priority. Speed Freak lets you give
preferential treatment to particular applications (Safari or
Adobe Photoshop), so they run faster. Applications you care
less about will run more slowly, but sacrifices have to be
made.

Disabling Unnecessary Features

A tough balance exists between features and per-
formance. The more features you run, the more your
computer has to do. The more your computer has to
do, the slower it becomes. The trick is to balance
functionality and speed. Therefore you should adjust
your operating system and computer usage so that
your Mac doesn’t waste precious resources doing
unnecessary things.

You can enhance your speed with these common
techniques:

1 Remove CD-ROM discs and external hard drives
when you aren’t using them. Your Mac has to
keep track of all mounted disks (and discs), be
they CD-ROMS, DVDs, or external hard drives.

» Tracking discs requires processor effort,
which could be better used elsewhere.

» Keeping an eye on large FireWire drives takes
a noticeable toll on your Mac. (Dismounting
and unplugging an external drive might cut
that electricity bill a bit, too.)

v Turn off the iDisk synchronization. Tiger has
built-in support for iDisk, so your iDisk can be
available for access and in synchronization at all

Disabling Unnecessary Features 2 9

times. This means that your computer is con-
stantly checking the status of your iDisk and
updating it. This is a drag in performance, net-
work speed, and hard drive space.

To disable automatic iDisk synchronization, do
the following:

1. Open the Internet & Network section of the
System Preferences panel.

2. Click the .Mac icon.
3. Click the iDisk tab.

4. Check whether the tab says iDisk Syncing Off
(see Figure 3-5).

If iDisk synchronization is on, click the Stop
button to shut it off.

88eo Mac
[« » [ showall | Q

! Account Sync | iDisk | Advanced |

iDisk Storage: larryullman

Disk Space: ! .
0 62 MB 125 MB
Currently Used: 64 MB W
)
Capacity: 125 MB \%,
iDisk Syncing Off
[ '7“ t ) Click Start to create a copy of your iDisk on your computer. You can
L otart  J  ihen use your iDisk when you are not connected to the Internet.
Synchronize: = Automatically Manually
Your Public Folder
Allow others to: ) Read only " Read & write

(| Password protect your Public Folder Set Password

* Figure 3-5: Keep iDisk synchronization off for better
performance.

Having an iDisk is one of the benefits of paying
for a .Mac account (both of which we cover in
Technique 42). Simply put, the iDisk is 250MB

of online storage. (It used to be 100MB, but
Apple has increased the allotted space.) There's
a little more to it than that — like a .Mac Web
page, a .Mac mailbox, an easy way to download
software, and a method for sharing documents
online — but that's the gist of the idea.
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v Turn off the items in the Sharing panel if they
won’t be used regularly (see Figure 3-6). Tiger
supports several network-related services:
Personal Web Sharing, Personal File Sharing, and
Printer Sharing. Each of these requires an actively
running process. Most wait quietly in the back-
ground, but you don’t need to have them turned
on if you aren’t regularly using them. Click the
Sharing icon under the Internet & Network section
of System Preferences to access the panel and
check Technique 40 for the details (including the
related security issues).

een Sharing
[« »][ showan | al

Computer Name: Larry Ullman's PowerBook G4

Other computers on your local subnet can access
your computer at Larry-Ullmans-PowerBook -

( Edit... )
Ga.local ——

! Services | Firewall Internet

Select a service to change its settings.

On | Service

Personal File Sharing
Windows Sharing
Personal Web Sharing
Remote Login

FTP Access

Apple Remote Desktop
Remote Apple Events
Printer Sharing

Xgrid

Personal File Sharing Off
(‘. Start J

Click Start to give users of other computers
access to Public folders on this computer.

()
o

il
' q Click the lock to prevent further changes.

* Figure 3-6: The Sharing panel provides easy access to
different services.

The good people at Apple were smart enough
- (ﬂ to have all the Sharing items turned off by

default. If you change these settings, try to
remember that and turn them back off again
when the time is right. For example, if you're
traveling (and therefore not on your normal
network), you don’t need to enable File or
Print sharing.

v Don’t overburden your Internet connection.
Imagine simultaneously listening to online music
through iTunes, running ESPN’s GameCast Java

applet to follow a Cubs game, instant messaging
your friends, and transferring files via FTP. For
some inexplicable reason, your computer is
incredibly sluggish. By making better decisions
(your friends can wait, so turn off iChat; wouldn’t
you rather listen to a CD anyway?), Tiger starts
purring again.

With Mac OS X, most open applications don’t
affect the overall performance when they
aren’t being used. You can save yourself time
without bringing the computer down by not
continually closing and reopening applications.

v Turn off your AirPort Card when you aren’t
online. Using an AirPort Card requires some pro-
cessing and battery power. If you aren’t currently
online, turn off the AirPort Card. See Technique
38 for other wireless-network-related ideas.

Longer Battery Life

If you're using a laptop, the life of your battery
directly affects how fast you can get things done. If
you don’t believe us, try doing anything on a dead
battery with no outlets in sight. To minimize or alto-
gether eradicate such occurrences, keep in mind the
following principles:

v~ Calibrate the battery before using it. The man-
ual that came with your Mac (you read it, right?)
tells you how to do this. Do yourself a favor and
make sure you do.

v Disable unnecessary features. See the preceding
section of this technique.

v Avoid opening applications. Starting and stop-
ping applications drains the battery more than
running them. Open only the applications you
need and keep them open until you're finished.

v Close CPU-hogging applications. A few applica-
tions use a lot of CPU power even when they’re
in the background and they should be doing
nothing. For example, Microsoft Office applica-
tions can easily use 10 percent of your CPU when



you aren’t actively using them. Use the Activity

Monitor (see Technique 4) to find CPU hogs and
quit them when they’re unused for long periods
of time.

Minimize how often the computer accesses the
hard drive. Writing to and reading from any
drive is a big drain on a laptop’s battery.

Most iLife applications suck the blood from your
battery. Avoid listening to iTunes, editing videos
in iMovie, or working with iPhoto unless you
really have to or don’t mind the shortened bat-
tery life.

Remove CDs and DVDs from the disc drive.
Your Mac must pay some attention to all
mounted drives. Removing them saves your Mac
from having to perform this chore.

Run the battery down monthly. This isn’t a
problem for most laptop users, but you should
use the battery quite a bit with some frequency,
letting the battery charge back up afterwards.
(Perpetually running your laptop plugged in kills
a battery.) Ideally, you should completely drain
and recharge your battery monthly.

Change your energy settings to Better Battery
Life. Head over to the Energy Saver panel (see
Figure 3-7) under System Preferences. One of the
default configurations is Better Battery Life
(assuming you have a laptop). This option auto-
matically configures your display, sleep, and
other settings accordingly to get the most out of
your battery.

|«

8een Energy Saver
» | [ ShowAll | Q
Settings for: | Battery [ ]
Optimization: | Better Battery Life [ ]

(_ Show Details )

n
i i Click the lock to prevent further changes.

Your energy settings are optimized for long battery life.
Current battery charge: 96%

( Schedule... )

* Figure 3-7: Laptop users should keep an eye on the Energy

Saver panel.
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If you're using a laptop, get in the habit of dis-
playing the battery status in the menu bar
while you aren’t plugged in and disabling it
otherwise. You'll want to monitor it when
you're using battery power, but it only clutters
up your screen if you're not. To access this
area, open the Energy Saver panel, click the
Show Details button, then click the Options
tab, and then select the Show Battery Status in
the Menu Bar check box (see Figure 3-8).

880
[« » | [ showail | Q]

Wake Options:

( Hide Details )

[l ..!P

Other Options:

Energy Saver

Settings for: | Battery

Bl
Bl

Optimization: | Better Battery Life |

Your energy settings are optimized for long bartery life.
Current battery charge: 96%

! Sleep | Options

" Wake when the modem detects a rin
Wake f

r Ethernet network administrator access

button to sleep the computer
brightness of the built-in display when using this power source
@Autcmaticaliy reduce the brightness of the display before display sleep
] Restart automatically after a power failure

Restart automatically if the computer "freezes

Mshow battery status in the menu bar

(_ Schedule... )

Click the lock to prevent further changes.

¢ Figure 3-8: Tiger includes more energy management

B>

options.

v Keep the screen as dim as possible. A fair portion

@
@
é

of your battery’s power goes into illuminating the
monitor. To maximize your battery’s life, dim

the monitor as much as you can. (Use the screen
brightness keys on the keyboard to do so.) If
you're working in a particularly dark place or at
night, you can get away with dimming the monitor
almost entirely and still be able to read it.

If your laptop is running off the battery but
you want to keep it awake when you aren’t
actively using it (for example, if it's processing
something or playing iTunes), dim the monitor
to the point of blackness. You save yourself
lots of power for later use.
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v Don’t play DVDs or CD-ROM-based games.
Nothing drains a battery faster.

v Turn off the illuminated keyboard. If you're
lucky enough to have one of the new PowerBooks
with the backlight keyboards, you have another
energy-saving option. Go to the Keyboard tab of
the Keyboard & Mouse System Preferences panel
and deselect the llluminate Keyboard in Low
Light Conditions check box. The backlight key-
board is a great feature, but when you need extra
juice, you can easily do without the light.

Improving Performance
through Hardware

You can do a fair amount of tweaking by using the
built-in Tiger software and running shareware, but if
you really want to enhance your computer’s perform-
ance, you have to part with some cash. Here are
some hardware improvements that you can make
(from least to most expensive):

How to upgrade your hardware

If you don't like to open a computer and mess around with
the insides, you have a couple options to get the job done:

v Have it installed at the store where you purchase the
upgrades.

v Go to an official Apple store.

v Take your Mac to an authorized Apple dealer, such as
CompUSA.

Any of these places install the new hardware for a nominal
cost (maybe $30, depending on the item in question).

If you don’t mind a little tinkering — and are willing to
assume the risks involved — new RAM, hard drives and
video cards can often be installed by using only basic tools.
You'll most likely find installation instructions with the
purchased hardware or online. Search Google or the appro-
priate Apple manual (www.info.apple.com/support/
manuals.htm1) for specifics.

v Add more RAM ($40-$200). Adding RAM is far

and away the most foolproof method for improv-
ing your computer’s performance. RAM has
become cheaper and cheaper and is ridiculously
affordable these days. If you haven’t maxed out
your computer’s RAM capabilities, consider
doing so now.

We recommend at least 384MB of RAM in
your computer. You don’t necessarily need to
go up to 2GB, but 512MB is a nice, even num-
ber and befits most Tiger users.

Purchase a faster hard drive ($80-$300). Hard
drives spin at different speeds (measured in
revolutions per minute, or rpms). The faster the
spin, the faster the drive. Most laptops use a
4,200 rpm drive by default, but 5,400 rpm drives
can be acquired for a few dollars more. Desktop
machines commonly use 7,200 rpm drives, but
these can be replaced with 10,000 rpm drives
without breaking the bank.

Purchase an external FireWire drive ($150-
$400). If you need more storage space but don’t
want to replace your existing hard drive, add an
external one. Such a device can be used only
when you need it and can be shared among many
computers. If you have a FireWire 800 connec-
tion, definitely spend the extra case for a match-
ing FireWire 800 drive (as opposed to the older
FireWire 400).

Install a better video card ($150-$400). People
who aren’t hard-core gamers often don’t value a
good video card and often don’t know how a
faster card improves the overall performance.
Everything that happens on-screen has to go
through this device, so the performance impact
is significant. Laptop users have little to no room
for improvement in this area, but desktop users
have many options. Consider buying a new card
with as much RAM as possible (64MB is fair) and
use that Accelerated Graphics Port (AGP) slot if
you have it.



Make sure that the video card manufacturer
supports Tiger with the appropriate drivers. If
they don't, either you won't reap the perform-

ance benefits or the card might not work at
all. Check a manufacturer’s Web site for com-
patibility information before making the
investment!

v Replace the motherboard (desktop users only,

$400-8900). This is a pricey step and comes
close to being impractical because motherboards
are often almost as expensive as a new computetr.
But if you have a nice machine that you want to
work with, you can upgrade to a newer, faster
processor for a few hundred big ones.

Get that new Mac ($500-$3,000). It used to be
that as a Mac user, you knew that you would
spend more for your computers, get less in
return, and have fewer options than your
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Windows friends, but those days are long gone.
Apple has had great success in developing sepa-
rate computer lines (professional and home)
with a decent range of prices and capabilities.
You can now pick up an impressive eMac for
under a grand and a low-end iBook for just over
that amount. Or, for the very budget-conscious,
the Mac mini starts at just $500.

Take out a second mortgage and get a new dual-
processor G5, with all the RAM that you can
cram into it and a new 23-inch studio display
($5,000). Buy each of us one while you're at it.

If you're looking through this book in a library
or bookstore, we highly recommend that you
purchase your own copy (or better yet, buy

several, and you'll never need to read the
same copy twice). The small price is well worth
the timesaving techniques!



When Good
Applications

Technique 69 Bad

Save Time By

v Killing stalled-out
applications

+~ Keeping an eye out for
problems with the Activity
Monitor

v+~ Rebooting or shutting
down your Mac when the
chips are down

we’ve ever used. However, we still encounter the occasional prob-

lem or misguided application that mucks up the works. Fortunately,
OS X has protected memory: a stalled-out application no longer brings
down the whole machine. But stalled applications gum up the works and
leave your computer hanging. These techniques show you the best and
fastest ways to monitor and shut down problematic software. In an ideal
world, you'd never need to use these techniques, but in reality, following
these steps can keep your system going. As a last resort, you also see the
safest, most effective method for unsticking a stuck Tiger.

Tiger is a most excellent operating system — perhaps the best that

Slaying Stalled Apps with the Dock

Tiger lets you kill errant applications from the keyboard or the screen.

Always attempt to quit an application in the usual way before per-
forming a force-quit. Always give your quits and force-quits a few

moments to work before trying anything more drastic.

this application some monumental task (such as heavy image or video

Before you cancel a slow app, make sure that you haven't assigned
processing) that explains its sluggishness.

From the keyboard, just press 88-Option-Esc to bring up the Force Quit
Applications window (see Figure 4-1).
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Force Quit Applications

ec0e

If an application doesn't respond for a while,
select its name and click Force Quit.

B BBEdit
# clearscreen
# Fetch
tj iTunes
! LaunchBar
= Preview
& Safari
% System Preferences
4) wClock

K Finder

You can open this window by pressing 'FBPEE"QH
Command +0ption+Escape.

* Figure 4-1: The Force Quit Applications window allows
you to shut down applications.

You can also bring up the Force Quit
Applications menu by choosing Apple>Force
Quit.

On-screen, you can use the Dock to kill stalled appli-
cations. Here’s how:

1. If an application doesn’t respond, click and
hold its Dock icon to bring up a contextual
menu (see Figure 4-2).

ART

Keep In Dock
Open at Login
Show In Finder
Hide

Force Quit

* Figure 4-2: Clicking and holding a Dock item brings up a
contextual menu.

2. If the Force Quit option isn’t already visible,
press Option while still clicking the Dock icon
to get it.

The application’s contextual menu should now
be visible

3. If the application’s contextual menu reads
Application Not Responding and you aren’t
doing something intensive with it, choose Force
Quit.

4., Wait a couple minutes to let the system stabi-
lize; then reopen the application.

Gaining Better Performance
through Activity Monitoring

Tiger’s Activity Monitor is found in the Utilities
folder. This application does exactly what you’d
think: It monitors the activity of the computer. The
interface of the application is a bit techie, but it can
be a very useful tool for catching problems and fine-
tuning your computer’s performance.

Activity Monitor can set up a floating CPU window
that allows you to continuously monitor your CPU’s
activity. You can use the CPU window to catch apps
that might be slowing down your system perform-
ance. Follow these steps to set up the window:

1. Open the Activity Monitor, located in the
Utilities folder.

2. Choose Window=>Show Floating CPU Window
and then choose either Vertically or
Horizontally (see Figure 4-3).

By default, the Activity Monitor doesn’t display a
floating CPU window. This step keeps the win-
dow visible even after you hide the Activity
Monitor application.

Instead of using the menu bar, you can also
create the floating CPU window by pressing
88-4 or 38-5.
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[ Window JL3 =
Minimize ®M
Zoom
Activity Monitor 1
CPU Usage 82
Show Floating CPU Window » - Horizontally 34
g Vertically 5
Bring All to Front v Do not show

¢ Figure 4-3: Choose a type of floating CPU window to
display: Horizontal or Vertical.

3. While you have the Activity Monitor open,
adjust the update frequency by choosing
View>Update Frequency— Less Often.

7 Setting the Activity Monitor to update less
e { <@ often minimizes the performance effect that
&

running the monitor has on your computer.

4, If the floating CPU window (see Figure 4-4)
turns to solid green or solid green and red for
more than a few seconds, a program is using up
all the available processing power (which slows
down everything else).

il .
* Figure 4-4: The Activity Monitor creates a bar graph
indicating CPU usage.

5. Click the Activity Monitor icon in the Dock and
press -1 to bring up the Activity Monitor
screen (if it isn’t already up).

The Activity Monitor icon can look like the moni-
tor image next to the Dock’s Finder icon in Figure
4-4, or it can be a graph itself (see Figure 4-5).

"
il
¢ Figure 4-5: The Activity Monitor can also be represented
by a history graph of CPU usage.

Technique 4: When Good Applications Go Bad

The Activity Monitor’s Dock icon can be used
to show CPU usage or history (see Figure 4-5),
network or memory usage, or hard drive activ-
ity. Select which one you want by choosing
Viewr>Dock Icon.

6. Click the %CPU column heading so that CPU
usage is displayed by process in descending
order (see Figure 4-6).

If a process name appears in red in the process
list, the application is no longer responding and
needs to be shut down.

ee8 Activity Monitor =)
Q- Filte: My Processes I
Filter Show
Process ID | Process Name User ¥ %CPU| # Threads Real Memory VSIZE
449 IH Activity Monitor larryullman 19.80 2 2091MB 11152 MB =
321 & Snapz Pro X larryullman 0.30 2 25.27 MB 120.21 MB
342 « System Preferences larryullman 0.00 8 17.48MB 117.50 MB
338 | Screenshot Helper larryuliman 0.00 1 7.05MB 97.22 MB
322 A SystemUlServer larryullman 0.00 1 6.68 MB 102.04 MB
453 mdimport larryuliman 0.00 z 3.00MB  43.96 MB
304 pbs larryullman 0.00 2 154 MB 44.18 MB
236 ATSServer larryullman 0.00 2 4.20 MB 108.37 MB
346 SyncServer larryuliman 0.00 1 2.61MB 3864 MB

aan i Electon TReTou i T ann N SAn7 e 110 80 L

)' CPU | System Memory Disk Activity Disk Usage Network

CPU Usage

% User:. 25.00
%System:  19.00
% Nice:  0.00

Threads: 159

Processes: 51

ICICH

% |dle:  56.00

¢ Figure 4-6: Sort by the CPU usage to see what
applications are hogging the machine.

7. Determine whether it’s reasonable to kill the
application.

If the application in question is performing some
intensive task (like iMovie compositing a video
clip or iPhoto importing pictures), the high CPU
usage makes sense. However, if you haven’t
asked the application to do something taxing or
it’s a normally less intensive application (like
Safari), you have a problem.

8. If the application should be stopped, try quit-
ting it.

To quit the application, highlight it and click the
Quit Process icon (shaped like a stop sign) on
the toolbar, which attempts to kill the applica-
tion through normal means.



Q. If the application still doesn’t stop, force it to
quit by using one of the methods outlined in
“Slaying Stalled Apps with the Dock,” earlier in
this technique.

] If you have some time to kill or just really want
3 (@ to know what your computer is doing and why,
& the Activity Monitor is the perfect tool to spend
some time with. You can also use it to extend
your laptop battery’s life by quitting applica-
tions that use too much CPU power.

Understanding processes

In the UNIX world, a process is an active (running) applica-
tion, a daemon (a special type of constantly running utility),
or another type of service. (In fact, the UNIX operating sys-
tem blurs the lines between these ideas.) Tiger uses the
same notion of processes, so it introduces an idea that
might be foreign to you if you have no UNIX experience
(which is most of the world's population). The Activity
Monitor displays not only your open applications but also
behind-the-scenes system processes.

To find out more about any particular process, click the
Process ID in the Activity Monitor and then press 38-I. This
brings up another window with details for that particular
application, as shown in the following figure. When you're
done with your investigation, click the red button in the
upper-left corner to close the window. Don't click Quit — it
tries to shut down the process.

eee MagicMenuHotKeyDaemon (227)

Parent Process: MagicMenu (214) User: larryullman (501)

Praocess Group ID:  wheel (0}

% CPU: o Recent hangs: 0

! Memory | Statistics = Open Files and Ports -
Threads: 1 Page Ins 15
Ports 52 Mach Messages In: 351
CPU Time: 00.19 Mach Messages Qut: 917
Context Switches: 962 Mach System Calls: 1207
Faults: 1412 Unix System Calls 1196
Sample ) ' Quit

Another tool for monitoring your performance is
iPulse, which is a shareware application created by
the good people at the Iconfactory ($12.95 at http://
iconfactory.com/ip_home.asp). iPulse tracks the
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Crashing Your Mac

CPU, memory, and hard drive usage and displays
them graphically on the Desktop or Dock. It even
monitors the temperature of your motherboard.

If you want a free solution that monitors only CPU
usage, check out Xload (http://s.sudre.free.fr/
Software/X1oad.htm?l). If you are using a multi-
processor Mac, it even reports on each processor
individually.

Crashing Your Mac

Very, very rarely, your beloved Mac might come to a
grinding halt, seemingly frozen and incapable of
doing anything. Unlike those poor Windows souls,
such an occurrence should be at most an annual
event. If you find your Mac dead to the world, these
practices can solve the problem:

Periodic backups and other maintenance can
help your computer run more smoothly and
minimize the potential loss in case a crash
occurs.

To prevent and smoothly recover from crashes:

1. Give it some time.

Don’t rush your Mac or yourself. If your Mac
seems to be hanging, give the operating system a
few minutes to recover on its own.

2. Try to find and kill the offending application.

Sometimes the problem is in one application,
which can be terminated. If the offending appli-
cation is the Finder, you might need to shut
down or reboot.

3. Quit every other application before rebooting.

If, for example, the Finder is the problem, you
should still be able to switch to and quit (like
normal) every other application. Doing so mini-
mizes problems and lost documents in those
applications.
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4. When all else fails, press and hold the power Keep journaling enabled on your hard drive to
button to shut down. limit the damage from a crash. Journaling

helps your Mac recover from sudden crashes.
5. Give it some time. This option can be enabled during installation

Wait a few minutes for both your Mac and your- (see Technique 1) or from the Disk Utility.

self to cool down before booting up again.



Logging Out and
Shutting Down

Technique

Save Time By

v Logging out in different
ways

v~ Switching between users
quickly

v~ Shutting down fast

hen the time comes to call it a night, you want to get off your
WMac and on the road (or couch) as quickly as possible. In this

technique, we show you a few inside tips for speeding up that
process, covering the range of options: You can choose to log out of your
computer, switch over to another user’s account, or shut down the com-
puter. Don’t forget, of course, that you can also save time by just putting
your Mac to sleep or by scheduling it to start and stop when you like
(see Technique 2).

Logging Out

Before we cover logging out techniques, we need to make clear that log-
ging out of your computer is necessary under only two conditions:

v The Mac is used by more than one person.
v You want to make sure that no one messes with the computer while

you're away from it.

If neither describes your situation or how your Macintosh is used, stick
with your one login account and continue on your merry way.

If you share the computer and want to log out with ease, try any of the
following:

v Go to the Apple menu and choose Log Out User (where User is your
username; see Figure 5-1).

v If you've enabled Fast User Switching (see the next section of this
chapter to find out how), go to the user menu in the upper-right cor-
ner of the screen and choose Login Window (see Figure 5-2).

7

2 2 Fast User Switching is a must-use Tiger feature for multi-user
A computers.

v Press 3-Shift-Q to quit all applications and log out.

You get a warning message, as shown in Figure 5-3. Just press Return
to log out or Esc to cancel.
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About This Mac
Software Update...
Mac OS5 X Software...

System Preferences...

Dock [ 2

Location b

Recent Items [

Force Quit... AHED

Sleep

Restart...

Shut Down...

Log Out Larry Ullman... 4#Q
* Figure 5-1: The Apple menu gives the option of

logging out.

) (=1 Thu 11:07 AM @]

& Marc Liyanage

Login Window...

¢ Figure 5-2: The Login Window option makes it so that a
password will be required to re-access your
stuff.

Are you sure you want to quit all
applications and log out now?

If you do nothing, the system will log out
automatically in 117 seconds.

.;' Cancel '_,l ( Log Qut }

¢ Figure 5-3: Logging out the standard way causes this
annoying prompt.

To cut a step out of the log out process, hold
down the Option key when choosing Log Out
from the Apple menu or while pressing the
keyboard shortcut (88-Shift-Q). This eliminates
Apple’s warning.

Every method of logging out has these two results:

v The system automatically attempts to log you
out after two minutes if you don’t click either the
Log Out or Cancel button (see Figure 5-3).

v The main login screen appears after logging
you out.

If you want to temporarily log out of your
machine with the intention of returning to
your work, enable Fast User Switching and log
out from the user menu.

Unless you’re using the Fast User Switching method
of logging out, remember these two facts:

v Each logout method closes any open applications.

v If you have an unsaved document in any applica-
tion, you can’t log out until you opt to either
Save or Don’t Save that file.

Neither of these options applies to Fast User
Switching because the state of your account remains
the same (meaning that all open applications and
documents remain open).

Adding user icons

Each user on a Mac running Tiger can have his or her own
icon. This icon appears next to the username in the System
Preferences=>Accounts panel, in the main login screen, and
in the Fast User Switching menu. Besides being a nice rep-
resentation of you and your personality, user icons make
finding your login name in a list of names easy. You can
change your icon by using the Picture tab after selecting
your account in the System Preferences=>Accounts panel
(@s in this image).



86 Accounts
[a »] |\ Show All | al
My Account !" Password | Picture | Login ltems | Parental Controls
m Larry Ullman
Admin 4 —_—
w ( Edit... )
Marc Liyanage
Standsird Apple Pictures @
e 2
@
The selected picture will be used when logging in, in
the "My Card” in Address Book and as the default
m Login Options picture in iChat.
e
@
B Click the lock to prevent further changes.

From there you have four options:

v Click one of the default Apple icons in the rightmost

column.

v Click the Edit button and drag an image into the win-

dow from the Finder (see the figure).

8enNn Images
‘Recent Pictures q

= O =l

4 Plug in a camera to take a snapshot

L Choose... ) .__\' Cancel ) Set

Securing Your System with a Screen Saver 4 ’

v Click the Edit button and take a picture of yourself by
using an attached camera.

If you have a FireWire video camera (including iSight)
connected to your Mac, your image appears in the
Edit window, and you can click the Take Video
Snapshot button to make a literal iconic representation
of yourself.

v Click the Edit button and then click the Choose button
to find the image on your Mac.

If you dlick the Choose button in the Edit window, you
get a dialog (like the Open/Save ones) so that you
may navigate to and select an image on your hard
drive.

The user icon you select also is updated in your Address
Book and in iChat. If you like switching icons often, both
iChat and the Edit window from the Accounts panel
remember your most often used images.

Securing Your System
with a Screen Saver

If what you really want to accomplish by logging out
is to protect your computer while you're away from
your desk, here’s a simple step: Use your screen

saver and set it to require a password to deactivate.

1. Open System Preferences by choosing Appler>
System Preferences.

Click the Desktop & Screen Saver icon under
the Personal heading.

If the panel appears in the Desktop mode, click
the Screen Saver tab (see Figure 5-4).

Make sure that the screen saver is set to start
after a certain length of time.

N W N

For more security, set a hot corner that starts
the screen saver. This way, you can immedi-
ately enact the screen saver before you leave
your desk. Otherwise, you're trusting that no
one gets to your machine between the time
you leave and when the screen saver turns on.
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eecr Desktop & Screen Saver
|« » || Showal | Q

! Desktop | Screen Saver !

Screen Savers Preview
’:d Computer Name A
@ Flurry

55 Abstract

75 Beach

53 Cosmos

ey Forest

('-ﬁ .Mac

i Pictures Folder
4 Apple News

&3 Tunes Artwork

Fhansa Enldar b4

{ Options... ) ( Test ]

| Use random screen saver

Start screen saver: 3

3 5 13 30 lhr 2hr Never

(_ Hot Corners.. (

()

¢ Figure 5-4: The Screen Saver preferences panel.

Hot hot hot corners

Your Mac has a feature called hot corners. You can assign
special meaning to the different corners of your screen. So,
for example, moving the mouse into the upper-left corner
might turn on your screen saver, and moving the mouse
into the lower-left corner might engage Exposé. Moving
the mouse back out of a corner reverts the screen to its pre-
vious state (turns off the screen saver or Exposé, in these
examples).

You enable and assign hot corners by using either the Hot
Corners button in the Screen Savers panel (see Figure 5-4)
or by using the Active Screen Corners section of the Exposé
tab (see Technique 15).

5. Choose ViewrSecurity.

6. In the Security panel (see Figure 5-5), select the

Require password to wake this computer
from sleep or screen saver check box.

g While in the Security panel, you can also set
- («a your computer to log out after so many min-
utes of inactivity. You might find this option to
be great (because it's more secure) or a pain
(as you're consistently logging back in).

8e6c Security
[« » || showall | Q
FileVault
FileVault secures your home folder by encrypting its contents. It automatically
9% @ ® encrypts and decrypts your files while you're using them.

WARNING: Your files will be encrypted using your login password. If you forget your
login password and you don’t know the master password, your data will be lost.

A master password is not set for this computer.
This is a "safety net” password. It lets you unleck any
FileVault account on this computer.

(" set Master Password...

FileVault protection is off for this account.

(" Turn OnFileVault...
Turning on FileVault may take a while. -

@ Require password to wake this computer from sleep or screen saver
For all accounts on this computer:

| Disable automatic login

Require password to unlock each secure system preference

Log out after 60 . minutes of inactivity

[ Use secure virtual memory

il
J " Click the lock to prevent further changes.

()

¢ Figure 5-5: You can password-protect your computer
through the Security panel.

Fast User Switching

The main benefit of Fast User Switching is that a
user can log out without quitting every application.
In other words, it maintains everything exactly as
you have it but doesn’t let anyone back in without
entering your password first.

To enable Fast User Switching, do the following:

1. Open System Preferences.

2. Click the Accounts icon under the System head-
ing (see Figure 5-6).

3. In the Accounts panel (see Figure 5-7), click the
Login Options button at the bottom of the left
column.

The Login Option panel appears.

4. In the Login Options panel, check the Enable
Fast User Switching option (see Figure 5-8).



Follow these steps to switch to another account
(or switch back) with Fast User Switching:

1. Choose the account from the Fast User

Switching menu in the upper-right corner of

your screen (refer to Figure 5-2).

8een System Preferences
[« » || ShowaAll | Q
Personal
-aln E 4 a
Q (Clalade] 3 |QJ
Appearance Desktop & Dock Exposé International Security
Screen Saver
Hardware
- 4 1z ul =l - Y @
CDs & DVDs Displays Energy Keyboard & Print & Fax Sound
Saver Mouse
Internet & Network
® 6 Q @
Mac Network QuickTime Sharing
System
R & & § O @
5| \ -
Accounts Date & Time Software Speech Startup Disk Universal
Update Access

* Figure 5-6: Configure Fast User Switching from the
Accounts panel.

8een Accounts

Name: Larry Ullman
J CCounts
Marc Liyanage Short Name: larryullman
Standard

4 Change Password. .. b

Address Book Card: \‘ Open... “J

i’ Allow user to administer this computer

ﬁ Login Options

|+

Change how users log in to their account

[ Password | Picture = Login ltems = Parental Controls '

A =
ﬂé{ Click the lock to prevent further changes. ‘\D

* Figure 5-7: The Accounts panel manages a computer’s
users.

Fast User Switching 43

2. Enter the user account’s password and click
Log In (see Figure 5-9).

3. To switch back to a previous account, follow
Steps 1 and 2.

8een Accounts

(4 » ][ showal | Q

My Account
. larry Ullman
Admin ™ Automatically log in as: | Larry Ullman = ]
Other Accounts
Marc Liyanage Display login window as:
Standard @ List of users

=4
(_) Name and password

Eshow the Restart, Sleep, and Shut Down buttons

Show Input menu in login window

|

Use VoiceOver at login window

I

| Show password hints

E Enable fast user switching

View as: | Name i
m Login Options
ok
‘éﬂ G
d Click the lock to prevent further changes. G

* Figure 5-8: Multi-user Macs should enable Fast User
Switching.

Mac OS X

Larry Ullman's PowerBook G4

@‘ * Marc Liyanage

Password: esssssss

Cancel Log In

* Figure 5-9: Enter the proper password to log in as
another user.
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You can add features and minimize the menu
bar requirements of Fast User Switching (see
Figure 5-10) by installing WinSwitch (www .
wincent.com, donationware).

4) = sat12:46 pm FIY BEW

é Marc Liyanage

Open Accounts...

v Standard icon
User picture
Name

Short name Login Window...

Root user
—

* Figure 5-10: WinSwitch creates a smaller Fast User
Switching menu bar icon and adds other
options.

] If users share a Mac, the Fast User Switching
=3 (ﬂ feature allows them to switch between
& accounts (having different preferences, docu-

ments, and Home folders) without losing their
place or re-establishing the work environment
upon return.

Making the Quick Exit

After you finish for the night (or morning or after-
noon) and it’s time to close up for the day, you prob-
ably want to shut down your computer. Every Mac
user knows how to do this, but not every Mac user
knows how to do it as quickly as possible.

v The old-fashioned method is to choose Shut
Down from the Apple menu (refer to
Figure 5-1).

»” You can shut down your computer by pressing
the power button on your Mac or keyboard.
This brings up a prompt of options (see Figure
5-11). At this prompt, press Return to shut down
your computer, Esc to cancel, S to sleep, and R to
restart, or click the appropriate button with your
mouse.

Are you sure you want to shut down your
| computer now?

[ Restart ) |\_' Sleep ','I |"_'

Cancel '_,I (Shut-Down-}

* Figure 5-11: Use this prompt to specify what action your
Mac should take.

From the Energy Saver panel (in System
Preferences), you can set your computer to
automatically shut down at set times. This is

great for lab environments or if you tend to
forget to shut down your computer at the end
of the day. Technique 2 covers scheduling
your Mac.

v Hold down the Option key while you choose
Apple=>Shut Down. Holding down the Option
key causes your computer to shut down immedi-
ately without any other prompts.

The Option key trick for suppressing the con-
firmation prompt also works for restarting the
computer, putting it to sleep, or logging out.



Goodbye Microsoft,
Hello Mac!

Technique

Save Time By
v~ Picking up the basics

+* Going from a control
panel to System
Preferences

v~ Getting help when the
chips are down

+* Knowing what other
resources are available

ating system and start using Macs. Maybe this is because you've

seen how great iTunes and the iPod are. Maybe it’s because that
Mac Mini is priced right. Maybe you’re making the switch out of spite for
Microsoft (because you can’t keep rewarding such shoddy workman-
ship). In any case, you’ve made the right decision. But, you might ask,
“What do I need to know about using Macs?”

So you’ve made the decision to give up that annoying Windows oper-

In this technique, we give you a nice little introduction to your Mac from
a Windows-user perspective. For starters, you find out who stole the Alt
key, what that key is next to the space bar, why your Mac has only one
mouse button (perhaps), and other basic stuff. Then you get an introduc-
tion to System Preferences, which is your new control panel. After that,
we let you know how to get help. Finally, a short list of useful Mac-related
resources is provided.

One of the most important things to understand from the get-go is
that your Windows software doesn’t run on your Mac. So don't try
installing Office for Windows. But many Windows applications are
also available in Mac versions (which you might be able to purchase
at an upgrade price). More importantly, your documents should
transfer with little or no problem. A Word document for Windows will
open in Word for Mac. It will also open in iWork’s Pages application!

Where Is the Alt Key? Mac Basics

The Mac setup — from the keyboard to the mouse to the main screen —
is just foreign enough to confuse a lifelong Windows user. The first thing
to realize is that the Mac setup is a lot simpler than it looks, and it’s defi-
nitely easier to work with than Windows. In this initial section, we famil-
iarize you with some of the basics.
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Your new keyboard

A keyboard is a keyboard, right? Well, for the most
part. If you're a handy keyboard user on a Windows
machine, you probably got used to using the Ctrl
and Alt keys as shortcuts (for closing or opening
things, quitting applications, whatever). As you’ll
quickly pick up, those keys don’t exist on the Mac
keyboard. Instead you have Control, Option, and 3
(the Command key, which is also the historical Open
Apple key). We reference these keys hundreds of
times throughout the book, but here are some quick
facts about the most important keys:

v The 3 key is the most important key. The vast
majority of shortcuts use the 3 key. Everything
from opening and closing windows to getting
information (think “properties”) about a file uses
this key.

The 38 key is the Alt key, more or less. For
example, on Windows you would use Alt-F4 to
close an application; on your Mac, you use 38-Q

(for Quit).

The 38 key is somewhat like your old Ctrl key.
Did we mention that the 88 key is the most
important? Well, it is.

Hold down the Control key while using the
only (or the left) mouse button to create the
equivalent of a right-click (see Figure 6-1).

The Option key is a modifier. Using the Option
key with other shortcuts (like 8-W to close a
window) modifies that behavior (so $8-Option-W
closes all windows).

The Shift key is also sometimes a modifier.

The Return key (the Enter key’s better-looking
sibling) doesn’t always do what you’d think it
does. Specifically, in the Finder (the main inter-
face you have — think of it like your Windows
Desktop), the Return key doesn’t open a file or
application but rather lets you rename it. This is
odd, yes, but that’s the way it is. Otherwise, the
Return key is pretty much your old friend the
Enter key.

Open
Open With
Print

Get Info

Move to Trash

Duplicate
Make Alias
Create Archive of “StickyBrain_Receipt”

Copy “StickyBrain_Receipt"

Color Label:

X @

Scripts
Finder lcon
Quick Access
Move To
Copy To
Make Alias In

yFVYVYVYYY

Automator

Enable Folder Actions
Configure Folder Actions...
Stuffit

v

2

¢ Figure 6-1: Control-click to create a right-click on the
Desktop or on a file.

Here are a couple tricks to help ease the transition:

v Pull out the cheat sheet from the front of this
book to be able to quickly reference the most
important keyboard commands.

Use the menus at the top of the screen while
you’re getting the hang of things. Nearly all the
keyboard shortcuts refer to a menu option (for
example, 38-C for Copy is the same as going to
the Edit menu and choosing Copy). So while
you're learning the ropes, feel free to use your
mouse with these menus. Speaking of the mouse,
check out the following section.

If you miss the Alt key, pry it off your old key-
board and wear it as a key chain. We hear this
is all the rage with the kids these days.



How to use a one-buttoned mouse

One of the hardest ideas for new Mac users to grasp
is the single-button mouse. Macs ship with these by
default, but dozens of multi-buttoned mice — and
you’ll probably want to get one eventually — are
available. If you have an Apple laptop, you have a
trackpad that comes with but a single button.
Whatever Mac you use, you have only one mouse
button because you really need only one. That’s all
there is to it. But we should also point out

v If you’d like to open something, just double-click
it by — yes! — clicking it twice in succession.

» You can adjust a mouse’s behavior within the
Keyboard & Mouse System Preferences panel.

You find out more about System Preferences
later in this technique.

»” You can achieve a Windows right-click by hold-
ing down the Control key while clicking. This
creates what Mac users call a contextual menu
(CM), and they are just awesome. Beyond offer-
ing the standard stuff (like the Windows right-
click), the CM can be modified in many different
ways to make them more useful. See Technique
14 for more on the wonder of contextual menus.

1 Multi-buttoned mice are often programmable
(see Figure 6-2). If you buy a different mouse
down the road, it will most likely come with soft-
ware to adjust the behavior of the buttons.

Working with the Finder, your new Desktop

The most important application on your Mac is the
Finder (see Figure 6-3), which is the Mac equivalent of
the Windows Desktop. It will often be how you access
your files, applications, and so on. Part II of this book
is largely dedicated to the Finder. Compared to your
Windows interface, what you find is that

v A Mac has no Start menu. Instead, you open
applications from the Dock (see Technique 13);
from the Applications directory; or by using

Where Is the Alt Key? Mac Basics 4 7

Favorites (see Technique 17). The Apple menu in
the upper-left corner also adds Start Menu-like
functionality.

v Icons normally line up on the right side of the
screen instead of the left.

8eeo MouseWorks
[« »|[ showal | Q
Kensington" MouseWorks. Caboue) ()
{ Buttons | Scrolling | Click Speed | Acceleration | Directlaunch™
Application Settings: “Default m A_d_d_? m
( Restore Defaults p
¢ Figure 6-2: The software for programming a multi-
buttoned mouse.
& Finde [ Co_ wwdow Hela ) 4 1051 ) Ly Uilman )
E |
—
# E|
5 B p—
e

* Figure 6-3: The Finder: your home away from home.
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+* You probably have hard drive icons instead of
My Computer.

v You can access CDs and DVDs more directly. By
default, mounted discs appear on the Desktop,
so you no longer have to look inside My
Computer to access the CD you just inserted.

v The Trash (in the Dock) works like the Recycle
Bin. And, just out of curiosity, are you really
recycling that stuff on Windows? We think not.
It’s a Trash bin. Period.

Now that you have a little introduction to the inter-
face, you can move on to other important concepts.

Setting System Preferences

System Preferences is an important tool and one we
reference frequently in this book. It controls how
your Mac behaves and how you interface with it. It’s
very much like the Control Panel in Windows. To
open it, choose System Preferences from the Apple
menu (see Figure 6-4).

About This Mac
Software Update...
Mac OS X Software...

System Preferences. ..
Dock [ 2

Location
Recent Items [
Force Quit Finder ED
Sleep

Restart...

Shut Down...

Log Out Larry Ullman... {3#Q

¢ Figure 6-4: Use the Apple menu to get to System
Preferences.

As you can see in Figure 6-5, the System Preferences
interface is organized by categories (Personal,
Hardware, and so on). Within each category is a list
of what panels are available (such as .Mac, Network,
QuickTime, Sharing). Each panel lets you adjust your
Mac’s behavior and features for that specific techno-
logical area. To access a panel, click just once on
that icon. Some other useful information:

eaen System Preferences

[« v [ showal | & Q

Personal

= w =M I B ¢ @

Appearance Desktop & Dock Exposé & International Security Spotlight
Screen Saver Dashboard

Hardware

0 & W ¢ © m &

Bluetaoth CDs & DVDs Displays Energy Keyboard &  Print & Fax Sound
Saver Mouse

Internet & Network

Mac Network QuickTime Sharing

System

N A @ ¢ B
8K 9 & @ ¢ B @
Date & Time  Software Speech Startup Disk  Universal

Update Access

Accounts Classic

Other

© ¢ =

MouseWorks  SizzlingKeys Stuffit AVR

¢ Figure 6-5: The main interface to System Preferences.

v You can use the View menu to quickly access a
panel without using the main interface.

) The View menu is the fastest way to switch
i (45 from one System Preferences panel to another.
& It's organized alphabetically.

v~ If a System Preferences panel is locked (Figure
6-6 shows a locked option), you need to unlock
it if you want to make changes.

Locking preferences panels is a great way to
make sure that changes aren’t made without the
proper authority. To unlock a panel,

1. Click the lock.

2. Enter your administrative password at the
prompt.



3. Click OK.

To relock a panel, click the open lock icon.

8eon Accounts.
[« »|[ showai | Q

[ Password | Picture | Login ltems Parental Controls '

Name: Larry Ullman

e: larryullman

Marc Liyanage
4 tandard

( Change Password.. \;'

Address Book Card: ( Open... \J

¥ Allow user to administer this computer

B Click the lock to make changes.

¢ Figure 6-6: The Accounts pane is locked to prevent
unauthorized changes.

1 Some utilities install extra System Preferences
panels.

You can find these listed at the bottom of the
main window, under Other (refer to Figure 6-5).

1 You can search the System Preferences panel.

This feature is new in Tiger and very useful for
Windows folks. For example, if you know you
need to do a printing activity, try this:

1. Open System Preferences.

2. Type print in the Search box in the top-right
corner.

As you type, a list of logical categories
appears underneath the Search box. Related
System Preferences panels are highlighted.

3. Use the arrow keys to select a specific topic
(see Figure 6-7).

The corresponding System Preferences panel
for the selected topic is highlighted more
prominently.
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een System Preferences
[« »][ Showan | Q print

Print & Fax
Printer sharing
Set printing defaults

Personal

o] Fum]

= =

Add a printer
Appearance  Desktop & Dock Exposé & International  § |
Screen Saver Dashboard Ll WS(E,'“ e
Windows file sharing
Hardware Set printer for receiving faxes
9 g =i Q - Printer sharing
Bluetooth  CDs& DVDs  Displays Energy Keyboard &  Print & Fax Sound
Saver Mouse

Internet & Network

® 6 q v

Mac Network  QuickTime Sharing
System
| ) 5|
1 9@ & @ § 4
Accounts Classic  Date & Time  Software Speech  Startup Disk  Universal
Update Access
Other

@ @

MouseWorks  SizzlingKeys  Stuffit AVR

* Figure 6-7: Search the System Preferences panel to
quickly find the pane you need.
4. Click a topic to pursue that activity.

After you click it, the proper System
Preferences panel flashes and then opens.

5. Click the X in the Search box to close the
search.

v Some panels have multiple subsections.

If a panel has subsections, they are available as
a series of tabs. Click a tab heading in order to
switch to a different tab within the same panel.

Using Mac Help

Tiger comes with its own Help tool, called the Help
Viewer. Among the uses for the Help Viewer are

v Finding answers to questions
Seeing what new features are available

Discovering special tips and tricks

AW WA

Using the glossary to make the Windows transi-
tion easier
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Many of the applications that come on your Mac, as
well as those you install, also have their own help
pages, which you can access through their Help
menus. As an example of using the Help menu, open
up the glossary page:

1. Switch to the Finder if it’s not currently the
active application.

2. Choose Help->Mac Help or press $8-? to launch
the Help Viewer.

3. In the Search box, type glossary and press
Return (see Figure 6-8).

866
[« »][a3~]

Title Rank

Mac Help

Q- glossary

¥ Help Topics
¥ Support Articles
© Multimedia Glossary: G - R (2 of 3)
© Multimedia Glossary: § - Z (3 of 3)
© Multimedia Glossary: A - F (1 of 3)
© Remote Access: CCL Command Glossary
© A Glossary of ClarisWorks Database Terms (DB)
© QuickTime VR: Glossary of Terms
© Macintosh: Glossary of Terms
& iPhoto 2.0: Colors Window Not Visible
© Remote Access: Modem Script Basics
© Apple DVD Player: Distorted Video When Played Through VCR
© GarageBand: Selecting Keyboard Shortcuts From the Help Menu
© Power Macintosh G3 (Blue and White), Power Mac G4: SCSI FAQ
© Power Macintosh G3, G4: Differences Between Available SCSI ...

Found: 1 help topics, 13 support articles Show

* Figure 6-8: Search the Mac Help to get assistance on
specific topics.

4. Double-click the What’s it called on my Mac?
result.

5. When you're done reading, click the house
icon to go back to the main Help page.

Technique 6: Goodbye Microsoft, Hello Mac!

6. Click and hold on the house icon to see a list of
other available Help pages.

Useful Migration Resources

The tips and steps in this technique are just the tip
of the proverbial iceberg when it comes to transi-
tioning to the Mac. Oodles of resources are available
to assist you. Of those, the most useful are

v Apple’s Switch site (www.apple.com/switch):
Apple discusses how you can best make the
switch and provides links to more resources
through this section of the Apple site. For
some basic information, check out the Top 10
questions.

v Apple’s Support site (www.apple.com/support):
In particular, consider using the Discussions sec-
tion, where other people post questions and
answers about various topics. If you click the
Advanced Search link on the main Support page,
you can search the Knowledge Base, Apple’s
library of useful articles.

To find out how to use the Knowledge Base
more effectively, check out this article: http://
docs.info.apple.com/article.html?art
num=75178. It shows you different keyword
shortcuts you can use within the Knowledge
Base (such as kpbg4 for PowerBook G4).

v Move2Mac (www.apple.com/switch/howto/
move2mac, $50): This application, available
through Apple’s online and brick-and-mortar
stores, automates the transition from Windows
to Macintosh. The software runs on both
Windows and the Mac OS and takes all your
documents from your old PC and puts them into
the right location on your new Mac.
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Making Vour Mac
More Accessible

Technique

Save Time By

v~ Letting your Mac tell you
what's going on

v Commanding your Mac
vocally

v~ Customizing the display
for improved visibility

v Adapting the keyboard
and mouse behavior to
suit your needs

wrists. Moreover, computers can be quite hard on the human

body, making the need for special assistance even greater. Tiger
comes with many ways to customize how you and your Mac interact,
allowing for different or just easier interactions. As you look into this
technique, you find that these features are quite useful for all Mac users,
not just those with special needs.

Not everyone who uses a computer has 20/20 vision or tireless

You can adjust your Mac’s behavior in four primary areas:

v Setting Tiger to provide audible clues

v Using your own speech to control your Mac
v Changing the display appearance

v Altering the keyboard and mouse settings

In this technique, we cover each of these in detail, primarily focusing on
the sections of System Preferences that you’ll want to use. (In case you
do not already know, you can access System Preferences through the
Apple menu.)

When searching for more information online regarding your Mac and
this subject, use the keywords Mac and assistive technology. You can
also use Mac and accessibility. Within the Mac’s Help files, the word
accessibility brings up a number of articles, many of which we cover
within this technique.

Listening to Your Mac

For users with limited vision, the Mac has several strategies for relaying
information in non-visual ways. The main feature, called VoiceOver, is
enabled within the Universal Access panel (see Figure 7-1). VoiceOver, in
short, provides an audible narration for what’s happening on your Mac.
This narration ranges from the basic, such as reading alerts and notifying
you of what window is open, to the thorough, such as reading entire sec-
tions of text.
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You can also set VoiceOver to do other neat
tricks, such as speaking

To turn on VoiceOver, click the On button or press
88-F5. (This keyboard shortcut works no matter what
application you're in.) You should immediately hear
“Welcome to Macintosh” or another greeting. After
you enable VoiceOver, you probably want to tweak
how it behaves:

» The text that the mouse cursor is currently
over

» When the mouse enters a window

Yola) Raan » When a modifier key (Shift, Control, Option) is
[« »] [ Showall | Q pressed
When using this computer, | would like assistance with: » When the Caps Lock key is engaged (SO that
[“Seeing | Hearing | Keyboard = Mouse & Trackpad - you know you're typing in all capital letters)
VoiceOver: Turn voiceOver on or off: %F5 CXE) VoiceOver Utility
®0n _Off ( Open VoiceOver Utility... | ! General | Werbosity | Navigation | Voices | Display | Pronunciation '
Zoom: '{urn z_oog;{:__n or off: X8 R T 7
~ oom In: =
8 On C off Zoom out: 8- IGDIIT Repeated Punctuation: = First Three Times % ]
When text attributes change: = Speak Attributes i !
Dis play: Switch to white-on-black: 8\ ~8 While typing speak: | Every Word ]
@ Black on White [ Use grayscale [ Speak text under mouse after delay: i
O White on Black G ' =
Enhance contrast: 4\_‘7
Nm:mal : Maxi;num ] Announce when mouse cursor enters a window
. R || Announce when a modifier key is pressed
Reduce contrast: 8\ oo =t _ Announce when the caps lock key is pressed
Increase contrast: 388°C 4. 2)
* Figure 7-1: The Universal Access pane is visually easier to @ (Reset... )
work with than other panes.
¢ Figure 7-2: Control how active the VoiceOver is by using
1. Click the Open VoiceOver Utility button. the Verbosity tab.
Click the Verbosity tab and adjust the settings . A . .
2. y J 8 3. Click the Navigation tab and adjust the settings

there (see Figure 7-2). there

You use the Verbosity tab to determine how

The Navigation aspect of VoiceOver helps you
much your computer speaks to you. For starters,

you can adjust how VoiceOver handles

» Punctuation (which standard users might not
need to hear but technical writers would)

» Alterations of text (for example, when text has
italic or bold formatting)

» Text that you type

with just that: getting around. There’s a top sec-
tion dedicated to Web pages, followed by one
section for tracking cursor movement and
another related to text.

Click the Voices tab and modify the Mac’s voice
(see Figure 7-3).



_60 - VoiceOver Utility

! General = Verbosity =~ Navigation | Veices Display Pronunciation '

Voices Rate Pitch Volume
v Default Voice Buce 89| 35 [s0%) [100][2)
Content ‘DefaultVoice  f8d 35 = s0 /s 100 %
Status (Default Voice  J#) 355 s50% 1002
Type " Default Voice i 3sI5H so sl 10005
Attributes ‘Default Voice  F#) 35 5 s50% 100 %
VoiceOver Menu (DefaultVoice |8 35 . 50 . 100 %
® P

* Figure 7-3: Select a voice and rate that works best
for you.

Your Mac comes with about 15 different voices.
Select a preferred voice first, and then adjust the
rate, pitch, and volume of that voice. You can
even select different voices for different narra-
tions (content, attributes, status, whatever).

B~ for successfully using VoiceOver. Use a voice
that you like and at a rate that makes sense

for how quickly you do things on your Mac.

2 The Voices tab is one of the most important
=)

&

5. Click the Display tab and turn on the Caption
Panel.

The Caption Panel displays, at the bottom of the
screen, the essence of what VoiceOver is also
saying. You can modify its size and transparency
to improve its visibility.

6. Finally, click the Pronunciation tab and adjust
how VoiceOver pronounces abbreviations.

You can see some examples listed there, and
hear them by clicking them. You can add and
subtract pronunciations as needed, and edit the
pronunciation of an item by double-clicking it.
This feature is particularly good for people in
fields with a specialized vocabulary.
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Editing or creating the pronunciation of some-
thing isn't as difficult as you would think. You
can start by checking out the included pro-
nunciation definitions. After that, type letters
and words that you think are appropriate, and
then use spaces and hyphens to create pauses
and break up syllables. When creating your
pronunciation, use the Play button to hear the
result and then modify the pronunciation until
it's just right.

A second way to have your computer vocalize infor-
mation for you is by using the Text to Speech fea-
ture. Found within the Speech pane (see Figure 7-4),
Text to Speech simply speaks particular things. You
can turn it on for

880 Speech
[« »|[ showal | Q

! Speech Recognition | Textto Speech l

System Voice: | Vicki B3]

Speaking Rate:

Slow Normal Fast

EAnnounce when alerts are displayed (‘. Set Alert Options... )
@ Announce when an application requires your attention

@ Speak selected text when the key is pressed (" set Key.. -J

To have clock announce the time: { Open Date & Time Preferences... )

To change VoiceOver settings: \- Open Universal Access Preferences... )

,ﬁ
=)

¢ Figure 7-4: The Speech pane dictates when your Mac
talks to you.

v Alerts (warnings and other prompts in
applications)

v When an application needs something (the
equivalent of the application’s bouncing Dock
icon)

v Selected text, when an assigned key combination
is pressed

v The current time
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If you use Text to Speech, make sure to choose a
voice and a speaking rate that’s most effective for
you. A Play button is available so that you can test
the various settings.

Technique 7: Making Your Mac More Accessible

In the Date & Time section of System
Preferences, you can set your Mac to
announce the time at regular intervals, using a
favorite voice.

Talking Back to Your Computer

Assuming that your Mac has a microphone (most
laptops have them built in), not only can your Mac
talk to you, but you can talk right back. Speech-
recognition software lets you control your Mac —
make it do things — by saying the proper commands.

Your Mac is able to perform certain actions,
such as saving a document or quitting an
application, by using the software built into
Tiger. If you want to be able to dictate e-mails
or text files, you need third-party software like
iListen (www.macspeech.com, $150 and up).
To work with your computer by using your voice, 3.
you need to enable some of Tiger’s speech recogni-
tion features. Repeat after us. . ..

1. From the System Preferences panel, open the
Speech pane.

2.

Click the radio button to turn on Speakable
Items.

After you enable Speakable Items, you see a
round window appear (see Figure 7-5). This
window

» Shows what key needs to be pressed so that
your Mac listens to you speaking. (The key is
Escape by default, which you don’t see in the
figure because the key is already being
pressed.)

4.

» Shows the sound input levels when you're
speaking.

» Links to the Speech panel and a window of
speakable commands (click the down arrow
to access these).

You can click and drag this bubble around to
position it where it’s most convenient. It will
always remain on top of every other window.

* Figure 7-5: This round little guy shows that Speech

Recognition is on.

Read the prompt on how to most effectively use
Spoken Commands, and then click Continue to
close the prompt.

The prompt provides very important informa-
tion. As you see,

» You need to hold down Escape when speaking
a command so that your Mac hears you.

» You have to use specific commands, listed in
the Commands area.

» You should speak loudly enough that you con-
sistently hit the green levels in the micro-
phone window (see Figure 7-5).

Select a sound or voice for command acknowl-
edgement.

Tiger lets you know whether it understood a
command. By default, it does this by playing a
sound, but you can set it to repeat the command
back to you by selecting the Speak Command
Acknowledgement check box.



To test the Speech Recognition software, hold
down Escape and say “Tell me a joke.” Note
that we aren’t suggesting you'll hear a good
joke!

Click the Commands tab.

L

6. Select and deselect the command groupings as
necessary (see Figure 7-6).

Here you decide what types of commands Tiger
should listen for. Click any item to see a descrip-
tion and then select or deselect the check box as
appropriate.

8een Speech
[« »|[ showal | Q

f Speech Recognition | Text to Speech !

Speakable Items: @ on () Off

Settings | Commands

Select a command set.

Listen for navigation commands
for the menu bar and menu
items.

On | Name

@ Address Book

E Global Speakable items
E Application Specific ltems
@ Application Switching

E Front Window

& Menu Bar

(" Open Speakable Items Folder ) " Helpful Tips... ) fé)

* Figure 7-6: Check out what types of commands you can
speak, and limit them if you need to.

If you type speakable in the Mac Help Search
box (see Technique 6) and press Return, you
find some instructions for creating your own
new speakable commands.

7. Click the Open Speakable Items Folder to see a
list of speakable commands.

In order for Speakable Commands to work, you
have to know what commands are available.
These are listed, by application, within the
/Library/Speech/Speakable Items folder.
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You can also see some, but not all, of the avail-
able commands by selecting Open Speech
Commands Window from the Speakable
Commands floating window (see Figure 7-5).
This resulting Speech Commands Window
also shows the most recently spoken com-
mands, and marks those commands you
spoke that it didn't comprehend as question
marks.

Using Visual Clues

The Universal Access pane has a few other settings
that are useful for people with limited vision. These
include

v Zooming in on sections of the screen

v Displaying white text on a black background (as
opposed to black on white)

v Using grayscale colors

\

Adjusting the contrast

v Having your Mac flash when alerts sound (under
the Hearing pane)

The last four options are easy to enable and use,
requiring very little thought or customization. The
zoom feature merits further discussion because it
has its own keyboard shortcuts and customization
options:

1. Open the Universal Access pane.

2. Turn Zoom on.

3. Memorize the keyboard shortcuts.

To zoom in, press 8-Option- = (equal sign). To
zoom out, press 38-Option-- (hyphen).
Fortunately these two keys (- and =) are right
next to each other, making these combinations
easier to remember.

4. Click the Options button to further customize
how the zoom works (see Figure 7-7).
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Set range for rapid zooming in and out:

. =
Maximum Zoom: -
|

Magnification (x}: 2 4 B 3 10 44 14 16 18 20

Minimum Zoom:

Keyboard shortcuts can be used any time zoom is on.

To zoom past the maximum or minimum setting, hold down
= or #®-.

| Show preview rectangle when zoomed out
qu Smooth images (Press™C3\ to turn smoothing on or off)

E Zoom follows the keyboard focus

When zoomed in, the screen image moves:

® Continuously with pointer
) Only when the pointer reaches an edge
() So the pointer is at or near the center of the image

¢ Figure 7-7: The zoom feature has its own set of
customizable options.

After you zoom in, move your mouse around —
without clicking any buttons — to move the
focus around your screen.

- people of any kind. It's very easy to use, doesn’t
interfere with your normal operations, and can
come in handy under a multitude of circum-
stances. Graphic designers in particular will

find it useful.

z Tiger's zooming ability can be useful for Mac
<

&

Customizing the Keyboard and
Mouse to Suit Your Needs

One final way in which you might want to customize
your Mac’s behavior is to adjust how your input
devices function. Slower typists, users with
restricted motor skills, and people who easily
become fatigued can benefit from adjusting the key-
board and mouse settings. There are two related sec-
tions of the System Preferences panel into which you
should delve:

Technique 7: Making Your Mac More Accessible

1. Open System Preferences, if it isn’t already
open.

2. Go to the Keyboard & Mouse pane.

3. Adjust the Key Repeat Rate and Delay Until
Repeat settings if you're having problems with
the same key being repeated (see Figure 7-8).

The Key Repeat Rate dictates how many lower-
case x’s (or whatever) are repeated if Tiger
thinks a key is being held down. The Delay Until
Repeat rate sets how much time must pass for
Tiger to think a key should be repeated. If you're
a slower typist, increasing the Delay Until Repeat
rate and decreasing the Key Repeat Rate might
minimize typing errors.

Keyboard & Mouse

e6r
[« » ][ showal | Q

f Keyboard | Trackpad = Mouse & Bluetooth  Keyboard Shortcuts '

Key Repeat Rate

Slow Fast Off Long Short

Delay Until Repeat
—_——

Type here to test settings

[ Use the F1-F12 keys to control software features
When this option is selected, press the Fn key to use the
F1-F12 keys to control hardware features

g Iuminate keyboard in low light conditions

Turn off when computer is not used for

5 secs 10 secs 30 secs 1 min 5 mins Never

( Modifier Keys... ) (?J

¢ Figure 7-8: Set keyboard repeating rates in the
Keyboard & Mouse pane.

4. Adjust the mouse behavior in the correspon-
ding tab.

You can adjust your mouse’s behavior with
respect to its tracking speed (how fast the cursor
moves) and its double-click speed (how quickly
you have to click in succession). You can also —
depending upon the mouse in use — adjust the
speed of the scroll wheel and determine the
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primary mouse button (which is great if you're
left-handed and want the right button to be
primary).

If you have a programmable input device, you
also might be able to adjust how quickly the
device moves the cursor on-screen.

Adjust the trackpad behavior by using the
Trackpad tab (if applicable).

Like the mouse, you can adjust your trackpad’s
behavior with respect to its tracking speed (how
fast the cursor moves) and its double-click speed
(how quickly you have to click in succession).
You can also set important trackpad qualities,
such as whether the trackpad is ignored if a
mouse is present.

Within the Keyboard Shortcuts tab, turn on
Full keyboard access for all controls.

Doing so lets you more fully navigate your Mac
from the keyboard alone. Technique 10 discusses
this concept in greater detail.

The Keyboard Shortcuts tab is also critical in
that it displays many of the keyboard shortcuts
available within Tiger. Most of these won't
appear in any menu, so this is the only place
to find them (outside of Mac Help).

Choose View=>Universal Access.

You tweak the remaining settings within
Universal Access.

On the Keyboard tab, set the Sticky Keys and
Slow Keys properties (see Figure 7-9).

Sticky Keys lets you use a difficult keyboard
shortcut, like 8-Option-H (for Hide Others), with-
out holding down all the keys simultaneously.
The Slow Keys feature adds a delay between the
time you press a key and when your Mac regis-
ters it. On this tab, you can also tell Tiger to beep
when one of the modifier keys has been pressed
and display the pressed keys on your screen.
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[«

Universal Access
»| [ ShowAll | Q

When using this computer, | would like assistance with:

! Seeing = Hearing Keyboard @ Mouse & Trackpad '

For difficulties pressing more than one key at a time _
Sticky Keys: @Dn : Off
Treats a sequence of modifier keys as a key combination,
MPress the Shift key five times to turn Sticky Keys on or off
@Beep when a modifier key is set
MDisplay pressed keys on screen

For difficulties with initial or repeated keystrokes
Slow Keys: @ on (O off

Puts a delay between when a key is pressed and when it is accepted.
™ Use click key sounds

Acceptance Delay:

| | i ! |
Long Short

Key repeat delay can be set or turned off in Keyboard preferences: [ Set Key Repeat... )

()

¢ Figure 7-9: The keyboard behavior can be customized in

many ways.

9. On the Mouse & Trackpad tab, turn on Mouse

10.

Keys if you have a numberpad.

The keyboard’s numberpad can be used to con-
trol your mouse. This is a useful adjustment if you
have trouble with mice or trackpads. That being
said, if you don’t have a separate numberpad on
your keyboard (for example, if you have a laptop),
you'll probably find the pseudo-numberpad to be
much less convenient.

On the Mouse & Trackpad tab, adjust the size
of the cursor if it’s too small for you.

The cursor itself can be hard to see and find on
the screen, so use the sliding bar to increase its
size to a more discernable format.

11. When you finish adjusting settings, close the

12.

Universal Access pane.

Use your Mac normally, and then readjust the
various properties if needed.
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When customizing how you and your Mac inter-
act, remember that this isn’t a static relationship.
How — and how quickly — you’re able to work
might change over time, meaning that you might
have to re-tweak the applicable settings to make
them better represent your current needs.

If you have difficulty typing or using the key-
board, remember that you can also key in let-
ters by using your mouse and the Character

Palette. The Latin category displays the alpha-
bet in upper- and lowercase from which you
can select characters (double-click to insert a
character into the current document). See
Technique 28 for more on the Character
Palette.

Using macros and automated processes

Besides the controls that you can adjust within the System
Preferences panel, you can facilitate your interactions with
your Mac in many other ways. Here are just a couple
examples:

v Use Microsoft Word’s macros to automate typing, for-
matting, and more.

v Create Workflows in Automator (see Technique 61) to
perform a sequence of actions, even across multiple
applications, with one simple step.

v Use AppleScripts — those you can program yourself or
ones available for download — to run through com-
mon tasks.

v Use Microsoft Word's AutoCorrect feature to create
abbreviations of words.

Although these options aren’t necessarily geared toward
people with special needs, they can be just as or more use-
ful in that capacity.



Working with
Displays

Techniqie

Save Time By

v+~ Finding out how to
change the screen
resolution

v~ Figuring out color
management

v Adjusting how the system
handles fonts

v Using multiple monitors

monitor that supported two colors: black and green. Today’s mod-

ern computers come equipped with beautiful monitors, some of
them liquid crystal display (LCD) or plasma flat-screen, capable of dis-
playing millions of colors, and with a viewing area of nearly two feet. But
there’s more to your monitor than just the physical hardware: You also
use many pieces of software to control what you see and how you see it.

The distant ancestor of today’s Macs, the Apple Ile, had a small glass

In this technique, you find out a thing or two about what screen resolu-
tion is, how to choose the proper setting, and how to easily manage
these settings. Determining and setting the optimal resolution for your
monitor gives you more screen space to work with, a better interface,
and more reliable results (for graphic designers). Then you work with
color management in Tiger by using ColorSync. We introduce how Mac
OS X handles fonts, why you might want to adjust that behavior, and how
to do it. Finally, we cover how to configure your Mac to make the best
use of multiple monitors.

Managing Your Display Resolution

Most beginning computer users, whether they use a Mac or a PC, never
concern themselves with the display resolution. So why should you?

Because adjusting the display resolution directly affects everything you
do with your computer. (Because it all goes through the monitor, right?)

Monitors create everything that you see on-screen by using pixels, which
are small squares of colored light. Your screen resolution is set in terms
of pixels, such as 800 x 600 pixels. Common measurements for standard
monitors are

¥ 800 x 600

v 1024 x 768

v 1280 x 1024
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¥ 1600 x 1200
¥ 1920 x 1440

You also find these weird numbers if you use laptops
or a cinema display:

v 896 x 600
¥ 1152x 768
¥ 1280 x 854

The screen resolutions used on a display corre-
spond to its aspect ratio. Like televisions, most
traditional monitors use a 4:3 (width:height)
ratio. Most Apple laptops and all Apple cinema
displays use a modified widescreen ratio (like a
movie theater screen or a widescreen televi-
sion) that is closer to 16:9.

These numbers refer to how many pixels comprise
the width and height of the monitor; therefore, a
higher resolution has more pixels. How does this
affect you in practical terms?

For example, compare the images on the left and
right side of Figure 8-1. A higher resolution means
that

v You can display more folder icons in the same
monitor space (because the high resolution
offers more pixels).

v Each individual folder icon is smaller because the
pixels take less physical monitor space.

A higher resolution allows you to display more
stuff, but everything is smaller.

] A higher screen resolution might increase
(«a your productivity (you'll spend less time tog-

gling around), but also your need to see an
ophthalmologist (you'll be looking at tiny, tiny
things on-screen). So don't just accept the
default screen resolution set for your Mac —
find one that works best for you.

T ETR ISR EOTRISTITTTITESS

Wikepetr ST (ke (BAsianinniisss

¢ Figure 8-1: A folder icon at two different resolutions, the
one appearing bigger than the other.

You set screen resolutions from the Displays dialog:

1. Choose Apple=System Preferences—Displays.

2. Make sure that the Display tab is selected (see
Figure 8-2).

3. Select a higher resolution than the current
(presumably default) one.

The screen sizes available for use depend on
» The display itself

» The video card in the computer (in particular,
the amount of VRAM — Video RAM — that

it has)
8eo Color LCD
[« » | [ Showall | Q
' Display | Color '
Resolutions:
640 x 480 Colors: | Milliens ¥
640 x 480 (stretched) : -
720 x 480 Refresh Rate: n/a
800 x 600
800 x 600 (stretched)
896 x 600 ( Detect Displays )
1024 x 768
1024 x 768 (stretched) ¥ Show displays in menu bar
1152 x 768 Number of recent modes: 3 %
i
g
Brightness

¢ Figure 8-2: Control your screen resolution from the
Display tab.



4., Select the Show Displays in Menu Bar
check box.

Marking this check box creates a monitor control
in the menu bar (shown in Figure 8-3), saving you
trips to the Display panel.

you add or remove another monitor, including
a projector. Doing so allows your Mac to rec-
ognize what monitors are currently in use.
Alternatively, you can choose Detect Displays
from the pop-up menu that appears when you
click the menu bar Display icon.

z Click the Detect Displays button whenever
&}

é

[ Wed 9:47 AM

Detect Displays

640 x 480, Millions
800 x 600, Millions
v 1024 x 768, Millions

Displays Preferences...

¢ Figure 8-3: The little monitor icon in the menu bar can be
used to control display settings.

5. Set the Number of Recent Modes pop-up menu
to 3, if you have that option.

The Recent Modes drop-down list dictates how
many resolutions appear in the menu bar’s
Display menu. You probably have no reason to
show more resolutions than three unless you've
got some hog-wild resolution switching going on.

Close the Displays panel.

N &

Experiment with the new monitor setting.

If it’s too hard on the eyes, switch to another res-
olution with either

» The menu bar Display tool (refer to Figure 8-3)

» The Display preference pane (refer to
Figure 8-2)

Adjusting the Colors 63

As a compromise for your vision, you can use
a high resolution and increase the default font
sizes of the system (see “Handling Fonts” later

in this chapter) and your applications.

Virtual desktops

If you never seem to have enough monitor space for all
your stuff, you can get more screen space for your buck
with an application such as DesktopManager (http://
wsmanager.sourceforge.net, free). This program cre-
ates virtual desktops. A virtual desktop is exactly like the
Finder's Desktop except that you can have many of them
instead of just the one.

After you create multiple desktops, each can have its own
personality. Each individual Desktop can have its own back-
ground, Dock, set of preferences, open windows, and even
open applications. For example: If you have multiple proj-
ects going on at once, a different Dock can be used for
each environment. Or, you can have one Desktop in which
you're playing games and using iTunes and another where
you're actually working.

This is familiar territory for users of the Linux operating sys-
tem. Linux (and other variants of UNIX) primarily uses the
Gnome or KDE application as its version of the Finder. Each
of these applications supports multiple desktops.

You might like the idea of virtual desktops — and you might
not — but if you're whittling away time one afternoon, it's
certainly worth your consideration. And the price — free! —
can't be beat!

Adjusting the Colors

Your monitor doesn’t necessarily display colors in a
manner that’s consistent with other users’ monitors:
It’s a foreign concept to many computer users and a
hard lesson for the novice graphic designer to learn.
In fact, historically, the colors of a Mac have been
slightly brighter than those of a Windows PC. This is
because coloring is a software issue. To help adjust
for these variations, you can create different profiles
with Apple’s ColorSync application. For example,
you can calibrate different color profiles for different
purposes (graphic design, general use) and then
switch among them from the Display panel. To cre-
ate a custom ColorSync profile:
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1. Choose Appler>System Preferences->Displays
to bring up the Display panel (refer to
Figure 8-2).

2. Make sure that the Colors pop-up menu is set to
Millions and that the Refresh Rate drop-down
list is set as high as possible.

The number of colors is just that: how many dif-
ferent colors the monitor will display. We can’t
name 256 colors (let alone a million), but we can
definitely tell the difference between the two set-
tings on the monitor.

The refresh rate determines how often every-
thing on-screen is redrawn. (When you see
computer monitors on television and in
movies with lines scrolling down the page, a
refresh is taking place.) The higher the num-
ber that you select in the Display panel, the
faster the refresh. Even though you'll probably
never be aware of it, except on the lowest set-
tings, higher refresh rates are easier on the
eyes.

3. Click the Color tab (as shown in Figure 8-4).

-Yela)

4

Color LCD
> | [ ShowAll | q

| Display | Color |

Display Profile:
Color LCD

Generic RGB Profile
sRCB Profile

1 Show profiles for this display only

(_ Calibrate... )

¢ Figure 8-4: The Color panel of the Displays dialog.

4., Click the Calibrate button to begin the auto-
mated calibration process.

The Display Calibrator Assistant appears (see
Figure 8-5).

asc Display Calibrator Assistant

Introduction

@ Introduction
@ Set Up | Welcome to the Apple Display Calibrator Assistant!

@ Native Gamma % g -
This assistant will help you calibrate your display and create a custom

ColorSync profile. With a properly calibrated display, the system and
other software that uses ColarSync can better display images in their
intended colars,

@ Target Gamma
® Target White Point

® Admin . _

Dizplay calibration inwolves several steps:
® Name _ a (some steps may be skipped on some displays)
#® Conclusion

« Adjust the display's brightness and contrast

« Determine the display's native luminance
response curve

« Choose & desired response curve gamma

+ Choose a desired white point (warmth or
coolness of white)

E3

" Expert Mode - This turns on extra options.

Click the continue button belowto begin

( Continue )

¢ Figure 8-5: Use the Display Calibrator Assistant to create

your monitor’s color profile.

4. Follow the on-screen instructions to create
your profile.

The assistant is easy to use and has clear
instructions to help you through the process.
The Display Calibrator Assistant even offers an
expert mode, although if your needs are
advanced enough to require that, you probably
don’t need our help.

If you have a laptop, adjusting the brightness
of your monitor from the Display panel will
throw off your colors.

6. To change from one profile to another, select
from the available options in the Color section
of the Display panel (see Figure 8-6).

Your Mac probably comes with a couple profiles,
and every profile you add also is listed here.
Select the new profile to make the switch.
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860 Color LCD

[« » ][ showai | Q

! Display | Color ",

Display Profile:
Color LCD

Color LCD Calibrated
Generic RGB Profile
sRGB Profile

Warmer Look

| [l Show profiles for this display only

(_ Calibrate... )

¢ Figure 8-6: All the available profiles appear under the
Color panel of the Displays System
Preferences panel.

Graphic designers can create a Mac profile for
everyday use and a Windows profile for seeing
how their work will look on that other operat-
ing system. After you create the two profiles,
switching between the two is a snap!

Handling Fonts

How the system treats fonts affects your overall
Tiger experience. On your Mac, you can adjust how
the operating system handles anti-aliasing. As any
graphic designer will tell you, anti-aliasing minimizes
the jagged edges of characters to produce a
smoother appearance. Like the refresh rate issue,
this is something that you might not consciously
appreciate, but it could have a subtle effect. You can
adjust anti-aliasing by using the Appearance dialog:

1. Open System Preferences, and under the
Personal heading, click the Appearance icon.

2. Atthe bottom of the Appearance dialog that
appears (see Figure 8-7), select the appropriate
font-smoothing style.

8een Appearance
| » | [ ShowAll | Q
Appearance: ] Iﬂug ?ﬂ
For the overall look of buttons, menus and windows
Highlight Color: Blue i)

For selected text
Place scroll arrows: @) At top and bottom
: Together

Click in the scroll bar to: ) Jump to the next page
: Jump to here

] Use smooth scrolling

E Minimize when double clicking a window title bar
Number of Recent Items: 10 m Applications

10 m Documents

10 m Servers

SIS LU REI VY « Automatic - best for main display
Standard - best for CRT
Turn off text smooth Light {

—

¢ Figure 8-7: The Appearance dialog adjusts many cosmetic
and user interface settings.

(~)

Medium - best for Flat Panel
| Strong

» If you don’t like making decisions, select
Automatic and let Tiger do the thinking
for you.

» If you're using a traditional monitor, select
Standard.

» If you're using a flat-screen display (such as a
plasma cinema display or a laptop), select
Medium.

» If for some reason you want the least amount
of font adjustment possible (like us, when
writing this book), use Light.

» If none of these options apply to you and
you’re overwhelmed by the roughness of the
fonts, opt for Strong.

3. Just below the Font Smoothing Style pop-up
menu, determine to what point sizes font
smoothing should be applied.

From this pop-up menu, you can select 4, 6, 8, 9,
10, or 12. Any font of the size that you choose or
smaller will be anti-aliased. Larger fonts won’t be.

4. Close the Appearance dialog.
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How TinkerTool can help

TinkerTool, a must-have freeware application provided
by Marcel Bresink (www.bresink.de/osx/TinkerTool.
htm1), adds many customization options to Tiger. It's been
so popular in its many incarnations that its features fre-
quently end up in later versions of OS X. One adjustment
that TinkerTool can make is what fonts to use as the default
system fonts, as shown in the following figure.

TinkerTool (=3

CYels )
Emi=-F o €

Finder Dock General Fonts Permissions Reset

System : LucidaGrande, 13 pt ( Change...

System (headlines): LucidaGrande-Bold, 13 pt ( Change... )

Application: Helvetica, 12 pt |: Change... -,

Fixed-pitch: Monaco, 10 pt (_Change...

Messages:  LucidaGrande, 13 pt ' Change... )

Labels: LucidaGrande, 10 pt l: Change... )

Help tags: LucidaGrande, 11 pt (_ Change...

Window title bars: LucidaGrande, 13 pt [§ Change... ¥ Set to default )

Utility window title bars: LucidaGrande, 10 pt !_ Change... o Show preview |

Note: Some applications will ignore these settings.
Changes take effect when applications are launched or relaunched.

By adjusting these fonts, you can have a more personalized
interface, correct for a screen resolution’s settings, and
more accurately control when font smoothing takes place.

Using Multiple Displays

Many Mac users already benefit from the Mac’s ease
of using multiple monitors. Graphic designers and
video editors frequently use multiple monitors to
improve workspace efficiency. High-end applications
such as Apple’s Final Cut Pro, Adobe Photoshop, and
even Macromedia Dreamweaver have so many win-
dows open at once that you almost need to have one
monitor for open windows and another for the work
in progress itself. Laptop users can connect to
another monitor, using both it and the laptop’s built-
in display simultaneously. (The same principle
applies if you hook up a Mac to a projector for a
presentation.) In each of these cases, you need to be
able to manage all the displays. It’s pleasantly simple
with Tiger.

] You need an extra video-out port to use mul-
- { - tiple monitors with your Mac. Laptops have an
& extra port by default; desktops need either a

second video card or a video card with two
ports.

If you have two monitors (or a monitor and a projec-
tor), there are two ways you can use them. The first
is to have them mirror each other, so that they both
display the exact same information, as if you only
had one monitor. This is useful for presentations or
if you just want to use a bigger monitor for your lap-
top. The second option (nonmirroring) lets the mon-
itors act separately. One monitor will be the primary,
with the menus; the other is just extra screen space.
While very useful, not all Macs — even if they have
an extra video port — can support separate moni-
tors (not without hacking the software, that is). This
includes iMacs, eMacs, and iBooks (consumer line
products).

To configure your Macintosh to work with two moni-
tors (or a monitor and a projector), follow these
steps:

7. Connect both displays to your Mac.

When connecting any new display, turn off the
display (monitor, television, or projector), make
the connection, and then turn on the display. You
don’t have to turn off your Mac when connecting
a display.
- z a You don't need to restart your Mac to connect
A or disconnect another monitor.

2. Open the Displays dialog in System
Preferences.

3. Click the Detect Displays button.

This button brings the new monitor to the Mac’s
attention.

4. Click the Arrangement tab in the main display
window.

When using the Displays dialog with multiple
monitors, you see two separate windows:



» The main display window (see Figure 8-8)

appears on the display that also has the Dock

and the menu bars.

8e6ec Multiple Scan Display
[« »|[ showall | Q

' Display | Arrangement | Color '

To rearrange the displays, drag them to the desired paosition.
To relocate the menu bar, drag it to a different display.

__I Mirror Displays

* Figure 8-8: The main display panel controls the
arrangement of multiple monitors.

» The second display (see Figure 8-9) appears
on the subordinate monitor.

Color LCD

Resolutions:
640 x 480 | colors: (willons &)
640 x 480 (stretched) =
220 x 480 Refresh Rate:  n/z
800 x 600 [GnherWindows=)
800 x 600 (stretched) e
896 x 600 (" Detect Displays )
1024 x 768
1024 x 768 (stretched)
1152 x 768 Number of recent modes: | 3 i

it

3

Brightness

* Figure 8-9: A secondary display panel controls only the
resolution and color settings for the second
monitor.

5. In the main display, move the monitor icons
around so that they correspond with their
physical relation to each other.

Using Multiple Displays 6 7

The two connected displays are represented by
the two blue squares in the box below the
Arrangement tab (refer to Figure 8-8). The main
display has a white bar across the top of an icon,
which represents the menu bar. When you under-
stand which icon represents which monitor, you
can click and drag the icons to arrange them the
same way your displays are physically arranged.

If you're using a monitor and a projector, how
they are arranged in the Displays panel doesn’t
matter (because the screens aren’t next to each
other), but you still need to visualize how the
two screens meet up.

- format, you have essentially one large work-
space created by virtually combining the two
display areas. Consequently, the cursor scrolls
off the edge of one monitor and onto the
other. For those to work best, the monitors
should be arranged in the Displays dialog as
they are physically arranged in your work area
or you need to comprehend how the cursor
gets from a monitor to the projector’s screen
(by scrolling off of one side or the other).

2 If you're using two monitors in a nonmirroring
R}

é

6. Move the menu bar icon to dictate which moni-
tor is the primary.

The primary monitor will have the menu bar and
a Dock at the bottom; if your Dock is on the side
of your screen, it will appear on the leftmost or
rightmost screen side, accordingly.

The white bar on the top of the one display icon
represents the menu bar. You can click and drag
this from one monitor icon to the other to set the
primary computer. Your primary computer will
show the menu bar at the top, the Dock at the
bottom (if that’s your setting), and any mounted
volumes on your Desktop (if it’s set to do so).

If you have two monitors, they can mirror each
other. Mirroring means that both monitors display
the same thing at the same time — which is useful
when giving presentations because you can work on
your computer while still controlling the overhead
projection. The cursor moves in sync on both dis-
plays. To use mirroring
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1. If you haven’t already, enable the Display
menu bar icon (see “Managing Your Display
Resolution,” earlier in this chapter).

The Display menu bar tool provides you with
quicker access to your monitor settings,
including mirroring, resolution, and detecting

new displays.

2. Click the Display menu bar icon.

3. Choose Turn On Mirroring from the menu that
appears (see Figure 8-10).

4. Set the appropriate screen resolution for both

monitors in the Display menu (see Figure 8-10).

In earlier versions of OS X, both monitors had to
use the same resolution for mirroring to work;
fortunately, this is no longer the case.

| $ = 4) Larry Uliman|

Detect Displays
Turn On Mirroring

v 1024 x 768, 85 Hz, Millions
1280 x 1024, 85 Hz, Millions
1600 x 1200, 60 Hz, Millions

640 x 480, Millions

640 x 480 (stretched), Millions

720 x 480, Millions

800 x 600, Millions

800 x 600 (stretched), Millions

896 x 600, Millions

1024 x 768, Millions

1024 x 768 (stretched), Millions
v 1152 x 768, Millions

Displays Preferences...

* Figure 8-10: Control mirroring and the resolution of both
monitors by clicking the Display menu bar
icon.

5. Use the menu bar Display icon to turn mirror-
ing on and off as necessary.

When giving a presentation, you can use your
Mac's ability to easily turn monitoring on and
off to your advantage. If you want both moni-
tors to present the same information, turn on
mirroring. If you'd like to do something with-
out everyone in the room seeing it, temporar-
ily turn off mirroring and then use the
nonprojected display.

Quartz Extreme

Tiger supports a feature called Quartz Extreme. Quartz is
the underlying technology that handles 2-D graphics,
which is most everything that you see on a daily basis. A
system that uses Quartz Extreme performs significantly
faster than one that isn't.

Unfortunately, running a second monitor might disable the
Quartz Extreme feature because it requires AGP 2x
(Advanced Graphics Port) with 16MB VRAM. Running
Quartz Extreme on two monitors requires a video card that
can provide these minimum requirements for each. To find
out whether your system is Quartz Extreme—accelerated (as
shown in the following figure), check out the free Quartz
Extreme Check tool on Marc’s Web site (www.entropy.
ch/software/macosx).

O ) Check Quartz Extreme Acceleration

Display 1 is not accelerated|
Dizplay 2 is not accelerated

( Check )
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v Understanding how the
modifier keys are symbol-
ically represented
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the Finder window

v Moving around the
Desktop

v Mastering the easiest
ways to get to other
places on your computer

you read only two, read the next one, as well. Both of these chapters

discuss keyboard shortcuts: tricks for quickly getting around and
doing stuff with your fingers firmly placed on the keys. Remember: Every
time that your hands have to leave the keyboard to access the mouse,
you lose seconds that could be better spent typing (or playing games).

If you read only one technique in this entire book, make it this one. If

We divide all the requisite keyboard navigation techniques into two
broad categories: moving around within Finder windows and the more
specific “Getting Places” section, which discusses how to get yourself to
spots on the computer and your network. The first and longest section of
this chapter covers all the ins and outs of navigating windows, which are
the basic unit of the Finder. This is preceded by a brief introduction to
the various keyboard shortcut symbols that you find in Tiger — a sort of
Rosetta Stone for these commands. We also cover the Desktop because
not everything you do takes place inside a window. The final section
shows you how to quickly access parts of your Mac. These shortcuts can
be used inside or outside of Finder windows.

Keyboard Characters

Many of the keyboard navigation techniques can be found on-screen —
for example, on the Go menu (see Figure 9-1). To use these shortcuts, you
have to first know what the symbols mean. In case you never knew or
simply forgot, Table 9-1 shows how Tiger symbolically refers to the modi-
fier keys (Command, Control, Shift, Option, and Del).
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Back 38 [

Forward o6 ]

Enclosing Folder 3T
= Computer {+3C
T Home {+3H
% Network {r 38K
@ iDisk >
# Applications {3 A
| Utilities 38U
Recent Folders >
Go to Folder... {+3#EG
Connect to Server... 3#K

* Figure 9-1: The Go menu can help you navigate with the
mouse, and it lists the keyboard equivalents.

TaBLe 9-1: Common Mac MobiFier Keys

Symbol Key

& Command
A Control
& Shift

A\ Option

> Del

To really master the shortcuts in this tech-
nique, practice them on your computer while

you're reading the book.

Moving Around in a
Finder Window

Navigating, manipulating, and otherwise using the
Finder windows is such an integral part of getting
the most out of Tiger that we devote this and the
next three techniques to covering it. In Tiger, the
windows are highly customizable so that you can
tweak them to their own particular preferences.

If you really, really, really want to be able to
use your Mac faster, learn to type well.
Knowing how to type is infinitely quicker than
hunting and pecking. It also improves the

speed benefits of these keyboard shortcut
chapters.

The Finder has many shortcuts. Beginners might be
a bit overwhelmed at first. The shortcuts can vary
depending on what view mode you're using. The
Finder supports three view modes:

v Icon view

v List view

v Column view
In this technique, we discuss some keyboard short-

cuts that work in every view mode and then cover
those that work only in a particular view mode.

While in a window, use 88-1 to switch to icon
view, 38-2 to go to list view, and 38-3 for col-
umn view. These shortcuts correspond to the

order of the View icons at the top of the
Finder window.

Navigating in any view mode

These navigational tips apply in every view mode:



v Type a letter to go to the first item whose name
begins with that letter.

v If multiple items begin with the same letter, type
two or more letters to be more selective.

v Press Tab repeatedly to jump alphabetically
through a window’s contents.

v Hold down Shift while pressing Tab repeatedly to
scroll backwards alphabetically through a win-
dow’s contents.

v Press 38-[ or ] to move backward or forward,
respectively, like clicking the Back and Forward
buttons in a Web browser.

A Finder window can contain any combination
of files, applications, folders, network links, and
even volumes (hard drives, removable drives,

discs). We use the generic items to collectively
refer to all these things. (In other words, items
means things you might find in a Finder
window.)

v Use 3-~ (the tilde, found in the upper-left corner
of the keyboard) to toggle among the open win-
dows and the Desktop.

v Use the arrow keys (left, right, up, down) to
move as you would expect (namely, left, right,
up, or down).

Which view mode you use is best determined
by context and personal tastes. Technique 12
discusses the merits of each individually and
helps you decide when you should use which.

Navigating in icon view

The icon view mode (see Figure 9-2) shows the win-
dow’s contents as, well, icons. Although icon view
also shows each item’s name, you mostly see the
icons themselves. The basic shortcuts that we
describe in the previous section also work in icon
view.

Moving Around in a Finder Window 7 ’

866 @ larryuliman =
» |88 = m| -~ Q:

@ ipisk - = —_—

@ Network E | _2 [ H

Documents Library

| Hard Drive |
L B Desktop
@ larryuliman 3 |

o Mac OS X Install DVD =& |

[ Desktop " . _
£ larryullman | Nickilas
|

A Applications

Pictures

[} Documents W " =
) I [ [

[ Movies | I (ﬁ)} [

& Music | i

Public Sites.
L Pictures

8 items, 34.92 GB available 7

¢ Figure 9-2: Icon view mode is familiar to every Mac user,
although yours might look slightly different.

Use 38-1 to switch to icon view.

In addition, here are some 38 options that you can
use to navigate in icon view:

1 Press $-T to go up one level (to the parent
folder).

1 Use 8-| to go into the selected folder (see the
Documents folder in Figure 9-3).

806 @ larryuliman =
< [#=u] &) 2
" Network | I

| = ==

| Hard Drive

Desktop [ Documents } Library

@9 larryullman
5 Mac OS5 X Install DVD

-
s

5 (e | =
H Desktop i | - { 5 | B‘
3 = = =
£4 larryullman Movies Music Pictures
A Applications |
|9 Documents [ = =
. H f r
[ Movies | | @ |
& Music | 3 s
Public Sites.
. Pictures
1 of B selected, 34.92 GB et Y

* Figure 9-3: In icon view, a folder is marked as selected
when the name is highlighted in the selection
color.

v Press 38-0 to go into a selected folder.
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- items in general. You can use it to navigate by
opening a folder, to start an application by

“opening” its icon, or to open a file.

z 38-0 is the keyboard shortcut for opening
<

&

v Press 38-Shift-O to open the currently selected
folder in a new window.

Would you like a new window with that?

If you really like windows, you can set the Finder to open all
directories in their own new windows. To do so

1. Press 38-, (comma) to bring up the Finder prefer-
ences panel.

2. Select the Always Open Folders in a New
Window check box.

3. Press 38-W to close the Finder preferences
panel.

If you enable this option, Tiger opens up a new window
every time you open a directory. We find that this habit cre-
ates a very busy work environment, so we prefer to simply
use 88-Shift-O to manually request a new window when we
need one.

Navigating in list view

The list view (see Figure 9-4) shows the contents of a
folder as an itemized list. It always lists the names of
the items, but might also display various other prop-
erties. (You can customize what properties are
shown. For more information, see Technique 12.)

T larryuliman =
a-
e W Ciats Modrhed wre | ed
44 5 Documents Fow 2, 2004, 1:43 FM Foider
| =4 Hard Drive » U Ubrary Today, 12:03 PM Fotser
& larryuliman 21 e Movies Mov 2, 2004, 143 PM Folder
| S Mac CEXbsall VD = 1 i Music Now 2, 7004, 1:43 PM Folder
v U Pcnsres Todluy, 12:50 PM - Foides
i Deskzop S » (Pl Now 2, 7004, 1:43 M = Foloer
(e E Nov 2, 2004, 1:43 PM - Tei
o Applicarions
" Documents
| i Movees
& Music
Fictures
B of 8 yelerred, 14.92 CF avaiabie e

¢ Figure 9-4: The list view mode.

Use 38-2 to switch to list view.

Here are some basic commands for navigating
through list view:

v Use the up and down arrows to move up and
down the list.

v Press the right arrow to expand a selected folder
(see Figure 9-5). This is the equivalent of clicking
the little right-pointing triangle next to an item’s
name with your mouse pointer.

v Use the left arrow to close an expanded folder,
assuming that it’s selected. This is the equivalent
of clicking a down-pointing triangle with your
mouse.
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- = routpg Sep 11, 2002, 9:07 M BAKE PG Imige
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v (4 cocumems Nov 2, 2005, 14374 Folder
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* Figure 9-5: Expand a selected directory by pressing the
right arrow.

On top of these basic commands, all the 38 keyboard
shortcuts that work for the icon view also work in
the list view. For a refresher on those, refer to the
section, “Navigating in icon view.”

Navigating in column view

The column view mode is the most complex of the
three. It works a little like the list view mode but also
allows you to navigate forward and backward by
viewing the hierarchy as a series of columns within
the Finder window (see Figure 9-6).
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* Figure 9-6: The curious but extremely useful column
view mode.

Use 38-3 to switch to column view.

Here are some frequently used shortcuts for column
view:

v Use the up and down arrows to move up and
down within a column.

v Press the right arrow to move one column to the
right (see Figure 9-7).

 Disk L Application Support
= Assistants

ST Asferion,eximened

| ¥ svecservices = addressBook.data
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Images
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ann L AddressBock =

o

¢ Figure 9-7: The right arrow moves you into a subfolder’s
listing column.

v Use the left arrow to move one column to the
left.

When in column mode, the currently selected
@ item is highlighted with your selection/high-
light color. The gray highlight in preceding col-
umn indicates which folder’s contents are
listed in the current column. For example, in
Figure 9-7, the currently selected item is the
folder called AddressBook, which is high-
lighted in the selection color and whose
contents appear in the third column. The items
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listed in the second column are all in the
Application Support folder, which is high-
lighted in gray in the first column.

is to type the initial letter of an item to select
it, and then press the right arrow to move to
the next column. Repeat until you find the
item or directory you're looking for.

z The quickest way to navigate through columns
<}

Tiger offers you the choice of using column view as
your default view mode. To do so

1. Get yourself over to the Finder by clicking the
Desktop or the Finder icon in the Dock.

2. Press $8-, (comma) to bring up the Finder pref-
erences panel.

3. Click the General button if it isn’t already
selected.

4. Select the Open New Windows in Column View
check box (see Figure 9-8).

Ceneral

®6o0

o) @ ] &G

Ceneral Labels Sidebar Advanced

Show these items on the Desktop:
# Hard disks
™ CDs, DVDs, and iPods

™ Connected servers

New Finder windows open:

| @ Home i-:]

] Always open folders in a new window

@ Open new windows in column view

E Spring-loaded folders and windows

—

Delay: V
1 1 1 1 1 1

Short Medium Long

Press Space Bar to open immediately

* Figure 9-8: Use the Finder’s preferences panel to set
column view as the default.

5. Close the preferences panel by pressing $8-W.
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Navigating the Desktop

The Desktop has some keyboard navigation tricks of
its own, most of which get you to a Finder window.
Some of these options are limited based on how
you've customized your Desktop (for example, what
hard drives, servers, and devices will appear there).
The basics are

v Pressing the arrow keys works as expected, mov-
ing you up, down, left, and right.

v Pressing Tab moves you alphabetically from item
to item.

v Pressing Shift-Tab moves you reverse alphabeti-
cally from item to item.

v Typing the first letter or two of any item’s name
selects that item.

- ¥ a Within Open/Save dialogs, 38-D is the shortcut

A to your Desktop.

The following four shortcuts all require the ever-
popular 8 key:

v 3B-N creates a new Finder window showing the
default directory.

Use the Finder’s preferences to determine
which directory a new window should open by
default (refer to Figure 9-8).

»  8-Shift-T takes you to the boot disk drive on the
Desktop (the volume on which the running oper-
ating system is installed; see Figure 9-9).

v 38-0 opens a folder, volume, file, or application.

v 8-l opens a folder or volume.

Exposé, which we cover in Technique 15,
brings with it its own keyboard shortcuts.

Hard Drive

* Figure 9-9: Pressing 38-Shift-T on the Desktop highlights
the boot volume.

Getting Places

You can get to important spots on your Mac with a
number of specific keyboard shortcuts. These work
whether you're in a Finder window or just on the
Desktop itself. The first three are the most useful:
v~ 8-Shift-A takes you to the Applications directory.
v $-Shift-U goes to the Utilities directory.

v $8-Shift-H moves you to your Home folder.

] Most of these keyboard shortcuts are
- (45 duplicated — and listed — in the Finder’'s Go
& menu (refer to Figure 9-1).

These are handy typing tips, but you might never
need them:

v 38-Shift-K brings up the window displaying avail-
able networks.

v  3$B-K brings up the Connect to Server prompt.

\

&-Shift-l mounts your iDisk (for .Mac users only).

v 38-? retrieves the Help Viewer application. (This
is technically 88-Shift-/ because you need to
press Shift to get the question mark.)

One of the shareware applications that we rec-
@ ommend most often in this book is LaunchBar,
created by Objective Development (www .

obdev.at; $39 for businesses, $20 for per-
sonal use, free for limited use). Use LaunchBar



to quickly and easily get to applications, send
e-mails, open Web pages, and more without
ever leaving your keyboard. In fact, that’s the
entire point: LaunchBar lets you do many
common tasks just by typing short abbrevia-
tions. Techniques 23, 32, and 34 show specific
examples.

Another method of getting around your computer is
to use Full Keyboard Access. Full Keyboard Access
enables you to use the Tab, arrow, and other keys to
select on-screen items. To enable this, follow these
steps:

1. Open the System Preferences panel.

Click the Keyboard & Mouse icon.

w

Click the Keyboard Shortcuts tab of the
Keyboard & Mouse panel that appears.

4., Click the radio button next to All Controls
(see Figure 9-10).

5. Under Description, click any of the right-
pointing arrows to expand a section.

6. Select the check box next to a shortcut or short-

cut group to enable or disable it.

een Keyboard & Mouse

|4 » || Showal | Q

" Keyboard Trackpad | Keyboard Shortcuts }

To change a shortcut, double-click the shortcut and hold down the new keys.

On | Description Shortcut
PScreen Shots

P-Universal Access

¥ Keyboard Navigation

»Dock

P Exposé and Dashboard

P Input Menu

¥ Spotlight

REREAREER

> Application Keyboard Shortcuts

:+_ _' (' Restore Defaults )

Full keyboard access:
In windows and dialogs, press Tab to : Text boxes and lists only
move the keyboard focus between: @ All controls £

To change this setting, press ~F7.

()

* Figure 9-10: Use the Keyboard Shortcuts tab to enable
Full Keyboard Access for all control elements.
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if you know how to use it. You can even use it
to add your own customized shortcuts. See
Technique 10 for further examples.

z The Keyboard Shortcuts panel is a potent tool
R}

&

The default keyboard shortcuts, listed in the
Shortcut column shown in Figure 9-11, primarily use
the Control key in conjunction with your function
keys. Under the Keyboard Navigation heading in
Figure 9-11, you see that:

v Control-F2 takes you to the menu bar. (It’s just
like clicking the menu bar with your mouse.)

v Control-F3 takes you to the Dock.

880
|4 »|[ Showall | Q

Keyboard & Mouse

! Keyboard = Trackpad | Keyboard Shortcuts ]

To change a shortcut, double-click the shortcut and hold down the new keys.

(ﬂ'\ 'Descﬂpt\on Shortcut

™  ¥Keyboard Navigation r
E| Turn full keyboard access on or off ~F1L

~ Move focus to the menu bar ~F2

o Move focus to the Dock ~F3

# Move focus to the active window or next window ~F4 m
# Move focus to the window toolbar ~F5

] Move focus to the floating window ~Fé

| Move focus to next window in active application 8

¥ Move between controls or text boxes and lists ~F7

i Move focus to the window drawer B} X

g

(" Restore Defaults )

Full keyboard access:
In windows and dialogs, press Tab to O Text boxes and lists only
move the keyboard focus between: ® All controls £

To change this setting, press ~F7.

()

¢ Figure 9-11: The Keyboard Navigation shortcuts can really
minimize the need to use the mouse.

After you select the Dock by pressing Control-
F3, you can toggle from icon to icon by using
the left- and right-arrow keys or Tab and Shift-
Tab. Press Return to select a highlighted icon.

When you're in the toolbar of a window, use
Tab and Shift-Tab to move around. You can
use the spacebar to select an item, just like
clicking it with your mouse.
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Using the Go To Folder dialog

In the Finder, the 38-Shift-G keyboard shortcut brings up
the Go To Folder dialog (shown in the following figure),
which you can use to quickly navigate to specific directories.

GCo To Folder

Go to the folder:

Cancel )

Using the Go To Folder dialog offers the following benefits:

v A new Finder window is opened if one isn't open
already.

v If a Finder window is open, the Go To Folder dialog
operates within it.

v Tab completion (which allows you to type just a few
characters and then press Tab to complete the entry)
saves you from typing in long names.

v The Go To Folder dialog is case-insensitive.

v You can access hidden directories that don't otherwise
appear in the Finder.

v For those familiar with the cd command, the Go To
Folder dialog works identically to it.

The only trick to using the Go To Folder dialog is that you
need to know the path name for your desired destination.
A path name is the path of folders that you must follow to
find something on the computer. For example:

v The base (root) level is /.
v Apple’s e-mail client is in /Applications.

v A file on Larry’s Desktop would be under /Users/
larry/Desktop (Tarry is the short username that
he registered with).

v Larry's Desktop could also be written in shorthand as
~/Desktop; ~ (the tilde) represents the current user’s
Home directory.

v A folder on a secondary volume would have a path
name of /Volumes/volumename/foldername.

This might seem like more trouble than it's worth, but if
you have a basic understanding of where things are on
your computer, Tiger really helps you out.

To start:

1. Bring up the Go menu prompt by pressing
38-Shift-G.

2. Start typing the path name with either
» ~/ (refers to your Home directory)
» / (refers to the root or base level of the computer)

3. Begin typing the first letter or first few letters of
the directory that’s next in the path name.

For example, if something is in your Documents
folder, type Do or Doc after the ~/. If it's on your sec-
ond hard drive, type /Vo. In the figure, | begin with
~/Do to start heading into my Documents folder.

Go To Folder

Go to the folder:
~/Dd|

" Cancel '( Co )

4. Press Tab to have Tiger complete the directory
name.

Or, if you wait just a moment, the directory name is
automatically filled in. This next figure shows how
~/Do was turned into ~/Documents/.

Go To Folder

Go to the folder:

~{Documents/

" Cancel '( Co )

5. Repeat Steps 3 and 4 until the full path name
of the folder that you want to explore is
written out.

6. Press Return or click the Go button to load that
directory in a Finder window.



All in all, the Go To Folder dialog is a really smart way to
quickly hop to specific destinations on your computer.
Furthermore, getting comfortable with this system makes
the transition to using the Terminal for command line tasks
less daunting. (And most power users eventually take the
Terminal for a spin.)

Getting Places
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Essential Keyboard
Shortcuts

Technique

Save Time By

v Mastering the essential
keyboard shortcuts that
every Mac user should
know

+~ Discovering some
application-related
keyboard shortcuts

+~ Getting to know those lit-
tle F keys at the top of the
keyboard

v Making your own key-
board shortcuts

(as opposed to Technique 9, which covers navigation specifically).

These are really the most important keyboard shortcuts on your Mac
because they let you quickly do all the things you commonly do: Open
items, save documents, print things, and so forth.

In this technique, we focus on more general keyboard shortcuts

We begin with a hodgepodge of keyboard combinations that you should
know if you don’t already. These combinations cover several common
tasks. Then we go over application-related shortcuts — the key combina-
tions that you use to navigate among open applications and those that
work within all applications. Finally, this technique covers the function
keys and how to set your own keyboard shortcuts.

The Most Essential of the Essential
Keyboard Shortcuts

This and the preceding technique present a cornucopia of useful and
worthy keyboard shortcuts, but you might have difficultly memorizing
them all. These, therefore, are the most important all-purpose shortcuts:

v Pressing Return is the same as clicking OK, Yes, Continue, or whatever
the default action is for a button in a prompt (see Figure 10-1).

Are you sure you want to remove the items in the
Trash permanently?

f'ou cannot undo this action.

l Cancel 9 3 -E)P_E__;‘,

* Figure 10-1: Pressing Return is the same as clicking the highlighted button.




The Most Essential of the Essential Keyboard Shortcuts

v Pressing Esc is the same as clicking Cancel.

v 8-A selects everything in the currently used
directory or document.

v 3-C copies the selected (or highlighted) text or
image to the Clipboard.

v $-X copies the selected (or highlighted) text or
image and stores it on the Clipboard and then
deletes it from its current location.

v 8-V pastes the current contents of the Clipboard
into the current document, window, or other
location.

v $8-Z undoes the previous action, whatever it is.

applications to undo the last action, but it also
functions in the Finder. You can use this short-
cut to undelete a deleted (but not trashed) file
or to unmove something. Pretty much what-
ever you just did can be undone with 38-Z,
with some exceptions.

z Most people know that the 38-Z trick works in
<

é

1 8-0 opens anything (folders, files, volumes, or
applications).

v 3-F brings up the Find prompt (see Figure 10-2
for an example of a Find prompt; this one is from
Safari) or a new search window in the Finder.

8ene Find

Find: |

(_ Previous ) ( Next )

* Figure 10-2: Safari’s Find prompt.

v B-Shift-N creates a new folder within the current
directory.

v  #8-N creates a new Finder window.
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In the Finder preferences panel, you can use
the New Finder Windows Open pop-up menu
to set in which directory each new Finder win-
dow automatically opens (see Figure 10-3).
Bring up this panel by choosing Preferences
from the Finder menu and clicking the
General tab.

Ceneral

(660

] @ [ &

General| Labels Sidebar Advanced

Show these items on the Desktop:
Fﬂ Hard disks
W CDs, DVDs and iPods

@ Connected servers

New Finder windows open:

Thome )

1 Always open folders in a new window
[ 1 Open new windows in column view

@ Spring-loaded folders and windows

Delay: = -'5'- ]

Short Medium Long
Press Space Barto open immediately

* Figure 10-3: Use the Finder’s preferences to adjust a new
window’s default behavior.

v B-Delete sends an item to the Trash.
v B-Shift-Delete takes the Trash to the curb (which

is to say, empties it).

Those are the most critical keyboard shortcuts, but
here are a few more that are easy to remember and
quite useful:
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8-W closes the active window.
88-Option-W closes every open window.
8-M minimizes the active open window.
88-Option-M minimizes every open window.

8-P prints a document.

8-1 brings up the Get Info prompt, where you can
find information about (as well as control) some of

the properties of a file, a folder, or an application.

8-J brings up a window’s (or the Desktop’s) view

options.

88-Shift-Q lets you log out.

You can often find most or all of the shortcuts
available within a particular application, includ-
ing the Finder, by searching with the word
shortcut in that application’s Help pages.
Alternatively, KeyCue (www.ergonis.com/
products/keycue, $15) displays in a floating
window every menu keyboard shortcut for the
current application.

Most of the preceding shortcuts work in the Finder,
and most of them also function within applications
(particularly those by Apple). The following short-

cuts are more particular to the Finder:

7 d

8-D duplicates the currently selected item or
items.

If you can’t or don’t want to remember that
8-D duplicates items, you can always select
the item, copy it by pressing 38-C, and then
create the duplicate by pasting the copied
item with 36-V.

8-L makes an alias to the currently selected item
or items. An alias (what Windows calls a
shortcut) is a reference to an item. We cover
these in Technique 17.

8-R locates an original file that an alias or a
pointer represents.

] The 38-R shortcut is most useful in two specific
instances. In the Finder, if you select an alias, it
& takes you to the item that the alias points to.

In iTunes, if you select a particular track,

38-R takes you to the physical file on your
computer.

v 38-T adds the selected item to the window’s side-
bar (see Technique 12 for more).

v $-E ejects the selected disk or disc. (This disc
could be an external FireWire hard drive, a Zip or
floppy disk, a CD-ROM or DVD, or a mounted disk
image.)

When it comes to doing things on your Mac in
the most convenient way, don't forget
Universal Access, a special set of accessibility

tools for improving the standard Tiger inter-
face. We cover this and similar concepts in
Technique 7.

Application Shortcuts

Pretty much everything that you do on your Mac
takes place within an application. (Technically,
everything you do takes place within an application
because the Finder is considered an app.) You'll
probably have several applications open at the same
time. Although Part IV of this book really covers
applications in all their glory, this section covers the
highlights that should be second nature.

Technique 24 addresses application switching
@ in greater detail, discussing several shareware
applications that can be used expressly for this

purpose, such as LiteSwitch X (www.proteron.
com/1iteswitchx, $15). Technique 23 dis-
cusses the similar concept of launching appli-
cations, for which a slew of tools exists.

Here’s an easy way to switch applications:



1. Begin by holding down 3 and then pressing
Tab to bring up a palette listing the currently
open applications, with the most recently
used application automatically selected (see
Figure 10-4).

* Figure 10-4: The list of currently running applications.

2. While holding down 8, press Tab repeatedly
to move among the application icons until the
desired application is selected.

Press 38-Shift-Tab to go in reverse order.

3. Release 38 to bring up the selected application.

)

Press Escape to cancel the switch.

The Finder, Safari, and a few other applica-
tions all have a command similar to 88-Tab.
You can use 8-~ (tilde) to toggle among the
open windows.

Working with many applications and windows has
two primary considerations: switching among them
and clearing out the clutter. Knowing how to hide
current and background applications goes a long
way toward creating a neater workspace and giving
you peace of mind.

Application Shortcuts 8 ’

v Use 38-H to hide the current application.

v Use 38-Option-H to hide all the background
applications.

Exposé, Tiger's window management tool, cre-
ates special mouse and keyboard commands
to access all the open windows for the current

application or the whole operating system.
Get thee over to Technique 15 to find out all
about it.

Getting fancy with 88-Tab

Strange as it might seem, you can also use your mouse (or
other input device) in conjunction with 88-Tab. After you
bring up the palette, you can hover your cursor over an
application’s icon to select it and then release the 88 key to
travel there. You don’t even need to click the mouse for this
to work.

This means that you can perform drag-and-drop actions
with 88-Tab and your mouse or other input device:

1. In an open application, select the text, image, or
whatever you want to copy elsewhere.

2. Click and hold the selection.

3. Wihile continuing to hold your mouse click, drag
the selection slightly off in any direction.

4. Press 3-Tab to bring up the open application’s
palette.

5. Use either your cursor or Tab to select the desti-
nation application (while continuing to hold both
the mouse button and the 38 key).

6. Release the 88 key to bring up the destination
application.

7. Position your cursor in the appropriate location
in the new application.

8. Release the mouse key to complete the move.

This process might seem foreign at first, but it's remarkably
effective and a good alternative to copying and pasting.
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Function Keys

The purpose of the function keys changes dramati-
cally based on whether you're using a desktop or

a laptop Mac. Desktop Macs don’t have overriding
default function key purposes, although existing
applications and Finder shortcuts use many of them.

If you have a laptop, you might need to hold
down the fn key to use the function keys for
other than their default purposes (such as

changing the brightness or the volume).

If you have a laptop, familiarize yourself with using
these default functions:
v F1 dims the display.
F2 brightens the display.
F3 mutes the sound.
F4 lowers the sound volume.

F5 increases the sound volume.

A W W W WA

F6 engages the number lock feature, turning the
keypad into a number pad.

The function keys can perform other, lesser-
known shortcuts. Holding down Option while
pressing any of the brightness control keys
brings up the Display System Preferences
panel. Holding down the Option key while
pressing any of the sound control keys brings
up the System Preferences Sound panel.

You can change the behavior of function keys by
using shareware (sweet, sweet shareware):

v uControl (http://gnufoo.org/ucontrol/
ucontrol.html, free) lets you

» Change the function (ha!) of your keys, includ-
ing the function keys. (In other words, you
can reprogram what a key does.)

» Use Mac laptop function keys without holding
down the fn key.

v SimpleKeys (www.pidog.com, $15) is a more
advanced version of uControl. Not only can you
program the function keys, you can also execute
AppleScripts or paste text with keyboard
shortcuts.

Programming Your Own
Keyboard Shortcuts

The Mac has supported programming the function
keys in many ways over the years, but Tiger includes
a utility that does even more. From the Keyboard
Shortcuts pane, you can create your own keyboard
shortcuts that call menu commands. These short-
cuts can work in a particular application or in all of
them. Here’s a primer on how to use it, making a key-
board shortcut for the Finder’s Filec>Create Archive
command.

1. Open System Preferences.

2. Click the Keyboard & Mouse icon (under
Hardware).

3. Inthe Keyboard & Mouse pane, click the
Keyboard Shortcuts tab to bring up that pane
(see Figure 10-5).

Even if you never want to create your own
keyboard shortcuts, the Keyboard Shortcuts
pane is still great for reminding you of many

of the existing shortcuts that you can use.

4., Click the plus sign in the lower-left corner to
add a new shortcut.

4. In the sheet that appears (see Figure 10-6) do
the following:

a. Select what application you want the shortcut
to apply to in the Application pop-up menu.

b. In the Menu Title text box, enter the name of
the menu command that you want to assign
the shortcut to.



You must enter the name exactly as it appears

in the menu except for replacing ellipsis (. . .)
with a semicolon ().

c. Immediately enter the keyboard shortcut by
pressing the key combination.

8een Keyboard & Mouse

[« ][ showal | Q

! Keyboard | Trackpad | Keyboard Shortcuts }

To change a shortcut, double-click the shortcut and hold down the new keys.

On | Description Shortcut

#  ¥Screen Shots -
™~ Save picture of screen as a file #03 m
] Copy picture of screen to the clipboard #®03

| Save picture of selected area as a file ®o4

] Copy picture of selected area to the clipboard ®~{rd

™  vUniversal Access

o Turn zoom on or off E ]

¥ Zoom out 8-

# Zoom in #X=

] Reverse black and white ®~8 v
+ | ([ Restore Defaults )

Full keyboard access:
In windows and dialogs, press Tab to () Text boxes and lists only
move the keyboard focus between: ® All controls (.D

To change this setting, press ~F7.

* Figure 10-5: The Keyboard Shortcuts pane with some of
Tiger’s default shortcuts.

Application: | @ Finder .]

Menu Title: |Create Archive

Enter the exact name of the menu command
you want to add.

Keyboard Shortcut: e

( cancel ) € Add )

* Figure 10-6: The panel for adding shortcuts.
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6. Click Add, which becomes a clickable button
after you’ve met all the criteria in Step 5.

7. After you log out and log back in or restart
your computer, the new shortcut is available
(see Figure 10-7).

New Finder Window 3N

New Folder {r3EN

Mew Smart Folder N

New Burn Folder

Open %0

Open With >

Print

Close Window HW

Get Info x|

Duplicate #D

Make Alias 8L

Show Original 3E R

Add to Sidebar #T

Create Archive of "579630 fg1003.uiff"

Move to Trash E: |
IFT -_

Find... 2EF

Color Label:

.1 - v v e @

* Figure 10-7: The new keyboard shortcut has been added
to the Finder’s File menu.

Many applications have a system for creating
your own shortcuts as well. For example, in
Microsoft Word, you can create a macro and
assign it to a keyboard shortcut.
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Technique

Save Time By

v~ Setting the Finder prefer-
ences to fit the way you
use your Mac

v+~ Finding out about short-
cuts for your mouse or
other input device

v~ Getting the most out of
the Finder’s various
menus

tion on the Mac, yet many people don’t take advantage of its full

potential. It is the main interface for you to access files, applica-
tions, CD-ROMs, and more. Being familiar with it and knowing how to
customize its behavior to suit your tastes is critical to saving time on
your Mac.

The Mac OS X Finder is the most important and most used applica-

This technique begins with the Finder preferences that can be set within
Tiger. Included after this section is a treatment of the Finder’s many
menus. Then a number of input-device-related shortcuts are covered
(the clicking equivalent of many of the keyboard shortcuts listed in the
preceding two techniques).

Finder Preferences

Customizing the Finder involves using two tools: the Finder preferences
panel and the Desktop’s View Options panel. (You can also customize the
Finder windows themselves, which is an entirely different topic; see
Technique 12.)

To bring up the Finder preferences panel, either

v Press 3-, (comma).

v Click Finder on the menu bar and then choose Preferences.

- 2 To customize the Desktop, press 38-J or choose View=>Show View
A Options. We cover this topic in Technique 16.



The preferences panel (see Figure 11-1) is divided
into four sections: General, Labels, Sidebar, and
Advanced.

86.0 General

NI - ;

Ceneral | Labels Sidebar Advanced

Show these items on the Desktop:
# Hard disks
™ CDs, DVDs, and iPods
@ Connected servers

New Finder windows open:

[ |.
¥t Home el !

1 Always open folders in a new window
@ Open new windows in column view

ESpring—Ioaded folders and windows

Pt

Delay: =
1 1 Y 1 1 1

Short Medium Long
Press Space Bar to open immediately

* Figure 11-1: The Finder’s preferences panel.

General

The General section has a few important controls:

v Show These Items on the Desktop: We recom-
mend marking all these check boxes, which
makes accessing these items and knowing what'’s
connected or mounted to your computer easier.

v New Finder Windows Open: Use this pop-up
menu to determine what folder is the default
folder when opening new windows. Setting this
value saves you a navigational step (for example,
hopping over to your Home directory) with each
new window.

&

Finder Preferences 85

z If you keep your Home directory organized as
<8

Apple and the authors of this book recom-
mend and you use it accordingly, set the
Finder to open all new windows in the Home
directory, where every document that you
need will be stored.

v Always Open Folders in a New Window:

Selecting this check box is useful only if you
really, really like having lots of open windows
around.

Open New Windows in Column View: Column
view is the only view mode that can be set as the
default view for new windows. If you like it, mark
this box.

Spring-Loaded Folders and Windows: Spring-
loaded folders and windows pop open when you
drag something onto them. If you start dragging
a file and hold it over a folder, that folder springs
open so that you can place the file within a sub-
folder. You can even continue to spring open sub-
folders, allowing you to place a file several
directories into your hard drive without navigat-
ing there first.

Labels

After dropping off the radar in earlier versions of
Mac OS X, Labels — the OS 9 color-coded decorating
tool — has made a triumphant comeback. In fact, it’s
better than ever. Labels allow you to mark items
with a special highlight color, each color having its
own particular meaning. To assign what the colors
represent, do the following:

1.

2.

Open Finder’s preferences panel by pressing
8-, (comma).

Click the Labels button (see Figure 11-2).
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B f_') ' _ Labels

lCER

Ceneral __Lahels_ Sidebar Advanced

Use these label names:

Red

Orange

Yellow

Creen

Blue

Purple

Cray

* Figure 11-2: The Labels panel with its default values.

3. Highlight a color name and change the text to
whatever label makes the most sense to you.

4., Tab to the next label and change that text.

Help

Open
Open With
Print

Get Info

Move to Trash

Duplicate

Make Alias

Create Archive of "579630 fg44x.tiff”
Slideshow

Copy “579630 fg44x. tiff”

Color Label:

X @ v e

Scripts
Finder lcon
Quick Access
Move To
Copy To
Make Alias In

Automator

Enable Folder Actions
Configure Folder Actions...
Stuffit

YVYyYVYVYY

>

menu.

* Figure 11-3: Add a label to an item from its contextual

Repeat until a label name is set for each color.

4. Close the Finder’s preferences panel.

To use the Labels, follow these steps

1. Select the item or items in a Finder window.

2. Control-click the item to bring up the contex-

tual menu (see Figure 11-3).

3. Under the Color Label heading on the contex-
tual menu, click the appropriate color.

When you click each color, the contextual menu

In icon view mode, the item’s name is highlighted in
the label color (see Figure 11-5). In list and column
view mode, the entire line is highlighted. After
you’ve begun using labels, you can add the Label
column to the list view windows (see the section
“Show View Options” later in this chapter for
instructions) and then sort by this value (see
Figure 11-6).

If you use numbers in your label nhames (for
example, 1 Ciritical, 2 Important, down to 7
Low), you can easily sort a Finder window of
items by label, and they sort in numeric order.

shows the label associated with each color to
make the selection easier and more accurate.
(In Figure 11-4, the label reads “Urgent.”)



Help

Open

Open With »
Print

Get Info

Move to Trash

Duplicate

Make Alias

Create Archive of "579630 fg44x.tiff"
Slideshow

Copy “579630 fg44x.tiff”

Color Label:

X @ e v w
“Reviewed"

Scripts
Finder Icon
Quick Access
Move To
Copy To
Make Alias In

YyYVYVYVYVYY

Automator

Enable Folder Actions
Configure Folder Actions...
Stufflt 3

v

* Figure 11-4: When selecting a label color, the contextual
menu shows the corresponding text label.

anA T ‘-
[« » == m| & Q-

@ ibiak

5 nerwork

(5 Mard Drive

8 wrryuliman =

579630 cnO? 379630 chis 579830 chiny 379830 ch10

Kok
S Deskion _':é

A arnuliman
O Agplications

| Documents
I Movies

& Music =
570630 ch1a
Picsures

579630 chl0.sn 579630 ch1l 579630 chl2 579630 ch13

579630 ch15

10 mems, 6.97 GB avastable i

* Figure 11-5: Labeled items in icon view mode.

Finder Preferences 8 7

|- Pictures —

808 - e
[ =Eues] @ mZB@

® iDisk | Name " label X &

# Network » | iPhoto Library -
= Panther » |= Unused Tiger Photos -—
= Tiger © 579630 fg44 iPhoto 1.1iff Proofed
= Stuff 579630 fgl104.tiff Purple
i 579630 fgd4x.Liff Reviewed

A Applications 579630 fgl1103.tiff Reviewed
& larryuliman
@8 Desktop o |

S ¥ Timne TT for 0 )4

6 items, 13.42 GB available i

* Figure 11-6: Sorting by label in list view mode.

Sidebar

The Sidebar preferences panel (see Figure 11-7)
affects which items appear in a window’s sidebar:

v The top half of the Sidebar preferences panel dic-
tates what appears in the top half of the window
sidebar.

v The bottom half controls whether three specific
folders — the Desktop, your Home directory, or
the Applications folder — appear in the bottom
half of the window sidebar.

preferences panel that you don’t need to use
or access on a regular basis.

The Sidebar panel is the only place where you
@ can customize the top half of the window’s
sidebar. You can also customize the bottom

half manually. See Technique 12 for more.

2 Enable or disable the items in the Sidebar
a

Advanced

The Advanced pane of the Finder preferences win-
dow has just two options in the current version of
Tiger (see Figure 11-8).You can set the Finder to
always show the file extensions if you’re most com-
fortable dealing with files in this manner. (Note: A
file’s icon also implies its extension most of the
time.) You can also set whether you see those pesky
warnings when taking out the Trash.
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8en Sidebar

] @[] &

Ceneral Labels | Sidehar_ Advanced

Show these items in the Sidebar:

4 B computer
™ = Hard disks
™ € ipisk

= N Network

™ % Connected servers

4 i Desktop
4 ’_?_‘ Home

Ei /ﬁ, Applications

Iﬂ Removable media (such as CDs)

* Figure 11-7: The Sidebar preferences panel.

Advan ce d k

J 1) ik

Ceneral Labels Sidebar Adv:mced

"] Show all file extensions
E Show warning before emptying the Trash

* Figure 11-8: The Advanced section of the Finder’s
preferences panel.

7 If you trust your trashing capabilities, disable
e { -@ the Show Warning Before Emptying the Trash

option in the Advanced panel.

Changing themes

Another way to customize your Finder is to adjust what
theme it uses. By default, the Finder uses the Aqua theme,
which controls the appearance of windows, buttons, alerts,
fonts, and more. (Basically everything that gives the operat-
ing system a consistent look from application to application
is set in the theme.)

Changing your theme isn’t for the faint of heart (Apple
generally discourages the practice) and, arguably, has a
minor payoff. If you like to tinker, head over to www.
resexcellence.com/themes to download different
themes and find links to useful shareware. You'll probably
want one of the following:

v ShapeShifter (www.unsanity.com/haxies/shape
shifter, $20), which lets you change themes in the
least intrusive way possible.

v Duality 4.0 GT (http://carpestellarem.com/
Products/Duality), which allows you to change the
themes (they call them schemes). Duality is available in
both free and professional (paid) versions.

v ThemeChanger (http://sourceforge.net/
projects/themechanger), which also changes
themes and is also free.

Show View Options

You can access the Finder’s second area of cus-
tomization by either

v Choosing Viewr>Show View Options.
v Pressing 8-J.

The View Options settings apply to the currently
active window, if one is open and active. If no win-
dow is open and active, the View Options panel
applies to the Desktop.

When you apply the View Options to the Desktop
(see Figure 11-9), you control only how items appear
on the Desktop. (View Options can affect Finder win-
dows more dramatically.) Here’s the two-second
guide to what the options mean:



v The first three settings — Icon Size, Text Size,
and Label Position — do what you’d expect:
They control how big an item’s icon is in pixels,
adjust the point size for the item’s name, and
position the item’s name either underneath or to
the right of the item’s icon.

(i) Desktop

lcon size: 48 x 48

v d

Small Large

Text size: 12 pt | % ]

Label position:
'E} Bottom : Right

[ Snap to grid

] Show item info

[ Show icon preview
E Keep arranged by

* Figure 11-9: The View Options panel for the Desktop.

If your monitor is set at a high resolution (see
Technique 8), you can increase the size of your
icons and label text to accommodate this.

v The final four check boxes in the View Options
dialog affect how items are arranged on the
Desktop and what information is revealed.

The most important of the four check boxes is
Keep Arranged By, which allows you to maintain

Menus 8 9

order in an otherwise chaotic universe (or
Desktop). Mark this check box and use the drop-
down menu to arrange your Desktop by Name,
Date Modified, Date Created, Size, Kind, or Label.

If you select the Show Item Info check box,
image sizes are displayed along with their
names, and size of hard drives and discs
(including remaining space) are listed below
their names. The Show Icon Preview check
box turns an image’s icon into a miniature
representation of the actual image (in icon
view only).

Menus

The Finder, like any other application, has a series of
menus across the top of the display where you can
access commonly used features. The Finder’s menus
are located in two areas:

v In the upper-left corner are the standard menus
(see Figure 11-10).

v In the upper-right corner are extra and third-
party menus (see Figure 11-11).

ﬁ Finder File Edit View Go Window Help

* Figure 11-10: The standard Finder menus.

s B $) 1230 @ @ W

* Figure 11-11: The extended Finder menus, including third-
party additions.

To rearrange or remove an item from the right
side of the menu bar, hold down 88 while
clicking the icon. Then you can either drag the
item off to remove it (it disappears in a cloud
of smoke) or drag it side to side to move it
(the other icons move out of its way).
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The standard menus include

v Apple: The Apple menu (#) is the catch-all for

Tiger. Including system tools such as Software
Update and System Preferences, it allows you to
change the Dock settings and your network loca-
tion, and it also lists the most recently used
items. The bottom half of the Apple menu is for
force-quitting applications, shutting down,
restarting, putting your Mac to sleep, and logging
out. (Read more on some of these in Technique 5.)

Finder: The Finder menu gives you access to its
preferences panel (see earlier in this technique),
controls the showing and hiding of applications,
and links to Services (see Technique 29).

File: The File menu is for basic file-management
stuff (such as opening and closing) and includes
most of the often-used commands and keyboard
shortcuts.

Edit: The Edit menu, like any application’s Edit
menu, gives you access to editing shortcuts, the
keyboard equivalents of which should be second
nature to any power user. Two interesting fea-
tures here show you the contents of the
Clipboard (useful if you forget what you copied
there) and bring up the Character Palette to
access special characters.

View: The View menu is mostly useful with
respect to windows (see Technique 12). Most of
the options are grayed out (unusable) unless
you're in a Finder window. The remaining
choices affect the Desktop.

The View menu lets you customize a selected
Finder window or the Desktop. Conversely, the
Window menu lets you control windows: You
can switch among open windows, minimize a
window, and bring all windows to focus.

v Go: The Go menu is a nice little navigational tool,

giving you links and the keyboard equivalents for
quickly accessing common places. We prefer the
keyboard shortcuts ourselves, but the menu
option is handy to have, and you can find the
keyboard shortcuts listed there as a reminder.

P

Window: The Window menu controls the open
Finder windows (much like an application’s
Window menu gives you access to the open doc-
uments in that application). Although it does
give you an easy way to handle the mess of mul-
tiple windows, you might find Exposé to be an
easier solution.

Help: Need help? Use this menu to bring up the
Help Viewer application.

The right side menu area is a more flexible place;
what’s there depends on what you’ve enabled. For
example:

7

"

The Fast User Switching menu appears here if
Fast User Switching is enabled under Accounts.

The system clock reveals itself if you have it set
to do so in the Date & Time control panel.

The display menu makes an appearance if you
have it set to do so in the Displays panel.

The volume control appears here if you have it
set to do so in the Sound panel.

The Keyboard Menu shows up if you've set it to
do so under System Preferences=>International=
Input Menu.

Laptops show their battery status here if you've
set it to do so in the Energy Saver panel.

Furthermore, extensions and applications add
menus here.

Many freeware and shareware applica-
tions exist to modify or otherwise add to
the menu bar. A quick sample includes
the ever popular TinkerTool
(www.bresink.de/

osx/tinkertool.html, free), wClock
(www.wolfware.com/wclock.html, free),
FruitMenu (www.unsanity.com/haxies/
fruitmenu, $10), and Classic Menu
(www.sigsoftware.com/classicmenu, $10).



AppleScript’s Script Menu

AppleScript is a powerful automating tool that has been
part of the Mac operating system for years. It's so easy to
work with that even nonprogrammers can grasp its con-
cepts, and yet potent enough that seasoned programmers
will be pleased. Not only does Tiger come with literally
dozens of prebuilt AppleScripts, but it even comes with a
tool for easily accessing them: Script Menu.

To enable Script Menu and add a menu icon for it

1. In the Finder, navigate to
Applications=>AppleScript.

2. Double-click the AppleScript Utility icon to open
it.

3. Select the Show Script Menu check box in menu
bar to enable the AppleScript menu.

4. C(lick the new AppleScript logo located on the
right side of the Finder menu.

e FEl = 40 =uvs 238 @ @
Open Scripts Folder >
Open AppleScript Utility
[ 7 Address Book Scripts
[ Basics
[Z Colorsync
[ Finder Scripts
[ Folder Actions
[ FontSync Scripts
[ Info Scripts
[ 7 Internet Services
[ Mail Scripts

[ 7 Navigation Scripts

[ = Printing Scripts

[ 7 Script Editor Scripts
[ Sherlock Scripts

[ 7 Ul Element Scripts

[ 7 URLs

Yy ¥ Y VY Y Y Y Y Y Y VYIYTYIYTVYY

The logo looks like a stylized S, or a scroll (as in the
figure).

Using Your Input Device 9 1

5. Browse through the folders of scripts and select
any script to run.

You can also download and install other scripts created by
Apple:

1. Go to www.apple.com/applescript/scriptmenu.

2. Download any of the extra scripts available
there.

3. Open the downloaded archive(s).

Open Library Scripts Folder Open Scripts Folder >
Open User Scripts Folder Open AppleScript Utility
Open Screenshot Helper Scripts Folder

|© Address Book Scripts >
| Basics »
| ColorSync >
| Finder Scripts >
| Folder Actions B
| % FontSync Scripts >
| Info Scripts >
|7 Internet Services »
|~ Mail Scripts >
| " Navigation Scripts >
| Printing Seripts >
| Script Editor Scripts >
| sherlock Scripts >
| Ul Element Scripts »
22 URLs »

4. From the ApplesScript menu, select Open Scripts
Folder and then choose one of the subfolders
from this menu (see the figure).

5. Drop the downloaded scripts into the Scripts
folder window that was opened in Step 4.

The new scripts will be available at the bottom of the Script
Menu. Depending upon which option you took in Step 4
(affecting which folder was opened), the new script will be
available just within a specific application, just for you, or for
all users on the Mac.

Using Your Input Device

Your input device, be it a trackpad, mouse, trackball,
or graphic tablet, has some pretty impressive power.
Using input devices with the Finder automatically
brings with it a slew of useful timesaving techniques,
much like the keyboard shortcuts that the previous
two chapters highlight.
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Here are some basic mouse moves that any Mac
maven must memorize:

|V
17

\

A W W W W\

You can accomplish even more with your mouse by
clicking in combination with various modifier keys,

Click any item to select it.
Click and drag to select multiple items.

Double-click any file to open it in its default
application.

Double-click any folder to open it.

Double-click any application’s icon to launch it.

Click and hold a Dock icon to bring up a menu.

Double-click a window’s title bar to minimize it.

Drag an item over a folder or volume to make
it pop open (assuming that you have the
spring-loaded feature enabled under General
preferences).

such as Control or Option:

7 d

"

Control-click any item to open its contextual
menu.

Control-click a Dock icon to bring up its menu.

8-Option-click a Dock icon to switch to that
application and hide every other window.

\

A W W WA

\

88-Option-click the Finder in the Dock to go to
the Finder and hide all the open applications.
(This also opens a new window if no Finder win-
dows are open already:.)

Option-click the Desktop or the Finder icon in
the Dock to go to the Finder and hide the current
application.

Option-click the red button of any open window
to close every open window in that application.

Option-double-click to minimize all an applica-
tion’s open windows.

Option-click the yellow button of any open win-
dow to minimize every open window of that
application.

Option-drag a file to duplicate it.
3-Option-drag a file to make an alias.
&-click to select non-contiguous items.

88-click to deselect one of multiple selected
items.

Press the spacebar while dragging an item onto a
folder or volume to make it pop open immedi-
ately (assuming that you have the spring-loaded
feature enabled under General preferences).



Customizing
Windows for Your

Techniquer Convenience

Save Time By

v~ Determining which view
mode to use

v~ Customizing the windows

+~ Navigating among open
windows

use the Finder to access applications and files, move items around,
organize your data, and much, much more. Hence, customizing your
Finder windows is crucial to more productively using your Mac.

The Finder window is the basic currency of the operating system. You

In this technique, we start by covering the three view modes that you
can use in your Finder windows: icon, list, and column, each of which has
its own benefits. Then we show you how to customize the window’s
appearance and features. We conclude with how to navigate among mul-
tiple open windows.

Understanding the Uiew Modes

The Finder’s window can display the items in a folder in three view
modes: icon, list, and column. Each has its own benefits (and keyboard
shortcuts, see Technique 10), so take some time to figure out which view
mode works best under what circumstances. This is mostly a matter of
taste, but certain principles can help you make the best decision.

] To switch among the view modes, use 38-1 for icon, 88-2 for list, and
88-3 for column. If you have trouble remembering these shortcuts,
b they correlate to the order of the icons in the window’s toolbar, from
left to right (as shown in Figure 12-1).

Wlewy

* Figure 12-1: Click the icons to change view modes or use the keyboard shortcuts.
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Icon view

Icon view is familiar territory for almost everyone
and is often the default view mode for mounted
CD-ROMs and disk images. Icon view (see Figure
12-2) is best when you’re dealing with a directory
containing only a few items or if you just prefer the
look and feel of icons. Selecting a group of items (by
using the mouse to click and drag) can be an easy
and natural task in icon view.

8006 % larryullman -
< » = m] 2 a

":___.‘ IDisk i = —

9 Network E I | B | ﬂ

- =
_} Hard Drive Desktop Documents Library

) larryullman =

== =
{3 Desktop . é | J
£ faryullman § ol ool -
T Movies Music Pictures
,A- Applications
[5 Documents —== ="
P @
liésg Movies | ®= L =)
& Music o T
= Public Sites
|__| Pictures
i & items, 34.89 GB available o

* Figure 12-2: A directory displayed in icon view mode.

Icon view is limiting if you're dealing with a directory

containing lots of items or if you’ll be running
through multiple subfolders.

If you're viewing a directory of images, turn on
Show Icon Preview in the View Options panel
and then use icon view. This displays thumb-
nails of the window’s contents. (After you've
selected a window, press 38-J or choose
Viewr>Show View Options to bring up the
View Options panel.)

If Snap to Grid is enabled (meaning that icons
are arranged along imaginary grid lines
instead of free-form), icon view shows a small
grid icon in the lower-left corner of the win-
dow (refer to Figure 12-2).

Setting backgrounds in icon view

Icon view mode is the only mode that allows you to cus-
tomize the background of the window. Although this fea-
ture might seem like nothing more than eye candy (and it
certainly can be), it has its advantages. The best way to use
the background is to set a different background color or
image for different folders. That way, when you minimize
them, you can more easily know which window is which by
looking at the window'’s icon in the Dock.

This allows you to distinguish between them more easily. To
set a background:

1. Open the window in question.

2. Bring up the View Options panel by pressing
38-J or by choosing Viewr>Show View Options in
the Finder.

3. Within the View Options panel, select the This
Window Only radio button (at the top) so that
the changes affect only this window.

4. At the bottom of the window, select either the
Color or the Picture radio button.

5a. If you select Color in Step 4:

a. Click the color block that appears next to the word
Color to bring up the Colors palette.

b. Click the color that you want to use.
c. Click OK.

You see the window's background change colors, as in
this figure.

806 (% larryullman =

6 lanyuliman
@ This window only

: All windows
__l_ Hard Drive

£ larryuliman 2 Icon size: 48 x 48

esKtD | Small Large
n arryuliman Textsize: 12 pt 4]

A Applications

% Label position:
|4 Documents

@ Bottom () Right

Movies
? sk gSnap to grid
= [_! Show item info
[ Pictures # Show icon preview
| 8 items, 34.89 GB avallable [ Keep arranged by

Name

Background:
O White
O color [

O Picture




5b. If you select Picture in Step 4:

a. Click the Select button that appears next to the
word Picture to bring up the Select a Picture dialog.

b. Use the Select a Picture dialog to navigate to the
desired picture.

¢. Click Select to close the dialog.

6. Press 88-J to close the View Options panel (or
click the little red circle in the upper-left corner).

List view

List view is an easy-to-use-and-understand format for

pretty much any user. It has two primary advantages:
v ltems are displayed as a sortable list.

v Multiple item details are displayed simultane-
ously (see Figure 12-3).

GIGIG) T Larryuliman e

| «

{ & ok <l Name W1 Dare Modifed Soe | Hied
% Netwark & I Desktop Wedterday, 2016 PM Folder
2 Hard Drive Dacuments Mav 2, 2004, 143 PM Folder
oyl = ¥ Library Mav 14, 2004, 5:36 PM Foider

¥ Movies Mov 2, 2004, 143 M Folder

I Oeskiop ¥ Music Mov 2, 2004, 1:43 PM Folder

YYTTYTYTTYTTY

i Pictures Today, 1124 PM - Folder
A Asplications # Public Mov 2, 2004, 1:43 P4 - Folder
Documents Sites Mo 2, 2004, 1'43 PM - Foider

| Movies
B of B selocrd, 3489 CB available

* Figure 12-3: The same directory from Figure 12-2, now in
list view mode.

Because of these considerations, list view is the
obvious choice if you need to sort a folder’s con-
tents or view any information (such as size, modifi-
cation date, kind, creation date, and label). Also, if
you need to compare contents of subfolders, list
view is great because you can show multiple sub-
folders within the one window by expanding them.
This means that you can also select items from mul-
tiple subfolders in the list view.

To get the most out of list view, you must know how
to customize and use the column headings. In an
open window:
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Understanding the View Modes

1. Press 3-J to bring up the View Options
(see Figure 12-4).

2. arryullman
f*) This window only
) All windows

lcon size; 4

(%) T}

Text size: | 12 pt F5

Show columns:
™ Date Modified
" | Date Created

Version
Comments
Label

@Use relative dates
[ Calculate all sizes

* Figure 12-4: View Options displays different choices
based on the current view mode.

2. Use the radio buttons at the top to make these
options apply to this window only or to all
windows.

To create a default window setting for all your
windows, select All Windows in the View
Options dialog before customizing the
settings.

3. Set the icon and text sizes.

The icon and text sizes can be increased to make
up for a high monitor resolution, or these can
both be reduced to make list view windows show
more in a smaller space.
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4.

5.

Technique 12: Customizing Windows for Your Convenience

Select which columns you want list view to
show.

See the guidelines that follow this step list for
more information.

Press 38-J to close the View Options dialog
(or click the little red circle in the upper-left
corner).

Here are some good rules for what you might want
to include in list view:

7

Date Modified: The Date Modified option is most
useful for sorting your windows by modification
date. Doing so brings the most recently altered
file to the top.

Date Created: The Date Created option is slightly
less useful than the Date Modified option but
works the same way.

Size: The Size value is quite handy, particularly if
you're looking for small (such as text docu-
ments) or large (like Photoshop files) items. This
column can also be used to help you distinguish
between multiple versions of the same file.

Sizes aren’t calculated for folders unless the
Calculate All Sizes check box is enabled in the
View Options panel. Keep in mind that large
directories take some time to calculate, so
those values don’t immediately appear in a
window.

Kind: The Kind attribute of the list view is rarely
illuminating. The information that it lists (for
example, Folder, Microsoft Word document, TIFF
document) can normally be ascertained by the
item’s name and icon. It does, however, allow
you to sort by the file’s type.

Version: Frankly, we haven’t turned on a win-
dow’s Version option in years. We can’t imagine
why you would, either.

‘,

g

e { @
&

‘/

Comments: Listing an item’s Comments is very,
very useful — if you use comments, that is. If you
don’t (like most users), leave it deselected. You
might use comments to note a text file’s contents
or information about an image.

You can add comments to any item by open-
ing Get Info using the 38-1 keyboard shortcut
or the File menu’s Get Info choice.

Label: Viewing the Labels, like Comments, is
great if you use them. See Technique 11 for infor-
mation on using Labels to your advantage.

After you establish what columns to use, you should
understand these facts:

7
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The default view is to sort the items by name in
ascending order.

You can control the sorting of your files by
adding special characters to a file’s name.
Filenames that begin with a space always
come first; filenames that begin with symbols
always go last. Just don’t start a filename with
a period; it will become hidden if you do.

Click any column heading to sort the list view
contents by that column in ascending order.
Click the same column again to sort the contents
in descending (reverse) order.

You can rearrange the columns by dragging
them, except for the Name column, which is
always in view and is always listed first.

The quickest way to see a long filename
(which can be cut off in list and column view
modes) is to hover the cursor over the file-
name. After a brief moment, the file’s full
name appears. To make it appear immediately,
hold down the Option key while you hover
the cursor above the file (see Figure 12-5).
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* Figure 12-5: You can view a file’s full name by hovering
your cursor above it.

Column view

Column view mode is unique:

v It shows a list of a folder’s contents, like the list
view, but without any extra details.

v Column view opens subfolders in columns.
(Opening a folder moves you one column to the
right; closing a folder moves you one column to
the left.)

For these reasons, column view mode is the fastest
for quickly navigating through multiple directories.
You can even set the Finder to use column view
mode by default by enabling the appropriate check
box in the Finder preferences panel.

To save space in column view mode, disable
Show Icons in the View Options panel.

The trick to using column view mode is knowing
how to change the column sizes. By adjusting the
size, you can fit more columns on the screen or
show more of an item’s name. Here are some tips:

v Click and drag the bottom-right corner of a win-
dow to expand it.

v C(lick and drag the two vertical lines separating
columns to adjust one column’s width. The col-
umn to the left of the vertical lines is resized.

v To adjust every column’s width, hold down the
Option key while clicking and dragging any two
vertical lines.

Customizing Window's 9 7

z One of the best benefits of column view is

e { @ that it previews different file types for you. You
) can use it to view images, listen to sounds, and
play movies, as shown in Figure 12-6. You can
enable or disable this feature by using the
View Options panel.
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* Figure 12-6: Column view mode can show an image or a
movie or play a sound.

Scrolling through columns

Many mice and trackballs these days include a scroll wheel.
If you have one and use it, you're probably aware that you
can use it to move up and down within documents, Web
pages, even Finder windows. What many people aren’t
aware of is that by pressing the Shift key while scrolling, the
movement goes from being vertical to being horizontal.
Scrolling horizontally through the column view windows
can be the fastest way to access deeply nested folders.

Customizing Windows

Aside from choosing which view mode you use, you
can customize the Finder’s windows in many other
ways. The view modes themselves customize the
window’s content area, but you can also customize
the toolbar along the top, the Sidebar along the side
(appropriately enough), and even tinker with how
the scroll bars appear and function for larger
windows.
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Toolbar

The toolbar along the top of the window has been
around and customizable for a while now. Panther
added to it by adding the Action pop-up (which is
just another way to access contextual menus, see
Technique 14) and the Search box, both of which are
still present. To customize the toolbar:

1. Control-click the toolbar (see Figure 12-7).

= Ya) A larryullman -
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<+ |88 =W - 3
|« >[5 0] %~ | Icon & Text
g Disk v lcon Only pr—
: Text Only (
5 Network ! —
— . Use Small Size el
_-l' Hard Drive Desktop Library
3 larryuliman = Remove Item
== Customize Toolbar... e
=
{8l Deskrop (8 ? | M
fi laryullman @ == = -
s Movies Music Pictures
ﬂ Applications
“ Documents P e
— 4 7
ligg Movies | @ 5
== B
Q Music s
Public Sites
| Pictures
] 8 items, 34.89 GB avallable v
)

* Figure 12-7: Control-click the toolbar to customize it.

2. Select Customize Toolbar from the contextual
menu that appears.

This is the equivalent of selecting Customize
Toolbar from the View menu in the Finder. A
Customize Toolbar sheet appears.

3. Add items to the toolbar by dragging them
from the sheet to their desired location on the
toolbar (see Figure 12-8).

4. Remove items from the toolbar by dragging
them off the window.

5. Use the pop-up menu and check box at the bot-
tom of the window to dictate

» How much information should be shown in
the toolbar (Icon & Text, Icon Only, or Text
Only).

» Whether it should be in small size.

Technique 12: Customizing Windows for Your Convenience

Drag your favorite items into the toolbar...
[« » | = | S = |4
Back Path View Action
A AA Ao '
Eject Burn Customize Separator
= k-ﬂ’ )
Space Flexible Space  MNew Folder Delete
@ 0 g€ =~
Connect Get Info iDisk Search
... or drag the default set.
)=o) (%) a
Back View Action Search
Show iconOnly  [#) (] Use Small Size ( Done )

* Figure 12-8: The Customize Toolbar sheet.

The best way to customize the toolbar depends on
how you use it:

v Some options — Get Info, iDisk, Connect, and
Customize — are rarely used and can be
omitted.

v Burn and Eject are also options in the Sidebar if
you have volumes mounted there.

v Almost all the icons have keyboard equivalents
or can be re-created by Control-clicking.

Here are some other toolbar tips and shortcuts to be
aware of:

v If your window becomes too small to show all
the toolbar features, double arrows appear. Click
them to see the hidden options (see Figure 12-9).

v Click the oval button in the upper-right corner of
the toolbar to switch between a fancy Tiger win-
dow and a plain version. Strangely enough, you
can also use Shift-click, Control-click, or Option-
click to do the same thing.
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* Figure 12-9: The double arrows create a menu of hidden
toolbar options.

v B-clicking the oval button toggles among very
subtly different versions of the window.

»  You can also access the Path by 3-clicking the
window’s name in the title bar. A folder’s path
indicates where the folder is on the hard drive,
like /Users/larry/Desktop/Stuff.

88-clicking the window’s name is a good trick
to remember. Many other applications also
use this technique to show you the file path
(BBEdit) or your browser’s history (Safari).

1 Hold down the 3 key while clicking and dragging
to move or remove toolbar items without using
the Customize Toolbar panel.

v Drag any icon from the Desktop or a Finder win-
dow to add it to the toolbar.

v Control-click the toolbar to switch view modes.
Control-click a toolbar icon or tool to remove
it — or just 8-drag it off.

You can add a Delete button to the toolbar so
that you can delete a file by selecting it and
then clicking Delete. You can also trash a file
by dropping it on the toolbar’s Delete button.

f|an @ larryullman

I“"‘H::im}”#'] o ¥ New Folder
@ ipisk ;p; -+ Search

@' Network | u
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Customizing Windows

Sidebar

The Sidebar (see Figure 12-10) contains two separate
parts. The top section lists major resources, such as
volumes, mounted disk images, and discs. This can
be customized under the Sidebar panel of the
Finder’s preferences panel. Anything listed in the
Sidebar can be accessed with a single mouse click.

(These items don’t need to be opened with a double
click.)

m |

@ ipisk
ﬁ Metwork
l Hard Drive

;:i larryullman =

] Desktop
fi larryullman

/rf'k Applications

| 9| Documents

ﬁ Maovies

é Music

|} Pictures

i

—

* Figure 12-10: The side panel on the left of the window is
new to Panther and is customizable.

Resize the Sidebar width by clicking and drag-
ging the dividing line between it and the win-
dow's contents. If you make the sidebar really
small, you can see only the icons, but you can
see each item’s full name by hovering the
mouse over the icon.



100

Here are some things that you can do in the top part
of the Sidebar:

v Easily access any hard drive.

v Access your iDisk without formally connecting to
it. (We cover iDisk in Technique 42.)

v View mounted disk images and discs without
going to the Desktop.

v Eject mounted disk images and discs.
v Burn CD-Rs and DVD-Rs.

v See what servers you're currently connected to.

Using the window’s icon to move folders

In the title bar of a window, the folder icon that appears
next to the window’s name is the listed folder’s icon (also
called the proxy icon). Therefore, this icon is the same as
the icon for the directory that you would find in its parent
folder. By clicking and holding the window's icon, you can
move this entire directory around without going up one
folder. For example:

1. Open two different folders in two different win-
dows in the Finder.

2. Click and hold the title bar icon of the folder
that you want to move.

You need to click and hold for just a second to get
the system to engage.

3. Drag this icon into the other window.

4. Release the mouse button.

You now see the first window as a subdirectory in the sec-
ond. However, the first window is still open; only its location
has changed.

Proxy icons are also in other applications (for example,
Word documents have an icon next to the document’s
name) and are a useful concept to familiarize yourself with.
You can find other examples in this book where using the
proxy icon might be the easiest way to move a document
(such as attaching a file to an e-mail).

Technique 12: Customizing Windows for Your Convenience

The contents of the Sidebar also appear in
Open/Save dialogs, thus saving you time navi-
gating around the computer.

The bottom section of the Sidebar is partially cus-
tomizable from the Finder’s preferences panel. This
area should be used to access frequently used direc-
tories, such as

v The Desktop
v Your Home folder
v The Applications folder

v Your Documents folder

Select any object and press 38-T to instantly add it to
your Sidebar. Similarly, you can drag an item to the
Sidebar to add it or drag it off to remove it. Sidebar
items can also be rearranged by clicking and drag-
ging them.

The 38-T shortcut used to add an item to your
Favorites directory but now adds items to the
Sidebar. There is no longer a shortcut to add
items to the Favorites directory.

Scroll bars

Scroll bars appear on the right side and/or bottom of
the window when the window is too small to display
every item. These settings are adjusted in the
Appearance panel of System Preferences (see Fig-
ure 12-11). You can customize the scroll arrows to
appear like the following:

Place scroll arrows: @At top and bottom
) Together

Click in the scroll bar to: @Jump to the next page
) Jump to here

_| Use smooth scrolling

# Minimize when double clicking a window title bar

* Figure 12-11: Part of the Appearance panel also controls
the Finder window scroll bars.



v Separate, at the top and bottom of the window
v Together at the bottom of the window

While you’re at it, you can tweak how clicking in the
scroll bar area affects the window or document.
Select one of the following radio buttons:

v Jump to the Next Page: Moves a page at a time.

v Jump to Here: Moves to a particular location.

Both of these settings are more for personal taste
than anything, but you should understand what
you're getting when you make your selections. (For
the record, we tend to keep our scroll bars together
and set clicking in the scroll bar to move one page at
a time.)

If you install the free TinkerTool (see
@ Technique 54), you have even more scroll bar
options, including having both together at the

top and bottom of the window.
The last two settings that you can enable are

v Smooth scrolling: It makes your scrolling look
pretty, but it really drags down your Mac’s per-
formance. Turn off smooth scrolling for a faster
window response.

1 Double-clicking windows to minimize them: It’s
handy, but you can also minimize a window by
either

» Single-clicking the yellow button
» Using $-M

Moving Windows Around

Despite the fact that Exposé (see Technique 15) has
greatly facilitated moving about open windows,
plenty of other tips and tricks are still left to be dis-
covered. Window management is critical to using the
operating system efficiently, particularly if you open
every folder in a new window. Here are the best tips:
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Moving Windows Around

v Finder windows use three standard buttons in
the upper-left corner. They are color-coordinated
to represent what they do: red (close), yellow
(minimize), and green (zoom).

v Option-click the yellow button to minimize every
open window.

v Option-click the red button to close every open
window.

v lf you place the mouse cursor over an inactive
window’s buttons, they light up, allowing you to
close, minimize, or zoom a window without it
being in front (and therefore active).

v You can move background (non-active) windows
by holding down the 8 key and clicking them
with the mouse.

v Double-click the toolbar to minimize a window, if
enabled.

The Appearance panel allows you to turn on
the window-minimizing feature when double-
clicking the window’s title bar or toolbar.

v You can directly access any particular window
by clicking Window on the menu bar and select-
ing from the list of windows.

v The shortcut 8-~ scrolls you forward through
the open windows. 8-Shift-~ rotates you
backward.

v Minimized windows are stored in the right side
of the Dock.

v By placing your cursor over a window’s Dock
icon, you can see the name of the window (see
Figure 12-12).
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* Figure 12-12: A window’s title reveals itself when you
hover over its icon in the Dock.




Establishing an
Efficient Dock

Technique

Save Time By

v Customizing how the
Dock looks and behaves

v Organizing your Dock for
maximum productivity

+” Reviewing the various
keyboard and mouse
shortcuts that you use
with the Dock

+* Investigating Dock-
related shareware

such a particular aspect of your operating system that it merits its

own technique. A new concept to Mac OS X, the Dock has been
much maligned in its various incarnations, but we feel that with the right
treatment, the Dock can be an important ally in the war for productivity.

The Dock, that curious little bar at the bottom of your screen, is

We begin this technique with a discussion on customizing and organizing
the Dock, with the focus on making it as useful as possible. Then we
demonstrate the myriad ways that mouse and keyboard shortcuts can be
used to work with the Dock more efficiently. Finally, we introduce a cou-
ple of the more popular shareware applications that add to or mimic the
Dock’s purpose and behavior.

Customizing the Dock

The Dock is like a pet: You need to take care of it. Okay, it’s really nothing
like a pet, but you should still spend a bit of time doing two things: cus-
tomizing its behavior and organizing its contents and layout. You can
customize the Dock’s behavior from the Dock pane of System Preferences
(see Figure 13-1).

88c Dock
[« » ][ Showall | Q|

Dock Size: sm——fi———
o

Small Large

| Magpnification:

Min Max

Position on screen: ® O
Left Bottom Right

Minimize using: “Genie Effect |4 ]

El Animate opening applications

] Automatically hide and show the Dock (&1

* Figure 13-1: Use the Dock System Preferences pane to set the Dock’s behavior.



(8 from the Dock submenu of the Apple Menu
(see Figure 13-2). It gives you immediate access
to the Dock preferences panel without forcing

you to navigate through System Preferences.

z You can adjust much of the Dock’s behavior
<}

&

About This Mac
Software Update...
Mac OS5 X Software...

System Preferences...

Dock > Turn Hiding Off HED
Location » Turn Magnification On
Recent Items > Position on Left

+ Position on Bottom

i o a;
Force Quit Screenshot Helper C{r38 Position on Right

Sleep
Restart...

Dock Preferences...

Shut Down...

Log Out Larry Ullman.. {3EQ

* Figure 13-2: The Dock submenu is located under the
Apple menu.

You can adjust the following Dock properties, some
of which are just cosmetic and some of which are
actually useful:
v Size
» Magnification (whether it’s on and how potent
it is)
v Position on the screen (left, bottom, or right)

v The effect used when windows and documents

are minimized into the Dock (Genie and Scale are

your choices)
v Whether opening applications are animated

v Whether the Dock automatically hides and
shows itself

The size, position, and hiding features of the Dock
all directly relate to how you interact with your
computer — and therefore, can have an effect on
your productivity. That being said, how you set

them is largely a matter of taste. Here are some gen-

eral suggestions:

Customizing the Dock ’03

v Automatically hiding and showing the Dock is a
good way to keep your screen clear if you have a
smaller monitor (15 inches or less) or a laptop.

v Placing the Dock on the side makes more sense if
you have a widescreen display (where you have
more screen space on the sides than you do on
the top and bottom).

v lf you use the Desktop a lot and have folders, vol-
umes, and other icons automatically arranged
(meaning that they’re located on the right side of
the screen), don’t put the Dock on the right, or
it’'ll always be in the way:.

v Adjust the size of the Dock so that it’s as small as
reasonable while still allowing you to read it.

The Dock’s size automatically shrinks if the
number of items in the Dock makes it too
large to fit on-screen. In System Preferences,
you can also make the Dock really small, but
use magnification to see the items more

clearly (see Figure 13-3).
@RS @ .

* Figure 13-3: Magnification increases an icon’s size as your
mouse goes over it.

The minimizing effect, the animation of opening
applications, and (to a lesser degree) the magnifica-
tion are cosmetic. Turn them on to impress or annoy
your friends; turn them off if you think it’ll make
things happen faster (though it really won’t).

The TinkerTool freeware application (www .
bresink.de/osx/TinkerTool.htm1) lets you
customize your Dock in other ways. This
includes positioning the Dock at the top of the
screen, adjusting the alignment (left/top, cen-
ter, right/bottom), making the Dock icons for
hidden applications transparent, and adding a
Dock shadow. It also adds a “Suck In” minimize
effect for people who appreciate eye candy.
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Organizing the Dock

The Dock is divided into two sections: the left side
(where applications live) and the right side (where
you can find documents, folders, and the Trash).
The two sides are divided by a separator bar (a verti-
cal line that runs the height of the Dock).

v To add any item to the Dock, drag its icon there.

v Toremove any item (except the Finder and the
Trash, which are permanent), drag its icon off
the Dock.

The Dock always shows every icon that you add to it
as well as other currently running applications
(which are marked with an upward-pointing black
triangle; refer to Figure 13-3).

Technique 2 shows you a trick for making the
@ System Preferences panels more accessible:
just add the System Preferences to your Login

Items. Then you can Control-click the System
Preferences Dock icon to access an individual
control.

To organize your Dock:

1. Remove any of the default icons that you won’t
regularly use; just click and drag them off the
Dock.

Apple likes to give you immediate access to
every Apple application that comes installed on
your Mac, so your Dock has iMovie, iPhoto, iCal,
Mail, and the Address Book by default. If you
don’t frequently use some of these (like iMovie),
drag the icon off the Dock to make it disappear in
a puff of smoke.

You can’t remove two particular Dock icons: the
Finder, which is always on the far left (or the
top, if the Dock is on the side); and the Trash,
which is always on the far right (or bottom).

2. Add every application that you use on a daily
basis to the left side of the Dock by dragging
their icons from the Finder onto the Dock.

Technique 13: Establishing an Efficient Dock

3. Add frequently accessed folders to the right
side of the Dock by dragging their icons from
the Finder onto the Dock.

We recommend putting your Favorites folder
(which links applications and files that you use
less frequently), your Home folder, and perhaps
your Documents folder on the right side of the
Dock. You should also consider dragging the
folders for your current projects and documents
there. If you want, add the Desktop folder there
to immediately access Desktop items.

Use customized icons for your Dock folders
(before adding them to the Dock) to help you
find a desired folder among multiple folders
stored there. See Technique 17 for instructions
and resources.

4. Organize your applications so that those used
in conjunction are placed together.

For example, if you regularly use multiple Web
browsers, place these next to each other. If you
use BBEdit (a text editor) with Fetch or Transmit
(FTP applications), line them up.

Icons placed in the center of the Dock are the
most stable because they're less affected by the
expansion and contraction of the Dock. As your
Dock grows, applications found near the center
of your Dock remain near the center of your
screen. Conversely, items on the ends of the
Dock move closer and closer to the end of the
screen, making them slightly harder to get to.

Keyboard and Mouse Shortcuts
for the Dock

To get the most out of the Dock, you must be able to
customize it properly and also use it with ease. This
comes down to understanding the various keyboard
and mouse shortcuts that you can use to perform
common tasks.

With your mouse (or other input device), here are
the basics that you should know:
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Click any application’s icon to bring that applica-
tion to the front.

Click any folder’s icon to show that folder in a
Finder window.

Click the Trash icon to see what'’s in the garbage.

Hierarchical pop-up menus in the Dock

Clicking an icon in the Dock takes you to that application,
but clicking folders in the Dock can give you different
behavior. Both of these features are quite useful and an
easy way to access your documents:
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When you click a folder’s icon, that directory is
opened in a new Finder window.

When you Control-click or click and hold a folder’s
icon, a hierarchical menu is created of the folder’s
contents, as shown in the following figure.

This method allows you to navigate directly to a sub-
folder or document buried deep inside — the hierar-
chy of folders is revealed while you navigate. In
previous versions of Mac OS X, you were limited to
only a handful of submenus, but now you can literally
fill your screen up with menus to reach the file that
you want, as shown in the following figure.

W Vorvemshat Heipe  fie  on wecow  tew =N O 3
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Click a Dock item to make that item active, open
it if it isn’t already open, and reshow minimized
documents or windows.

Click and hold a Dock icon to bring up its contex-
tual menu (or a hierarchical menu for a folder).

Keyboard and Mouse Shortcuts for the Dock
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Use the contextual menu to quit, hide, and go to
the item’s location in the Finder.

Check the contextual menus for different applica-
tions to see what options they provide.

For example, the Mail application gives you the
option to check your e-mail (see Figure 13-4).
Many others, such as BBEdit or Safari, allow you
to preselect which open document (in that appli-
cation) you want to view (see Figure 13-5).

v ["] Inbox (5 messages)

Get New Mail
Compose New Message

Remove from Dock
Open at Login
Show In Finder

) EIREYe

* Figure 13-4: The Mail contextual menu in the Dock.

™1 Apple
v | Apple .Mac Welcome

New Window

Remove from Dock
Open at Login
Show In Finder

Quif

Ou O

* Figure 13-5: The Safari contextual menu in the Dock

shows open Web pages.

Click and drag the Dock’s separator up and down
to adjust the Dock’s size.

You can eject disk images, CDs, DVDs, floppy
disks, Zip disks, and external hard drives by
dragging their icons onto the Trash icon, which
turns into an Eject button.
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When using only the keyboard, you're fairly limited
by what you can do with the Dock, but to start

1. Make sure that Full Keyboard Access is turned
on for All controls in the Keyboard & Mouse
panel of System Preferences (under Keyboard
Shortcuts).

2. Press Control-F3 to access the Dock (see
Figure 13-6).

BT ET
™ A B,
- & | Egil

* Figure 13-6: Pressing Control-F3 highlights an icon in the
Dock.

Laptops might need fn-Control-F3 to access
the Dock.

e

3. Use the arrow keys to move left and right (you
can also Tab and Shift-Tab).

)

After an item is highlighted, press the spacebar
to make it active.

“

Use the up- or down-arrow keys to launch the
contextual menu for that item (see Figure 13-7).

N

Press Return to select an option highlighted in
the contextual menu.

N

Press Esc at any time to leave the Dock.

- z a Another keyboard shortcut to remember is

A pressing 38-Option-D to show or hide the Dock.

What you can do with the mouse — or the mouse
and keyboard together — is much more impressive:

v Control-click a Dock icon to bring up its contex-
tual menu. You can also just click and hold to
see it.

v Option-Control-click to change the contextual
menu’s Quit option to Force Quit.

Technique 13: Establishing an Efficient Dock

| Pictures
1 Part 2
v [ larryullman

Hide

- s il

¢ Figure 13-7: Use the up- and down-arrow keys to
navigate the contextual menus in the Dock.

To empty the Trash by using the Dock and
your mouse, click and hold (or Control-click)
the Dock’s Trash icon and then choose Empty
Trash from the menu that appears.

v 8-Option-click a Dock icon to hide all the other
applications.

v 8-click a Dock icon to reveal the icon’s original
file in the Finder. This is the same as selecting
Show In Finder from the contextual menu.

You can also control many of the Dock’s settings by
using your input device and the modifier keys. For
starters:

v Control-click the Dock separator (the line between
the left and right sides of the Dock) to access the
Dock’s preferences (see Figure 13-8).

v Press Option-click while dragging the Dock sepa-
rator to change the Dock’s size to standard icon
sizes.

v Pressing 88-Shift-click while dragging the Dock’s
separator bar left and right allows you to move
the Dock around the screen (from left to bottom
to right).
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Turn Magnification On
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Minimize using b

Dock Preferences...
O AN

1T

* Figure 13-8: You can adjust the Dock’s preferences from
the Dock’s contextual menu.
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v An application’s contextual menu allows you to
add the item to the Dock. You can also accom-
plish this by moving a Dock icon, which makes it
a permanent addition.

You can open a file by dragging it onto an
application’s icon in the Dock. The problem is
that the Dock might mistake your intentions
and frequently move the application icon out
of the way so that the file can be added to the
Dock. To make the Dock behave itself, hold
down the 3 key when dragging the file. To
force an application to attempt to open a file,
use 38-Option while you're dragging the file
onto the Dock icon.

Shareware for the Dock

After you get the hang of the Dock, investigate some
of the shareware applications that either add to its
functionality or otherwise duplicate its utility.

The following programs provide you with multiple
Docks. They either create separately accessible
Docks or one tabbed Dock (one Dock with multiple

subpanels, each of which can contain its own items):

v DragThing (www.dragthing.com, $25) is a very
popular application and consistently reviewed
well by Mac users.
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Shareware for the Dock

v Drop Drawers (www.sigsoftware.com/
dropdrawers, $20) has an extra emphasis on
storing stuff (text, images, and the like) in a Dock
drawer.

v DockSwap (www.pidog.com/0SX, $12 suggested)
allows you to have multiple Docks, switching
easily among them.

Launcher programs can quickly bring up applica-
tions, Web pages, and contextual menus. These can
be a dockling, pop-up menu, or menu bar extension:

v Snard (www.gideonsoftworks.com/snard.html,
$10) is a pop-up menu that gives you quick
access to just about anything on your Mac. It’s a
very unique utility, releasing you from the con-
fines of a Dock-centric world.

v DockExtender (www.codetek.com/dockextender,
$20) is highly customizable, taking the functional-
ity of the Dock to universally-accessible pop-up
menus.

A dockling is a special type of application that
resides in the Dock and adds extra functionality
to your computer. Unlike other Dock items, you

never really use it as a standalone application.

v ClearDock (http://unsanity.com/products/
free, free) by Unsanity lets you customize the
Dock on a more aesthetic level. You can

» Entirely get rid of the Dock’s background
(letting your Desktop show through).

» Change the color of the triangles that appear
below open applications.

v A-DockX (http://jerome.foucher.free.fr/
ADockX/ADockX.htm1, $10) provides both func-
tional and cosmetic alterations to the Dock. With
it you can use different themes for your Docks or
alternative Trash icons (there are more features,
too, but we like the occasional eye-candy).



Saving Steps with
Contextual Menus
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Save Time By

+* Understanding the bene-
fits of contextual menus

v Getting to know some
third-party contextual
menu software

+~ Seeing how you can use
AppleScripts with contex-
tual menus

for several incarnations now, yet many Mac owners underuse them

or don’t use them at all. Contextual menus provide an immediate
listing of options; usually frequently performed tasks such as invoking
Get Info, changing a label, or making a copy. Although contextual menus
exist in both applications and the Finder, they differ greatly across appli-
cations. Therefore, this technique specifically addresses the Finder’s con-
textual menus (often abbreviated as just CMs).

C ontextual menus have been part of the Macintosh operating system

First, we cover a smattering of the basics about contextual menus. Then
we cover, in greater detail, some of the specific contextual menu items
that you can add to your system. These include many common third-
party and shareware applications. Finally, you see how AppleScripts,
oh-so-wonderful AppleScripts, can be called by using CMs.

Grasping the Basics of Contextual Menus

When you Control-click an item, whether it’s a window, the Desktop, or
an icon, a contextual menu appears, listing the things that you can do
with that item. Different objects in your system offer different options.
For example, here are the CMs for a folder (Figure 14-1), a file (Figure
14-2), and a window. (A window’s CM can be accessed by clicking on its
background, as shown in Figure 14-3.)

have a programmable input device (such as a trackball or mouse),
you must program one of the buttons to act as a Control-click. Doing
so saves countless hours because you can access common features
more easily. In fact, most two-button mice treat the right button as
Control-click by default.

2 If you use contextual menus a lot — and you really should — and you
<8
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Help HE||J
Open
Get Info New Folder
Move to Trash New Burnable Folder
Duplicate Get Info
Make Alias P -
Create Archive of “Unused Tiger Photos” Show View Options
Copy “Unused Tiger Photos Scri pts >
Color Labsl; Finder Icon (2
X @ y 9w "
Quick Access [
Scripts > Move To [
Finder Icon > Cﬂpv,_‘r To [
Quick Access > 3
Move To = Make Alias In k
Copy To »
Make Alias In 3 Automator >
R UCOTTAtor > Enable Folder Actions
Enable Folder Actions Configure Folder Actions. ..
Configure Folder Actions... Stuffit b
Stuffit 3
« Figure 14-1: A contextual menu for a folder. ¢ Figure 14-3: The default contextual menu for a window.
| The Help and Get Info options are common to all
HER three of the listed CM examples. A window has the
gpe" ok s fewest number of options, by default, whereas files
it generally give you the most. Some common uses of
Get Info the contextual menu include
Move to Trash . o X .
v Creating a new folder within a directory, in case
Duplicate i i _Shift-]
A you get tripped up with the 38-Shift-N shortcut.
;fza‘eh”cm"e DfE379630 101 T TR »* Adding, deleting, or changing the Label.
lgesnow
Copy *579630 fg1111.tiff" v Sending the selected item to the Trash.
Color Label: v Opening a file with a specific application (see
X @ eeve Technique 25).
Scripts » v Archiving an item.
Finder Icon > . . . . .
S e 5 v Duplicating or just copying the item.
Move To | 3 . .
Copy To =S v Creating an alias.
Make Alias In >
Automator > If you want to know what CM options are
Enable Folder Actions available to you in any application, including
Configure Folder Actions... the Finder, Control-click to investigate. Get in
i E the habit of Control-clicking within windows,
« Figure 14-2: A contextual menu for a file. on icons, on the toolbar of windows, and on

Dock icons.
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Items in the Dock and the Dock itself have their
own contextual menus. To see a menu, Control-
click a Dock icon or Control-click the Dock. (The

menu differs depending on whether you click
the Dock separator or in a blank area.)

Opening your packages

If you're a techie user, a contextual menu allows you to view
the contents of packages (special bundles of information pre-
sented as one cohesive item). These are used frequently in
Mac OS X, but you can view a package’s contents only in the
Terminal unless you use the Show Package Contents CM.

1. Control-click a file with the .pkg extension to
bring up the file’s contextual menu.

2. Choose Show Package Contents from the CM.

3. A window of the package’s contents appears. In
it, you commonly find

» Two text (XML files that store version and other
information about the package

» An archive file

» A resources directory

These files can then be examined, copied, or (if you know
what you're doing) modified. This concept isn’t unlike using
a resource editor like ResEdit back in earlier versions of
Mac OS.

As you explore this concept, you'll notice that the /Library/
Receipts folder tracks what was installed by creating pack-
ages. Also, many installers come in a package form. Even
most of Tiger's default applications, like Mail, are packages
whose contents can be viewed.

Using CMs with Third-Party
Applications

Many third-party applications, including commercial
apps, shareware, and freeware, take advantage of
Tiger’s contextual menus. Here are a few of the best:

v Rainer Brockerhoff (www.brockerhoff.net) pro-
vides, for free, a useful contextual menu applica-
tion called Zingg!. It replicates Tiger’s Open With

Technique 14: Saving Steps with Contextual Menus

functionality that allows you to open a file with
an application other than the default application.
It takes this principle a small step further by
allowing you to

» Set applications, such as Preview, Photoshop,
or BBEdit, to always appear

» Prevent selected applications from ever
appearing as an option

» Disable Classic applications as an option if
Classic isn’t open

v The DesktopPictureCM tool from Azine Software
(www.azinesoftware.com/other.php, free) sets a
selected image as the Desktop picture without
having to go through System Preferences.

v QuickAccessCM from Abra Code (http://free.
abracode.com/cmworkshop, free) grants you
immediate access to commonly used folders (see
Figure 14-4), files, and even applications. With it,
you can move, copy, or even make an alias of a
selected item in another directory.

Help
M 156 KB N
Open M 200 KB N
Open With M 368 KB N
Print M 48 KB N
Get Info M 200 KB A
| 2B0 KB N
Move to Trash | 248 KB N
. [ 248 KB N
Duplicate | 252 KB N
Make Alias i 276 KB N
Create Archive of 579630 fgl1403.tiff" | 216 KB N
7 i [ 240 KB N
Copy “579630 fg1403.tiff" b i F
Color Label: AM & MB A
X @ eeee """
E
Quick Access » Add Item
Move To b
Copy To » Pictures
Make Alias In » 579630 ch14
T —
Automator »
Enable Folder Actions
Configure Folder Actions...

* Figure 14-4: The QuickAccess contextual menu provides,
um, quick access to folders.



v OnMyCommandCM, also from Abra Code
(http://free.abracode.com/cmworkshop, free),
lets you invoke UNIX commands (like those
you’d type in the Terminal) or AppleScripts from
a contextual menu. It’s a must-have for power
Mac users!

B> menu scripts. They're all free and available at

z Abra Code provides a slew of handy contextual
-
http://free.abracode.com/cmworkshop.

é

v FinderlconCM (www.pixture.com/macosx.php,
free) is the fastest way to change icons, saving
you lots of Get Info’s, copies, and pastes. In
Technique 17, you see how to use this to quickly
change an item’s icon.

v Stufflt Deluxe (www.stuffit.com, $80) comes
with several contextual menu options. The popu-
lar utility (see Figure 14-5), whose main use is for
compressing and decompressing files and fold-
ers, creates CM tools to immediately archive or
open pretty much anything. You can also access
the Stufflt preferences through the CM and use
sequential tools such as Archive and Mail.

Stuff (.sit)

Archive 2
Compress b
Make Self-Extracting >
Mail [
Launch >
Dropboxes |
Preferences

¢ Figure 14-5: Stufflt adds many useful items to the
contextual menus.
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AppleScript, Contextual Menus, and You

v StickyBrain (www.chronosnet.com, $40 or poten-
tially free with .Mac) is the Stickies application on
steroids, providing you with an amazing asset for
managing information. This application creates
contextual menus that incorporate StickyBrain
into nearly any other application. See Technique
19 for more information on StickyBrain.

v CleverKeys (www.cleverkeys.com/ck.
htm1?p=home&os=macosx, free) provides a quick
link so that you can search Dictionary.com,
Thesaurus.com, Google, and other sites for
words you select.

] Search Google or www.versiontracker.com
e { -a) for more contextual menu applications that
b you can use.

Almost all of these applications come with their own
installers. After installation, log out and log back in
to take advantage of your new contextual menus. To
save time, install a number of contextual menus at
once, then log out and log back in (rather than log-
ging out after each installation).

AppleScript, Contextual
Menus, and You

A special subsection of contextual menus exists
thanks to AppleScript. Without too much work, you
can trigger (or run) AppleScripts from contextual
menus.

You can also invoke Workflows you've created
with Automator through contextual menus.
See Technique 61 for an introduction to this
great application, examples of how to use it,
and instructions for making your work there
CM-accessible.
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AppleScript for the uninitiated

AppleScript is a programming tool for the Mac. Because it's
very easy to use but still powerful, it's remained a popular
application over the years.

Apple has a vast supply of ready-made AppleScripts avail-
able for download. They're organized by application at www .
apple.com/applescript/apps.

For more juicy AppleScript details, pick up a copy of
AppleScript For Dummies, 2nd Edition, by Tom Trinko (pub-
lished by Wiley).

Big Cat, created by Ranchero Software (www.
ranchero.com), is a free application that adds the
ability to run AppleScripts from contextual menus.
Big Cat creates two separate categories of scripts:

v Text: For example, you can copy, open a selec-
tion in TextEdit, or search with Google (see
Figure 14-6).

Help

Cut £
Copy #C
Character... %D
Paragraph... 8BM

Bullets and Numbering...

Hyperlink... #K

Copy | Scripts P |

Download URL to Desktop
Google Search

Open Selection in BBEdit
Open Selection in TextEdit

* Figure 14-6: Big Cat’s textual tools.

v Files: These include scripts such as Copy Path
and Make Alias on Desktop (see Figure 14-7).

Technique 14: Saving Steps with Contextual Menus

Help 118, 2004, 11:40 AM 96
{18, 2004, 12:02 PM 212
Open 118, 2004, 12:09 PM 52
Open With P (18, 2004, 12:10 PM 224
Print 114, 2004, 5:15 PM 156
Get Info 114, 2004, 5:16 PM 200
|14, 2004, 5:25 PM 368
Move to Trash (14, 2004, 5:33 PM 48
Duplicate 112, 2004, 4:20 PM 200
A 12, 2004, 2:55 PM 280
Make Alias
Create Archive of “iChat-002.tiff" {2, 2004, 2:56 PM 248
Copy "iChat-002.tiff" [ 2004, 2:50.PM 252
12, 2004, 2:56 PM 276
Color Label: 12, 2004, 2:57 PM 216
X @ 6 TR 12,2004, 2:57 PM 240
117, 2004, 4:23 PM 4.6
Copy Path
Quick Access > Make Alias on Desktop
Move To > Open in BBEdit
Copy To » Open in TextEdit
Make Alias In » Stuff
| Touch
Automator L ——

Enable Folder Actions
Configure Folder Actions...

=

* Figure 14-7: Big Cat’s file tools, available as a contextual
menu.

Which options you see depend on what'’s selected
when the contextual menu is brought up. (Hence the
name contextual menu.) To install and use Big Cat:

1. Download the latest version of Big Cat from
http://ranchero.com/bigcat.

2. Double-click the downloaded file, called some-
thing like BigCatl.0.sit, to open it.

3. Open the resulting folder, called something
like Big Cat 1.0.

The contents should resemble Figure 14-8.

[ Big Cat 1.0 (=)

& .

BigCat.plugin How to Install.rtf

8o86

Big Cat Scripts

* Figure 14-8: The contents of the Big Cat folder.
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4., Move the Big Cat Scripts folder to ~/Library/ il e 0.5 B R = =
[« =] 22 | B~ Q-
Application Support, where ~ refers to your e e e
N = v P Flss Ot 18, 2002, 101 PM — Foder
Home directory. @ nenvarc Copy Patn 0 18, 2002, 1141 AW e senpt
= Hard Drive. Make Alas on Desktop Oct 18, 2002, 11:41 AM 4 KB swrigt
8 wrryuliman = Open In B8Edi O 18, 2002, 11:41 AM 4 KB scrigt
5. Move the file BigCat.plugin to the ~/Library/ i—::u:wl openinTextat DanRALAAL e
Contextual Menu Items folder, again where ~ Bumiman [ 3 Toeh Sl 20t U A 8% Torom
refers to your Home directory. s R mnes CEmER i B
I Movies Googhe Search Muar 76, 2002, Im :3 a: : KR :: 2|
If you don't already have an Appicaton g Onan seection in Tt Mar 26,2002, 1120 4Xdseron
Support ora Contextual Menu Items folder S :
in your Library directory, create one (using the * Figure 14-9: You can add any AppleScripts that you want
exact same spelling, capitalization, and spacing). to the appropriate Files or Text folder.
6. Log out of your computer and then log back in. If you really llkg Big Ca.t, consider maklpg a donation
to the cause with the links at the Web site (www.
In this case, you can't use Fast User Switching to ranchero.com/bigcat).
log out because that doesn’t close your session.

After you realize the benefits of Big Cat, you
might want more. The Ranchero Software
Web site has other scripts that you can down-
load and install as well as tutorials to teach you
how to write your own.

7. When you log back in, you should now have
the Big Cat options listed under Scripts when
invoking contextual menus.

8. To install your own AppleScripts to use through
Big Cat, drop them into the text or file sub-
folder of the ~/Library/Application Support
directory (see Figure 14-9).
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Save Time By

v~ Setting System
Preferences for Exposé

+ Navigating windows with
Exposé

+* Using Exposé without the
mouse

v Checking out the
Dashboard

tem called Exposé. Exposé allows you to access and switch among

open windows either throughout the entire operating system or
just in the current application. It also gives you immediate access to the
Desktop.

New in Panther and added to in Tiger is a window management sys-

In this technique, we introduce you to Dashboard & Exposé and all the
benefits that it has to offer. We also show the default mouse and key-
board shortcuts for using Exposé and how you can alter these. Then we
demonstrate a few techniques that you can use, thanks to Exposé.
Knowing how to switch documents within an active application, how to
drag and drop files more quickly, and how to use Exposé without the
mouse goes a long way toward helping you speed through routine tasks.
Finally, we introduce you to the Dashboard, a new feature in Tiger.

Introducing Exposé

You enable and control Exposé from the Dashboard & Exposé panel,
which is found under the Personal section of System Preferences.

1. Open System Preferences by going to the Apple menu or by clicking
its icon in the Dock.

2. Click the Dashboard & Exposé icon.
The Dashboard & Exposé pane appears (see Figure 15-1).
3. Set the corner activation settings for Exposé.

Exposé, like a screen saver, can use a feature called hot corners. Hot
corners are just the corners of your screen that have been assigned
special meaning. Moving the cursor into a certain corner activates a
function; moving it out of the corner deactivates that function. For
example, if you're in Safari, moving into one corner might reveal the
Desktop. When you move the cursor back out, Safari is revealed again.
Before you can use any hot corner, though, you need to assign func-
tions to them in the Exposé pane.



8een Dashboard & Exposé
[« =] [ showall Q|
Exposé allows you to temporarily see all your open windows at once, so you can easily
click on any window to bring it to the front. You can set a Dashboard shortcut to show
or hide the Dashboard.
Active 5creen Corners
Dashboard % | Disable Screen Saver |§
All Windows 5 | Desktop [ ]
Keybaatid and Mhlise Shotteliiss
All windows: | - ) = )
Application windows: | - ¥ :] - | :!
Desktop: | - i ] - 'C!
Dashboard: | F12 B (- H
For more shortcut choices, press the Shift, Control, Option, or Command keys. @

¢ Figure 15-1: The Dashboard & Exposé pane.

The pop-up menus in this pane correspond to
their positions on-screen. In other words, the
upper-left pop-up menu controls the upper-

left corner of your screen, and so on.

» You can set one corner to show every open
window (All Windows).

» You can set another corner to reveal every
open window for the currently active applica-
tion (Application Windows).

» You can set another corner to access the
Desktop (Desktop).

» You can set another corner to start your
screen saver.

» You can set another corner — you're at five
corners now, so you need to start making
choices — to disable the screen saver.

» You can have a corner do nothing whatsoever
(just, you know, sit in the corner).
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Introducing Exposé

4, Use the pop-up menus in the Keyboard section
to set your function keys to also perform cer-
tain Exposé- and Screen Saver-related tasks.

corners to start and disable the screen saver.
These controls are duplicated — even for
Exposé — under the Desktop & Screen Saver
System Preferences.

] The Exposé pane also allows you to set hot
- (@

&

You might find all these options intimidating. Here
are our best rules for customizing Exposé:

v You might want to skip setting a Desktop short-
cut in Exposé because you can also access the
Desktop by clicking it or by clicking the Finder
icon in the Dock.

v Because the All Windows and Application
Windows features are very similar, place the hot
corners on the same side of the screen and use
contiguous function keys for them.

v If your function keys aren’t readily accessible (or,
as with laptops, require the use of the fn key to
work), avoid setting the function key shortcuts
or otherwise ignore them.

v If your function keys are already being used for
other purposes, skip setting the function keys
and just use the hot corners instead.

v If your function keys are already being used for
other purposes, you can add a modifier key to
the keyboard shortcut by holding down the
Shift, 88, Option, or Control key while you select
the corresponding function key (see Figure 15-2).

v Multiple displays (see Technique 8) probably
still only have four corners, even though it might
seem that you physically have eight.

Strange as it might seem, some muiltiple dis-
plays might have five or more screen corners.
If the two displays aren’t aligned exactly, there
can be an extra corner or two between the
two displays, as shown in Figure 15-3. This
isn't necessarily a problem or an asset but just
a curiosity to be aware of.



] ’6 Technique 15: Easily Managing Windows with Exposé

e8on Dashbeard & Exposé

Exposé allows you to temporarily see all your open windows at once, so you can easily
click on any window to bring it to the front. You can set a Dashboard shortcut to show
or hide the Dashboard.

Active Screen Corners

T e re—
Dashboard Disable Screen Saver |'3]

All Windows Desktop 5
#4 F4
B4 FS
Keyboard and Mouse Sh
'_'—_4 B4 F6
All windows 34 F7 - =
®B4 F8 —
Application windows g0 £g - |
Desktog 0 F10 - >
#4 F11
Dashboard # F12 = [=
#4 F13
For more shortcut choices,|  — Command keys. @

¢ Figure 15-2: You can also trigger Exposé by using the
function keys and a modifier key (or keys).

@

86 Multiple Scan Display

< »|[ showall Q )

! Display | Arrangement | Color '

To rearrange the displays, drag them to the desired position.
To relocate the menu bar, drag it to a different display.

"I Mirror Displays

¢ Figure 15-3: The arrangement of your displays dictates
how many corners your system has.

v If you have a Mac with a small display (such as
an iBook or the 12-inch PowerBook), you might
find the hot corners a nuisance. They tend to
cause funny Exposé things when your cursor
(even accidentally) nears a corner.

v If you have a multi-button input device, you can
set the extra buttons to trigger Exposé, with or
without modifier keys (see Figure 15-4).

8een Dashboard & Exposé

) (] q

Exposé allows you to temporarily see all your open windows at once, so you can easily
click on any window to bring it to the front. You can set a Dashboard shortcut to show
or hide the Dashboard.

Active Screen Corners

Dashboard e Disable Screen Saver |3
All Windows [ Desktop [

Keyboard and Mouse Shortcuts

3 {+ Right Mouse Button
# 0+ Mouse Button 3
354+ Mouse Button 4
3 {r Mouse Button 5
& {* Mouse Button 6

All windows: | - [

Application windows: | - v
Desktop: | - } C]
Dashboard: | F12 s

For mare shortcut choices, press the Shift, Control, Option, or Command keys. @

(R

¢ Figure 15-4: You can set modifier keys and extra mouse
buttons to use Exposé.

g The most natural way to trigger Exposé is
e («a probably to use the hot corners with the
& mouse. For many people, the function
keys aren’t as easy to access and use as the
mouse is.

Getting the Most out of Exposé

After you get Exposé set up the way you want it, you
need to know how to get the most out of its poten-
tial. Aside from revealing the Desktop, Exposé either
displays all the open windows (including Finder win-
dows, Web browser windows, and documents) or all
the open windows for the current application. Here
are the basics for using Exposé.



To switch to a different document within the current
application:

1. Depending on how you’ve set your System
Preferences, press the keyboard shortcut, use
the mouse shortcut, or move your cursor to the
hot corner to bring up all the open windows for
the current application (see Figure 15-5).

W Safari file [6n View History Bockmarks Window Hein - 4l s

T 12352 7 1 C

¢ Figure 15-5: The Exposé display for the active application.

2. Place your cursor over each window (the rest
of the screen will be dark) to view its title. (See
the middle image of Figure 15-6.)

Safari File Edm View History Bookmarks Window  Heln - CETRCSTLTE Y o

* Figure 15-6: Exposé shows a window or document'’s title
when you hover the mouse over it.
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Exposé shows only open windows and docu-
ments. Minimized windows and documents
are never revealed.

3. Click the desired window to make it active.

Getting the Most out of Exposé

You can always press Esc to leave Exposé with-
out switching windows or applications.

To switch to a document in another application:

1. By using the keyboard shortcut, the mouse
shortcut, or the hot corner, bring up all the
open windows.

Check out the party in Figure 15-7 (and that’s not
even a particularly busy day).

W Preview file fdn View Go Tooh Sookmarks Window Heln

I < [ el
* Figure 15-7: The Exposé display for every open
application.

2. Place your cursor over each window (the rest
of the screen will be dark) to view its title.

3. Click the appropriate window to make it active.

This tip’s just too cool for school: After you use
Exposé to show all the open windows and
documents, you can access all the windows or
documents for specific (open) applications by
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pressing the Tab key. The end result is much
like rotating through Exposé’s current applica-
tion listing without actively switching from one
application to another. If you have a lot of clut-
ter or want to view a particular window or doc-
ument in a larger size, this is the way to go.

Dragging and dropping with Exposeé

One of the coolest features of Exposé is that you can
use it for drag-and-drop purposes, like when you
want to quickly add an attachment to an e-mail or
copy and paste some text from one application to
another. This might not be obvious on first exposure
(insert groan here), but it’s a really cool technique.
Here’s the skinny:

1. Select the item or items that you want to drag
and drop (see the 579630 chl4.sit file in
Figure 15-8).

ana L Part 2 —
= (¢ —_
[« [w=als] @2 a:
8 ok j | z
9 rerwork F r 4 (B
| B4 suard Ot 579630 cha? 579630 £h0A 579630 choa 579630 ¢h10.
i larryuliman =
3 Desiaop - 4 k]
4 armyuliman B = == = &
o Applications STH650 chll STI630 chlz 79630 chld 79630 chldan
j Documents
B Mavies i H0) =
& Music = = L=
1 Pictures 579630 chld STO630 chld.sit §79630 ch1s
] Lot 11 selected, 6 B4 GB avaitabie 7

* Figure 15-8: To attach a document to an e-mail, first
select the document in the Finder.

For example, you can select
» A file in the Finder to attach to an e-mail
» Text in an e-mail to drop into BBEdit

» An image in Photoshop to view in your Web
browser

» Text in a Word document to copy into another
Word document

» Files in a Finder window to duplicate or move
to another Finder window

Technique 15: Easily Managing Windows with Exposé

2. Begin dragging the selected item by clicking
with the mouse and moving your cursor
slightly.

3. While continuing to hold down the mouse but-
ton, use Exposé to show either all the currently
open windows or all the open windows for the
current application.

Do so by moving the cursor into the correct hot
corner or by pressing the associated keyboard
shortcut to engage Exposé.

4. While continuing to hold down the mouse but-
ton, select the appropriate window or docu-
ment by moving the cursor over it (see the
lower-left corner of Figure 15-9).

M 043 P

¢ Figure 15-9: To add an attachment to an e-mail, select
the e-mail’s image by hovering over it.

5. While (still!) continuing to hold down the
mouse button, activate the highlighted window
or document by pressing the spacebar.

e document or window if you hover the cursor

] Exposé also automatically switches over to a
(«
over it for a couple of moments.

)

6. While (of course) continuing to hold down the
mouse button, move the cursor within the win-
dow or document to where you want to drop
the selected item.



7. Release the mouse button to complete the drop.

See the results in Figure 15-10.

®06 Chapter 14 e

@& [@ A Q |

_S_End Chat Attach Address Fonts Colors _E..aveﬁ\s-Draft

To: Larry Ullman

Cc:

%~ | Subject: Chapter 14

Hey Larry,
Here's chapter 14. Enjoy!

LSIT

1@l

579630 chl4.sit (393 KB)

* Figure 15-10: The completed drag-and-drop attaches the
file to the e-mail.

8. Apply hot and cold compresses to your tired,
aching, mouse-clicking finger as needed.

Using Exposé without the mouse

This technique is for you if you never take your hands
off the keys or if you use the mouse as a toy for your cat.

You can use Exposé without touching the mouse
at all.

1. In the Exposé panel, make sure that you have
the keyboard shortcuts enabled.

2. Press the appropriate keyboard shortcut to
launch Exposé.

By default this is
» F9 to see all open windows

» F10 to view all the current application’s open
windows (or documents)

» F11 to head to the Desktop
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Dashing to the Dashboard

3. Use the arrow keys to select the window or doc-
ument that you want.

The arrow keys move you around the window
listings as you would expect: left, right, up, and
down.

4. Press the spacebar to make that window or
document active.

5. If you brought up all the active windows in
Step 2, you can rotate among the windows of
the different active applications by pressing
Tab. Use the arrow keys to select a window and
the spacebar to make it active.

Dashing to the Dashboard

New to Tiger and Exposé is a whole world called the
Dashboard. The Dashboard gives you one-button
access (the F12 key) to widgets. A widget is a term
referring to a mini-utility designed to do one simple
thing (such as show a clock). People with minimal
skills can write new widgets, which can later be
added to Tiger. Out of the box, Tiger comes with

14 widgets:

\

Access to your Address Book

A simple calculator

A calendar

An iTunes information and control bar
Stickies (sticky notes)

A world clock

A tile game

A flight tracker

A dictionary and thesaurus

A phonebook

A weather tracker for various locations
A currency converter

A language translator

W W W W WO W U N N N W W

A unit converter
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As you can see in Figure 15-11, you can have as many
widgets open at once as you want, and often multi-
ple copies of the same widget (for example, there are
two clocks in the image).

¢ Figure 15-11: The Dashboard has some of its widgets
open.

Besides pressing F12 to get to the Dashboard, here’s
what else you might want to know:

v Open a new widget by clicking its name on the
widget bar.

v Hover your mouse over the widget bar and then
click the More tab that appears to see more
options (such as more widgets or a Trash icon
for getting rid of widgets).

v Minimize the widget bar by clicking the X. It
rotates into a plus symbol, which you can click
to maximize the widget bar.

v Hover your cursor over any widget to create an
X that allows you to close that widget (see
Figure 15-12).

v Click the red button at the bottom of the
Address Book to launch the actual Address Book
application.

Technique 15: Easily Managing Windows with Exposé

Hey now brown cow.

¢ Figure 15-12: The X in the upper-left corner lets you
close (but not delete) a widget.
v To change the city setting for the clock
1. Hover your mouse over the clock widget.

2. Click the “i” symbol that appears in the lower-
right corner.

3. Select a continent from the first pop-up menu
(see Figure 15-13).

)

Continent:

Gity:

Done

¢ Figure 15-13: You can customize some widgets, such as
the world clock.

4. Select a city from the second pop-up menu.

5. Click Done.
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Handling Files (And
Other Stuff) Quickly

The Sth Wave By Rich Tennant
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Organizing Your
Home Directory

Technique

Save Time By

v Understanding your
Home directory’s default
structure

v~ Finding out about the
Library

v Using the Desktop wisely

v+~ Reminding yourself how
great the Dock can be

lovely Macintosh in front of you. Tiger — Apple’s latest and greatest

operating system — is purring along. You might have read Part II of
this book and picked up some navigation tips, discovered how to work
the Finder, organized your Dock, toyed with contextual menus, and
(hopefully) begun using Exposé. But the real question haunting your
mind is this: What do I do with all my stuff? That’s what we tell you in
this technique.

Picture this: You're sitting there reading this book. You've got a

This technique is all about your stuff: you know, those files and folders in
your Home directory, most of which were created by default, and some of
which you might have added. The first section of this technique is a
primer on the Home directory, how it’s organized, and how to most effi-
ciently use it. We then take you on a brief tour of your Library folder,
which is a special area for special files. The third section delves into the
Desktop: what you ought to know about it and some good ideas on how
to use it. Finally, we briefly discuss the Dock, just to make sure that
you've really started using it.

Your Stuff, Vour Home Directory, and VYou

Mac OS X revolutionized the way files are managed on the hard drive
(for Mac users, at least). This is largely thanks to the more secure multi-
user environment. All users have their own directories, located within
the Users directory on the boot operating system’s hard drive, as shown
in Figure 16-1. Each user’s directory is named after the user’s short name,
as entered when the account was created.

866 | & Users (=)
AN
E | -
larryullman marc Shared

* Figure 16-1: The Users directory and its contents.
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In the Users directory, the current user’s
Home folder is always marked by a little house
icon. (See the folder named /arryullman in
Figure 16-1)

Although separating the users this way might seem
like a hassle, here are some benefits:

v The structure is more secure: Each user can
access only his or her own files (assuming that
folks log in as themselves).

v The operating system is safer: Because your
stuff is no longer interspersed with the operating
system’s stuff, you're far less likely to do some-
thing that messes up your whole computer.
Granted, you can still do something to mess up
your stuff, but we cover how to avoid doing that,
too (see Technique 22).

v Your stuff is easier to back up: If you manage
your stuff properly, using the format suggested
by Apple, you can back up every important item
— all your e-mail, documents, pictures, music,
and even application preferences settings —
simply by backing up this one directory.

v Your stuff is easier to restore: Should a disaster
ever strike, you can fully recover all your stuff as
long as you've backed up your Home directory.
Whether you use backup software or just copy
the entire directory to an external drive, restor-
ing your files is never very complicated.

v Your files are easier to transfer: If you want to
move your files from one computer or hard drive
to another, copying the contents of your Home
directory does the trick.

v Operating system upgrades are less intrusive:
Whereas previous Mac OS upgrades could affect
your data, OS X upgrades avoid touching the
Users directory altogether, making these transi-
tions less painful.

In this book and other resources, you often
seen path names: the full name of a folder on
your computer. In path names, the ~ (tilde)

refers to the current user's Home directory.
For example, if Marc is logged in, ~ refers to

Technique 16: Organizing Your Home Directory

/Users/marc. If Larry is logged in, ~ means
/Users/Tarryullman. Thus, ~/Documents
can stand for either /Users/Tarryullman/
Documents or /Users/marc/Documents, but
it is always the current user's Document folder.

By default, your Home directory consists of what
you see in Figure 16-2:

ene 4 larryullman (=]
i " .r____.--~
G 0 i
Desktop Documents Library
e = '_.-"""_ == |
- [ & =
= = =

Movies Music Pictures

= =
| = *}

Public Sites

* Figure 16-2: The standard user’s Home directory.

v Desktop: The Desktop folder contains all the files
and folders stored on the Desktop. The Desktop
might also show volumes, CDs, DVDs, disk
images, and more, but those aren’t actually in
the Desktop folder.

v Documents: The Documents folder was created
as a place for you to store your, um, documents
(such as your Word files, work-related projects,
downloaded stuff, and more). Things you look at,
edit, read, delete, create, and so forth all go in
the Documents directory.

g The Documents directory should be the folder
that you work with the most! By keeping all
& your documents in it, they are easier to find,
open, search for, and save.

v Library: The Library could actually be the most
important part of your Home folder (or second
most important after the Documents folder). The
Library stores everything the operating system
needs to know about you. This includes



Address Book records

iCal calendars

Favorites

Keychains

The Mail application’s data

Preferences files

vV v vV v v VY

Web browser bookmarks
» Stickies contents

Because the Library folder is so important, we
cover it a bit more in this technique.

Movies: The Movies directory was intended as
the default directory for creating movies in
iMovie. It’s one of the few optional folders in the
Home directory.

Music: The Music directory is the iTunes equiva-
lent of the Movies directory. It’s intended to
store your music collection and the text files that
iTunes uses to manage that collection.

Pictures: The Pictures directory is the iPhoto
equivalent of the Movies and Music folders. The
iPhoto application uses it by default, but it’s also
a logical place to store any graphics that you
have.

Public: The Public folder is a special case. It’s
designed to provide a storeroom for files that
will be accessible by other users on your
Macintosh or on your network. Within the Public
folder is a Drop Box folder so that others on your
Network or Mac can give you files.

If a number of files need to be accessible by
everyone on your Mac, place them in the
Shared folder within the Users directory. Every
user can read from and write to this folder,
making it a great document management tool.

Sites: The Sites folder is for Web pages, which
can be accessed by going to http://Tocalhost/
~username/ or http://your.ip.address/~
username/ (see Figure 16-3).
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Vour Stuff, Your Home Directory, and You

806 Mac OS X Personal Web Sharing

< »|[ e | +]| @hup://127.0.0.1/~larryullmany

2(Q- Google

e

Your website here.

You can use Mac OS X Personal Web Sharing to publish web pages
or share files on the Internet — or on your company's or school's
local area network — from a folder on your hard disk.

You can display your documents on the Internet — or restrict
access to a chosen few within a local area network. Mac OS X
Personal Web Sharing makes it a snap.

Here's how it works: Create your website by changing this page
(it's called "index.htm!" and it's in the Sites folder in your home
folder) and creating any other HTML pages you want.

Once you're online, turn on Personal Web Sharing, then send your
web address to other people.

* Figure 16-3: The Sites folder holds Web pages that you
can access through browsers like Safari.

Here are our top ten tips for organizing and using
your Home directory:

v Don’t delete or rename any of the existing
folders.

v Use the Desktop as a temporary storage place.

As a general rule, you can add folders or files
to your Home directory, but you shouldn’t
delete or rename any of the default folders. In
particular, tinkering with the Desktop or
Library folders would be a grave mistake.

See “A Cluttered Desktop Is a Sign of a Cluttered
Mind,” later in this technique.

v Use the Documents folder for all your
documents.

Go wild with it. Organize your documents as logi-
cally as possible, creating subdirectories for files
based upon their type (what application created
them) or purpose (personal, school, work).

Most applications use the Documents folder as
the default place to save or open files. Go with
the flow on this point: It will save you endless
time spent wandering around your computer
in search of a file.

¥
w(@
)
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v If you have enough hard drive space, place all

your music, movies, and pictures in the appro-
priate media folders.

Apple’s iLife applications (iTunes, iPhoto,
@ iMovie, and iDVD) can use directories that are
located outside of your Home directory for

their files. This is normally an option within the
particular application’s preferences.

v If you create Web sites, place all the associated

files within the Sites directory. (Don’t split
the files between the Sites and Documents
directories.)

If an application gives you the option of
installing it system-wide or just for your use,
install it just for your use.

If you install the application for yourself, the files
go into your Home directory and are retained
through any operating system transitions that
follow.

Store smaller-sized software that you simply
must have — such as drivers for an input
device or printer — in your Home directory so
that they’ll be easy to find if you need to rein-
stall them.

Create an Installs or Software directory within
(«a your Documents folder to store small applica-
tions that you will probably need to install

again. For example, the driver for your mouse
might be only 2MB in size and needs to be
reinstalled with every major operating system
upgrade. Keeping a copy of the installer saves
you a trip online the next time you need to
install it.

v Create a text document listing all the software

and corresponding serial numbers that you use
on your computer — and then store it in your
Home folder.

Print this document for reference as well.

Technique 16: Organizing Your Home Directory

v Add fonts, contextual menu items,
AppleScripts, screen savers, and other add-ons
to the operating system in the corresponding
folders of your Library, not the system library.

v Back up your entire Home directory fre-
quently, often, regularly, consistently, without
fail, and on a regular basis. See Technique 49
for backup utilities and best practices.

Checking Out Your Library

The Library is, in some ways, the most important
item in your Home directory. It contains all the infor-
mation about you and how you use the computer.
Here’s a rundown of some of the Library’s important
folders and how they relate to your use of the com-
puter:

v The Application Support folder contains critical
files for many applications (check it out in
Figure 16-4), including

» Your Address Book data
» iCal information (other than calendars)
» Extensions to the Terminal application

Third-party applications also use the Application
Support folder:

» The LaunchBar utility keeps its settings there.

» The Camino Web browser stores preferences
and bookmarks.

» Big Cat stores AppleScripts for contextual
menus.

» The Fire list of accounts and preferences is
saved here. (Fire is an instant messaging
application.)
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* Figure 16-4: Many applications add items to your
Application Support directory.

v Extra system alert sounds can be added to the
Sounds subfolder of the Audio directory.

v The Calendars directory stores all your iCal data
(see Technique 46).

v The ColorSync folder has your ColorSync pro-
files (see Technique 8).

1 Contextual Menu Items contains your added CM
tools (see Technique 14).

v The Favorites folder is where aliases to favorite
applications, documents, and folders are kept
(see Technique 17).

»  You can install your own fonts by adding them to
the Fonts folder.

v Additional plug-ins and tools for iMovie can go in
the iMovie folder.

v Additional plug-ins and scripts for iTunes can go
in the iTunes folder (see Technique 43).

v The Keychains folder stores your keychain, which
contains your passwords (see Technique 53).

v The Mail folder has all your Mail application’s
data.

v The Preferences folder contains the preferences
files for almost all your applications and even
your operating system as a whole.

v Safari stuff is stored in the Safari directory
(see Figure 16-5).
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Checking Out Your Library

©606 [ =

Bookmarls.plist Downloads. plist

Form Values History.plist

—

lcans

* Figure 16-5: -The ~/Library/Safari folder keeps your
bookmarks, viewing history, and more.

As you can see, pretty much everything except for
your applications and your files (images, documents,
and what-not) gets stored in the Library directory.
For this reason, be sure to treat it with respect and
include it in your daily backups. (You are doing daily
backups, right?)

Aside from backing up your Library folder and
possibly adding a few things to it, don’t mess
around with it unless you really know what

you're doing. If you delete something you
shouldn’t, you can cause yourself a lot of pain.

How many Libraries does one
computer need?

Your Macintosh actually has several Library folders oniit . . .
three at least. Strange as this might seem, these libraries all
serve approximately the same purpose. The main differ-
ences are the priority and scope that each Library has. You'll
find a Library folder in

v The root of the system disk (/Library)

The /Library folder is primarily for third-party appli-
cations and other developers to install items for all
users. During OS upgrades, Apple doesn’t mess with
the /Library folder.

(continued)
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v The System folder (/System/Library)

The /System folder is basically for Apple and only
Apple usage. Apple has carte blanche with /System
during upgrades.

v Each user’s Library folder (~/Library)

For example, each of these Libraries might have a
Contextual Menu Items folder. ltems in your CM folder will
be available only to you. Items in the /System/Library
CM folder are available to every user on the computer and
were probably put there by Apple. In future versions of the
operating system, those CM items might be upgraded.
Those in the /Library folder are available to all users and
should remain unharmed by upgrading the OS. In case
you're the curious type, note that the contents of the
various libraries are loaded in this order: /Library,
/System/Library, ~/Library.

One important consideration with the Libraries is that
things stored in either /Library or /System/Library
might be replaced with every new installation of an operat-
ing system. If you perform an Erase and Install, an Archive
and Install, or even an Upgrade, these contents will likely be
replaced or overwritten. The contents of your Library folder
will remain, though, making it a good place to store all your
stuffl

A Cluttered Desktop Is a Sign
of a Cluttered Mind

The Desktop exists in two worlds. Yes, that’s right —
the Desktop is both a dessert topping and a floor wax:

v It’s the base level of the Finder, appearing on
your screen underneath everything else (as
shown in Figure 16-6).

v It’s another folder within your Home directory
that can be used to store your stuff (see
Figure 16-7).
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¢ Figure 16-6: The Desktop as viewed in the Finder.
76 (] 6 (@ Desktop =
[ 3 " o
data Installed Applications larryullman on
PANTHER
=
|
Software

* Figure 16-7: The Desktop as just another directory in a
Finder window.

The main difference between the Desktop and your
other folders is that the Desktop’s contents are
pretty much always visible because it’s the bottom
layer (so to speak) of what’s on your monitor. On the
bright side, anything that’s stored there is readily
accessible. But if you've got a lot going on there, it
can quickly become overwhelming.

Because the Desktop is almost always visible
e («m and can become cluttered quickly, we strongly

advocate that you use it primarily for tempo-
rary storage and to access hard drives, CD-
ROMs, and the like. You might even want to
create subfolders on the Desktop for longer-
term (yet still temporary) storage to cut down
the mess.
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Aside from tinkering with how much stuff lingers on
your Desktop, you can customize its behavior in
three ways:

1 Use the Desktop & Screen Saver panel of
System Preferences (see Figure 16-8).

This panel allows you to set what color, graphic,
or picture is used as the backdrop of the
Desktop. Although it’s an aesthetic decision, hav-
ing a visually pleasing Desktop goes a long way
toward preserving your sanity.

To change your Desktop background:

1. Control-click the Desktop to bring up the con-
textual menu.

2. Select Change Desktop Background from the
contextual menu.

3. In the resulting window (see Figure 16-8),
select a broad category from the left column.

Only one of the options behaves uniquely: If
you click the Choose Folder option, you're
given an Open dialog in which to find a folder
on your hard drive. After you find the folder
you want, click the Choose button or press
Return.

4. Click one of the options that appears in the
right column to select a specific color or
image.

5. Quit the System Preferences panel.

If you really like eye candy, set the Desktop
panel to rotate its picture every so often by
using the Change Picture drop-down list. You
can also do a hack to make screen savers run
as the background to your Desktop. It's a very
processor-intensive thing to do, slowing down
your computer noticeably, but it's soooo cool.
See Technique 62 for instructions and helpful
tools.

1 Use the Finder preferences panel (see
Figure 16-9), under General.
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880 Desktop & Screen Saver
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* Figure 16-8: The Desktop & Screen Saver panel sets the
graphical appearance of your Desktop.

__6 e o Ceneral
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General | Labels Sidebar Advanced

Show these items on the Desktop:
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™ cDs, DVDs, and iPods
@ Connected servers

New Finder windows open:
| @ Home [ !

] Always open folders in a new window

" Open new windows in column view

ESpring—Ioaded folders and windows

—

Delay: V
1 1 1 1 1 1

Short Medium Long
Press Space Bar to open immediately

* Figure 16-9: Use the Finder’s preferences to dictate what
volumes are mounted on the Desktop.
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Here you can indicate whether you want hard
drives, CDs, DVDs, iPods, and connected servers
to appear as icons on your Desktop.

v Select Viewr>Show View Options (see
Figure 16-10) in the Finder.

For how your Desktop looks and functions, the
Show View Options panel is the most critical of
the settings panels. Here you can set

» The default size of icons (in pixels)
» The default text size for names of items

» Whether an item’s name (called label in this
panel) should appear below or to the right of
an item

» Whether you want to see an item'’s info (for
example, the dimensions of an image or the
size of a hard drive)

» Whether you want to see a thumbnail preview
of images as their icon

» How files should be arranged, if at all

You want to set the icon and text sizes so that
they’re easy to view but don’t take up too much
space. The arrangement of items is the most impor-
tant consideration. If you keep them arranged by
name, your hard drives, discs, and such appear in
the upper-right corner. Remaining items are listed in
alphabetical order, just as you’d see them in the list
or column view of a Finder window.

If you prefer your Desktop to be more
entertaining than useful, consider iLuxo,

a free application from The iOS Zone (www.
ios-software.com). This utility adds anima-
tion and sound to your Desktop but is best
used only if you have a speedy computer.
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o Desktop.

lcon size: 48 x 48
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@ Show item info
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Name 4 j

* Figure 16-10: If no window is selected, the View Options
control the Desktop.

Revisiting Our Friend, the Dock

We give a good amount of attention to our friend, the
Dock, in Technique 13. We’d like to revisit (or visit, if
you haven’t read that other technique yet) one
aspect of organizing the Dock.

The Dock has two sides: the left, where applications
are docked, and the right, which contains the Trash
and any folders or files that you choose to dock
there. After you get your stuff organized, it’s a good
time to add key components to the right side of the
Dock. We recommend these (see Figure 16-11):



* Figure 16-11: The right side of Larry’s Dock, with current
projects, his Home folder, and his Favorites
all docked.

Your Home folder itself

Your Documents folder

X Y\

The folder(s) for any current project(s)

v The Desktop folder, if you really use the Desktop

You can access any directories that you add to the
Dock in hierarchical form by Control-clicking the
directory’s icon (see Figure 16-12). This trick gives
you fast access to the files that you use the most.

Revisiting Our Friend, the Dock 73 1

¥ Desktop [
| = Documents

| & Library b
= Movies

| & Music

| = Pictures B
& Public (2
(3 Sites =

Remove from Dock
Open at Login
Show In Finder

Open

* Figure 16-12: Control-clicking a docked folder brings up a
menu of its contents.



Managing Aliases,
Favorites, and Icons

Technique

Save Time By

+* Working with aliases to
establish shortcuts to
popular files, directories,
and applications

v~ Using Favorites to quickly
get to your favorite things

v~ Customizing the icons
used for files and folders

that give you quick access to the files and folders that you use

This technique deals with aliases, Favorites, and icons: all the things
most.

This technique has three main sections, each of which shows you how to
deal with the contents of your computer indirectly. In the first section,
we talk about aliases: what they are, how you create them, and how you
want to use them. In the second section, we go into Favorites, which are a
specific grouping of aliases. In the final part of this chapter, you find out
about icons, which are the visual representation for your stuff.

Also Known As: Working with Aliases

Your computer is loaded (perhaps overloaded) with many different files,
folders, and applications. Each of these items is located in a specific spot
on your hard drive, represented by an icon and a filename. An alias is a
secondary pointer to the same item. It can be (and normally is) placed in
another location; it can have a different name; and it can even have a dif-
ferent icon. However, by default, an item’s alias uses the same icon as the
original except for the addition of a little black arrow in the lower-left cor-
ner (see the bottom icon of Figure 17-1). The alias is created with the
same filename as the original except that the word alias is also appended
to the end under most circumstances.
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Ficture 2 alias

* Figure 17-1: An alias looks like the original file save for

the black, curved arrow.

Aliases offer the following benefits:

|7

7

They allow you to have virtually the same item
existing in many locations.

They’re relatively small in size. For example,
the alias of a 6MB MP3 file might take up only a
few KB.

They enable you to create groups of aliases to
related items without shuffling around the origi-
nal items.

They are very easy to create, manage, and
delete.

They make accessing files, folders, and applica-
tions easier without undermining any organiza-
tional structures.

Also Known As: Working with Aliases
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The operating system makes use of aliases all
over the place. Items in the Dock, in the left
side of a Finder window, and some menu
items are aliases. You might not be aware of
these aliases and they might not have the
little black, curved arrows, but the principle
remains.

Here’s how aliases work:

v Opening an alias of a file has the same effect as
opening the original file.

v Opening an alias of an application is the same as
opening the application by using its original icon.

v Opening an alias of a folder opens the original
folder.

v Deleting an alias has no effect on the original
item at all.

®
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An alias isn’t a copy of an item. If you open
and edit the alias of a file, the effect is the
same as if you open and edit the original file.
But if you delete an alias, the original remains.

After you select an item, you can create an alias in
any of five ways:

v Press $-L.

v Hold down the Option and 38 keys while drag-
ging the item with your mouse.

If you use this method, the cursor turns into the
little curved alias arrow.

If you use the 38-Option-drag method to
make an alias, it adds the word alias to the
filename if you drop the file within the same
folder as the original (because a folder can’t
contain two items with the same name). If you
create the alias in another folder, it doesn’t add
the word alias. In either case, the curved black
arrow is added to the icon, indicating its alias
status.
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v Go to the Finder’s File menu and choose Make
Alias (see Figure 17-2).

Mew Finder Window N
MNew Faolder i+ 36N
Mew Smart Folder #EN
MNew Burn Folder

Open 30
Open With >
Print

Close Window W
Get Info Eid|
Duplicate #D
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Show Original 3ER
Add to Sidebar #T
Create Archive of “579630 Ch36vs-dc-lu.doc” "C3A
Move to Trash #=
'.-'.I BCl HE
Burn Disc

Find... 2EF
Color Label:

x @ U J B e e e

* Figure 17-2: The Make Alias command is located in the
Finder’s File menu.

v Control-click the item and select Make Alias
from the resulting contextual menu.

1 Use the QuickAccessCM’s Make Alias In option
(see Figure 17-3).

This contextual menu is mentioned in Technique
14. One of the many features it adds is the ability
to make an alias and place it in another direc-
tory, all in one step.
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Open
e | ! Get Info
| 2] |
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579630 ch16 [ 579¢
Duplicate
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= =

579630 ch18 s70¢ COPY "579630 chl?
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fa | A X 8@ e e e
ir
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Quick Access »
3  Move To »
1 of 7 selected, 35 CB ava
of 7 selec a-pi Copv = <
Add Folder Make Alias In »
Choose Destination Folder...
Automator »

| Enable Folder Actions

Configure Folder Actions...

* Figure 17-3: Using the QuickAccess contextual menu to
make an alias.

To find the original item for an alias, select the alias
and do one of the following:

1 Press 3#8-R.

v Choose Show Original from the Finder’s File
menu.

v Control-click the alias and choose Show
Original from the contextual menu.

Remarkably, aliases continue to work no matter
what you do with either the alias or the original file
as long as you don’t remove either from the volume
in which it was created. If an alias can’t find the orig-
inal file, you see a prompt (as shown in Figure 17-4)
that allows you to reselect the original or delete the
alias.



The alias "wrigleyfield.gif alias” could not be
opened, because the original item cannot be found.

4

(_ Delete Alias I I Fix Alias... ) ( oK )

* Figure 17-4: Opening an alias whose original file can’t be
found generates this prompt.

A UNIX alias: Symbolic links

The Macintosh alias is the equivalent of the UNIX symbolic
link (and the Windows shortcut, too, but who cares about
Windows?). A symbolic link is just a secondary pointer to the
original file, application, or folder. Because Mac OS X is
based on the FreeBSD version of UNIX, you can also make
symbolic links in it by using the Terminal application.

The syntax for linking to a file is Tn -s alias_name
original_file_name. If you aren’t in the same directory
as both the original and the alias or if you otherwise want to
be exact, you probably want to include the path to both the
link and the original file: 1Tn -s /path/to/original_
file_name /path/to/alias_name. |f you want to create
an alias to a folder, the same syntax applies: for example,
In -s /Users/larry/Sites /Users/larry/Desktop/
Sites_alias or simply 1n -s ~/Sites ~/Desktop/
Sites_alias. As with standard aliases, a symbolic pointer
is created by this command, pointing to the original item.

Like UNIX, with the Mac you can create hard or soft links.
The -s option creates a soft link, and omitting it creates a
hard one. A soft link is exactly like an alias. A hard link is like
having another copy of the data itself and also has the
restriction that hard links can’t point to an item on another
volume (a disk drive or partition). You really should stick to
soft links because hard links are likely to cause problems in
one way or another.

One advantage that the Mac’s aliases have over symbolic
links is that you can move an alias from one location to
another, and it still works — it finds the original just fine.
Conversely, symbolic links can never be moved. They must
be deleted and re-created instead.

If you're keen on symbolic links but tired of the Terminal,
check out the MakeSymlink contextual menu (www.
naratt.com/MakeSymlink.html, $12). It allows you to
create actual symbolic links in the Finder.

These Are a Few of My Favorites Things ’35

These Are a Few of My Favorites
Things

In Mac OS X, Apple introduced Favorites: a collection
of aliases for your favorite things. By default, your
Favorites were linked as a folder in your Dock, allow-
ing you to access those items by Control-clicking

(or clicking and holding) the icon (see Figure 17-5).
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* Figure 17-5: The Favorites folder in the Dock.

In previous versions of Mac OS X, the 8-T shortcut
added the selected item to your Favorites, but this
feature has been eliminated. (In Tiger, that shortcut
now adds the item to the Finder window’s Sidebar.)
But we still like the idea of Favorites, so here’s the
easiest way to access your Favorites:
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Open a Finder window.

Navigate to the Library folder in your Home
directory (~/Library).

Select the Favorites folder.

Press 38-T to add the Favorites to the window’s
Sidebar (see Figure 17-6).
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* Figure 17-6: Your Favorites appear in the Sidebar with a
heart-shaped icon.

4. If you want, also drag the Favorites folder onto
your Dock so that it’s accessible there.

After your Favorites are readily available, you’ll
want to actually add your favorite things to this
collection:

1. From the Finder window, navigate to the item
that you want to add to your Favorites.

2. Select the item.
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3. Begin dragging the selected item toward the
Favorites icon in the Sidebar.

4. While still dragging but before reaching the
Favorites icon, hold down the Option and 8
keys so that the Make Alias icon appears with
your dragged selection.

5. To confirm that the item was added to your
Favorites, click the Favorites icon in the
Sidebar to bring up the directory (see
Figure 17-7).
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* Figure 17-7: A Favorites folder, with aliases for
applications and directories.

Whether you use Favorites is up to you, but
the idea of collecting, organizing, and access-
ing a collection of aliases to your favorite
applications, documents, and files is one worth
pursuing. After you place items in your
Favorites folder, you can quickly launch appli-
cations, open files, or find directories by using
the Favorites link in the Sidebar or the Dock.

w(«n
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You don't have to limit yourself to only one
Favorites folder. Create a second or a third
Favorites folder and then add these folders to
your primary Favorites directory. This way you
can have subgroups of applications by use or
files by project. Many sequences of steps that
you frequently take can be expedited by using
aliases and Favorites.
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An icon is the visual representation of an item, and it
tells you a lot about the item in question. Knowing
how icons work and how to manipulate them goes a
ways toward more productively using your com-
puter. Here are some basics:

v All folders use a default icon that looks like a,
well, folder.

v Files use an icon showing what application
they're associated with.

v Applications normally use their own custom
icon.

How your computer treats icons is dictated by the
View Options panel. You can bring this up by either

»” Pressing 8-J
1 Choosing Views>Show View Options

The View Options menu controls these icon settings:

v Theicon size in pixels.

v The size of the text associated with an icon (the
item’s name).

v Where the item’s name (called the label in the
Show View Options panel) appears (underneath
or beside the icon).

v How icons are arranged on the Desktop or in a
window.

In icon view mode only, you can dictate whether
and how icons are automatically arranged. Your
options are by Name, Data Modified, Date
Created, Size, Kind, and Label.

Select the Show Icon Preview check box under
the View Options panel to have all images
represented by a thumbnail of the actual
image. This feature is nice but can slow down
your computer when you open directories
with lots of images.
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The View Options panel is also discussed in
@ Technique 12, which covers how to customize
the Finder windows.

In all likelihood, you won’t change the default icons
for your files or applications, but you could (and fre-
quently should) use new icons for your folders.
Doing so helps you more easily recognize a particu-
lar folder, whether it’s in a Finder window or the
Dock. You can create your own icons by using Adobe
Photoshop, the open source The Gimp application,
or other graphics software (see the sidebar “Making
your own icons™), or you can download free icons
that others have made. Check out these resourceful
sites:

1t You Can, Icon

v The Iconfactory: www.iconfactory.com

v InterfaceLIFT: http://interfacelift.com/
icons-mac

v ResExcellence: www.resexcellence.com

Making your own icons

If you're graphically inclined, you can make your own
custom icons without much effort. Two popular tools for
doing so are Folder Icon Maker X (http://homepage.
mac.com/niteowl69, $5) and lconBuilder Pro (www.
iconfactory.com/ib_home.asp, $69), an add-on tool
for Adobe Photoshop. A free alternative is Viou (http://
perso.wanadoo.fr/prime). We haven't used this last appli-
cation ourselves, but the price is right and it looks promising.
Also, there’s Iconographer (www.mscape.com/products/
iconographer.html, $15), a more sophisticated icon editor.

Here, though, we focus on FinderlconCM, a free contextual-
menu-based tool available at www.pixture.com/macosx.
php. By using it, you can combine two different images to
easily make a new one:

1. Download and install FinderlconCM.
2. Click an icon in the Finder to select it.

Control-click the icon to bring up the contextual
menu.

(continued)
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4. Choose Finder Icon=>Create Folder Icon.

The resulting window is where you'll be
experimenting.

8enn Create Folder Icon
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5. If you want, use the drop-down list on the left to
change the base image from a folder to an open
folder to a document to whatever.

6. Use the sliders on the right to change how the
icon looks on top of the base image.
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7. Click the Create New Folder button to make a
new folder with this icon.

Alternatively, you can click the Copy to Stock button

to make this a stock image for the FinderlconCM or

click the Copy to Clipboard button to manually paste
this icon onto another item.

8. Click Done.
For an example, we take an image of this book’s

cover and use that for the icon of the folder contain-
ing all of this book’s documents:

1. Create or find the new icon image that you
want to use.
2. Select the new icon.

A border appears around it, as shown in
Figure 17-8.
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* Figure 17-8: To change an icon, first select a replacement
image.

3. Press 31 to bring up the Get Info panel or
8-Option-I to bring up the Inspector panel
(see Figure 17-9) for the new icon.
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* Figure 17-9: Use the Get Info or Inspector panel to copy

or change an item'’s icon.

Holding down the Option key while pressing
8-l brings up the Inspector panel. It's a lot like
the standard Get Info panel except that it
changes when you select a new item in the
Finder. It's particularly handy in situations like
this (changing icons) so that you don’t need to
repeatedly invoke the Get Info command.

Click the icon in the General part of the Get
Info or Inspector panel to select it.

Press 88-C to copy the icon.

Go back to the Finder and select the item whose
icon you want to replace (see Figure 17-10).
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* Figure 17-10: Selecting the folder whose icon will be
changing.

7. Select the icon in the Get Info or Inspector
panel and press 38-V to paste in the new icon

.
(see Figure 17-11).
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* Figure 17-11: The same folder with its new image.

8. Close the Get Info or Inspector panel by click-
ing the red circle in the upper-left corner.
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To restore an item’s icon to its default: The fastest way to change icons is to use the
free FinderlconCM (www.pixture.com/
1. Select the item whose icon you want to restore. macosx. php, free) contextual menu. After you
install it, you can Control-click the icon you
2. Bring up the Get Info panel (press 3-I). like and choose Finder lcon=>Copy to copy it
3. Select the icon in the Get Info panel. to th.e.CIipb'oard. T!1en Control-click t'he item
. receiving this new icon and choose Finder
4. Press Delete to delete the icon. Icon=>Paste. FinderlconCM also lets you create

a library of icons to repeatedly use (so you can
skip the Copy step) or create a new icon by
merging two others (see the “Making your
own icons” sidebar). All in all, FinderlconCM is
great tool to use, and you can’t beat the price
(freel).
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Technique

Save Time By

v Familiarizing yourself with

useful and important than you might think. It “only” manages a list of

In this technique, we delve into the Address Book, which is much more
people and contact information, but that’s a pretty big task. More

R Rross Book importantly, the Address Book ties into the Mail application and is even
] represented in the Tiger’s new Dashboard. So using and mastering this
v Making your vCard one application is well worth your time.

v Mastering groups

v Discovering other cool G—ettinq to Know the Address BOOk

Address Book tips

The Address Book has been around since the beginning of OS X. The new
features added in Panther and Tiger make it even more useful. Those fea-
tures include

v Printing mailing labels and envelopes
Autoformatting phone numbers

Creating your own default templates for records

X Y\

Listing relations, friends, and associates for the people in your
Address Book

\

Smart Groups, for easily making dynamic groups of people

\

Recording birthdays, which can appear in an iCal calendar

If you use the Address Book a lot, make sure that you back up the
contents just in case of disaster. The Address Book database is stored
in your Home directory (in the Library/Application Support/
AddressBook folder), but you can manually back it up by choosing
File=>Back Up Address Book in the Address Book.
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Accessing your Address Book

The most obvious way to find a person’s information is to
launch the Address Book itself and search it, but that's not
the only or necessarily the fastest method. Other options
include

v Dashboard’s Address Book widget gives you access
to the pertinent information with little fanfare (see
the figure). Press the hot key (F12 by default) to
invoke Dashboard, and then make sure the Address
Book widget is visible.

Apple Computer
Inc.

maln 1-800-MY-APPLE

work 1 Infinite Loop
Cupertino CA 95014
United States

v BuddyPop (http://projects.tynsoe.org/en/
buddypop, approximately $6) creates a pop-up
window for Address Book records. You can use it to
navigate to and display records as a pop-up window
underneath the menu bar.

v QuickAddress (www.codeddays.com/quick
address, free) lets you search for a record through
an under-the-menu-bar tool. It also provides quick
access to e-mail addresses and IM names.

v iAddressX (www.mibasoft.dk/iaddressx.html,
$8) puts a menu in your menu bar through which
you can browse your contacts.

The contents of your Address Book also are automatically
available in the Mail application. When sending an e-mail to
a person in your book, you never have to go to the Address
Book first.

One good reason to use the default applications that
Apple includes with the operating system (such as
the Address Book, Mail, and iTunes) is how well they
work together. Take the Address Book, for example.
If you use it to store and manage your contacts,
you’ll appreciate how nicely it works with Mail or
with the faxing software. Most of what the Address
Book does is self-explanatory. In this technique, we
cover a few tricks and habits that you might not
know . . . but might find useful.

If you have Bluetooth and a Bluetooth-enabled
cellular phone, you can dial phone numbers
by using the Address Book (see Technique 55).

Customizing the Template

When you add contacts to your Address Book,
you're given a default template with set fields of
records that can be entered for each contact, such
as name and e-mail address. In all likelihood, these
preset fields and formats don’t adequately reflect
the information that you want to record or use. The
first thing that you should do with the Address Book
is to customize this default template.

g Taking the time once to create a default
- («a Address Book template makes adding or edit-

) ing records easier and more efficient.
However, changing the template neither
deletes nor changes any previously existing
records. The template determines only what
fields are shown for new records — not what
information can be recorded or displayed.

To customize the default Address Book application:

1. Open the Address Book application.

2. Choose Address Book- Preferences or press 8-,
(that’s a comma).

In the Preferences dialog that appears, click
the Template pane (see Figure 18-1).
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¢ Figure 18-1: The Template panel allows you to customize

4.

the Address Book’s default template.

Change any existing fields that you don’t like to
ones that you will use.

For example:

>

If you want the template to have a home
phone field by default but no work phone,
change the work phone listing by clicking the
word work next to Phone and selecting home
from the drop-down list that appears.

If you want to list a person’s spouse instead of
friend or assistant, click the word next to
Names (this is “friend” by default) and select
the appropriate alternative from the drop-
down list that appears.

If AOL Instant Messaging (AIM) isn’t the
instant messaging application that you use
most often, change it to another from the
drop-down list, as shown in Figure 18-2.

* Figure 18-2: You can access more options by clicking the

5.

6.

up and down arrows to open this drop-down
list.

Delete all the fields that you won’t be using by
default by clicking the red minus sign next to
an item to remove it.

Your Address Book records must have the
First (Name), Last (Name), Company, Image,
and Note fields. These are the only ones that
can't be deleted.

Add multiple fields of the same type by using
the green button with the plus sign on it.

If you want several phone options or e-mail list-
ings in your default template, click the green plus
button to add another field of that type. Then
select a description from the drop-down list. For
example, add another e-mail address by clicking
the green button next to Email (marked as
“home”). Then select Work, Other, or Custom
from the new field’s drop-down list.
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7. Use the drop-down list at the top of the window
to add any other fields that you want.

Use the top drop-down list, shown in Figure 18-3,
to add new fields (such as a birthday or nick-
name) or standard ones that you’'ve removed
(e-mail addresses and phone numbers).
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* Figure 18-3: Use the Add Field menu to add fields not
currently listed in the template.

8. When you finish creating the template, close
the Preferences window by clicking the Close
button or pressing 36-W.

After you finish defining the Address Book
template, go to the Phone panel, where you
can establish the default format for phone
numbers (see Figure 18-4). If you check the
Automatically Format Phone Numbers box,
those numbers that match the default format
are formatted, while others (like international
numbers) are safely left alone.
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* Figure 18-4: Use the Phone panel to set the default
format for phone numbers.

Creating Your Own vCard

The Address Book uses the vCard format, which is
the default format for personnel records. If you cre-
ate your own record in the Address Book (the appli-
cation creates a record for you automatically), you
can export the record as a vCard and e-mail it to
friends or co-workers. They can then import it into
their own contacts application whether they use
Address Book or another application, such as
Microsoft Entourage, which saves them the trouble
of typing the information.

1. Open the Address Book application.

2. Navigate to your record by choosing Card->
Go to My Card.

You can see a card in Figure 18-5.



| | Address Book

ER=1IE3a Q

Larry Uliman
= Director of Digital Media Technology
[ me DMC Insights, Inc.

(555) 555-5555

Larry Ullman® DMCInsights.com
LarryUliman®Mac.Com

wirrw, DMCInsights.com
use Jessica
Troutocity (Yahoo)
1800 Pennsyivania Avenue

‘Washington DG 11111
United States

|
| ) CEgic_ <) 7
* Figure 18-5: My default Address Book record.

] You can have more than one record for your-
B («a self (or anyone), but you can mark only one as
& your official record in the Address Book. This

way, you can make different records for per-
sonal or business purposes.

123 cards

3. Click the Edit button at the bottom of the card
panel.

You can toggle between edit and view mode
with the 38-L keyboard shortcut.

4, Edit your information, adding, changing, and
removing fields as necessary.

You can add other fields to the card by using
the Add Field option under the Card menu.

5. Add your image — if you want — by double-
clicking the image icon.
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Double-clicking the image icon in the edit mode
brings up the image panel (see Figure 18-6). With
it, you can

» Drag an image file from the Finder into the
window.

» Use an attached video camera to take a snap-
shot of yourself.

If you have a FireWire video camera con-
nected to your computer — like one you
would use for video conferencing with

iChat — your mug appears in this window.
You can capture yourself by clicking the Take
Video Snapshot button.

» Click the Choose button to navigate to and
select the image to use.

(® N Larry Ullman

Drag Image Here

i f p—

I W | Take Video Snapshot

[:Canceljl ( Set 1

p -

* Figure 18-6: The image panel lets you add a graphical or
pictorial representation of yourself to your
card.
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After you select your image, click the Set button
to apply the changes. Then you return to the
Card panel, where you can continue editing your
record.

6. When you’re done editing your record, click
the Edit button to complete the changes.

7. Choose Filec>Export vCard.
8. Save the vCard (see Figure 18-7).

You most likely want to use your name as the
name of the file (with no file extension) and save
it in your Documents directory or other sub-
folder of your Home directory.

Technique 18: Addressing Vour Addresses

(ﬁ Aae .| Address Book ]
Save As: Larry Ullman E]
Where: :_ 7 Documents ?l
l Cancel I ( Save )
In (565) 555-5555
Larry Uliman @ DMClInsights . com
| LarryUllman @Mac.Com
: www DMClnsights.com
Jessica
Troutocity {Yahoo)
1600 Pennsyivania Avenue
| ‘Washington DC 11111
| United States
| 7 |
..Lﬂ Edit 123 cards ¢ //:
* Figure 18-7: Export your vCard to your Documents
directory.

After you create your vCard, you can attach it to
e-mails so that people can add your record to their
virtual Rolodexes (whether or not they use Address
Book). In fact, adding and editing your own card is a
great way to feel comfortable with the process and
the application for when you start adding other peo-
ple’s information. If someone e-mails you a vCard,
add it to your Address Book by dragging and drop-
ping it onto the application.

Technique 34 covers the 8-Y shortcut (found
within the Mail application) that creates an
Address Book entry for the sender of the cur-
rently selected (or viewed) e-mail.

Creating and Using Groups

Every record in your Address Book can also be a
member of one or more groups. (They don’t have to
be, though; a record can be independent of all
groups.) Defining groups brings you three main
benefits:

v Better organization for finding a record

v Ability to send an entire group (like your family)
updated contact information with the click of a
button

v Ability to send e-mails to a defined set of people,
such as everyone in your department, by refer-
ring to the group name in the Mail application

You can create a group in four ways:

v Using the New Group From Selection tool
Manually

Duplicating an existing group

Y Y\

Using Tiger’s new Smart Groups feature

Hold down the Option key when you have
selected a person’s record in the Name col-
umn to see what groups that person is in.

Using the New Group From Selection tool

A quick way to create a new group is to choose
Filec>New Group From Selection.

1. Make sure you are in Cards and Columns mode
by pressing 38-1 (see Figure 18-8).

Address Book supports three modes (all avail-
able through the View menu): Cards and
Columns, Card Only, and Directories. Cards and
Columns is the best for creating groups.



enNne . | Address Book
O] - Q
Group Name
il Al | Becky Abbott . Apple Computer Inc.
H\ Directories [Z]Jon Alba
" Books |+ | Michael Alba
i sucdy
I Family || Marjorie Baer
I Me || Gary Beeler 1-800-MY-APPLE
NFL || Isabel Beeler
L PHP | Karen Beeler gt BRGiR.com
I Sports Pools *| [ Brenda Benner 1 Infinite Loop
Wark [ ] Paul Bondy Cupertino CA 85014
[ | Bruce Bowden United States
(| Angela Brown
[ ] Jim Bruce
| Leah Cameron
|| Beth Campbell
|| Roger Carpentier
|| David Chapple
[ | Brian Chilton
3] |_Edit | 123 cards %

* Figure 18-8: Address Book’s Cards and Columns mode.

2. Click the All option under Group to display
every record.

3. &-click the names listed in the Name column to
select the group members.

4. Choose File>"New Group From Selection (see
Figure 18-9).

A new group is created in the Group column.
This new group’s name (“Group Name” by
default) is highlighted, ready for you to type the

new name.
New Card HN
New Group {r3EN

.. New Group From Selection

New Smart Group... N
Close BW
Import B
Export vCard...
Back up Address Book...
Revert to Address Book Backup...
Subscribe to Address Book...
Send Updates...
Print... 8P

* Figure 18-9: The New Group From Selection option eases
the group creation process.

Creating and Using Groups

5. Enter the new group’s name.

6. Press Return to complete the transaction.

Creating a group manually

To create a group manually:

1. Make sure that you're in Cards and Columns
view mode; choose it from the View menu or
press 88-1.

2. Click the plus sign in the lower-left corner to
create a new group.

3. Type the new group’s name in the new, high-
lighted field that appears (see Figure 18-10).
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ene Address Book
o I - Q

Group Namo
Can
[ Directories
I Books
7 Buddy
Family
| Group Name
I Me
NFL
PHP
I Sports Pools
I Work

No Card Selected

& e

* Figure 18-10: When you add a new group, it’s given a
default name that you can easily change.

4. Search or browse through the Address Book
names, adding people to the new group by
dragging their cards onto the group name.

To delete a group member, select the mem-
ber’s name from under the Group listing and
then press Delete. Press Return at the prompt
that appears (see Figure 18-11) to remove the
user only from this group (not from the whole
Address Book).
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Do you want to delete “Marc Liyanage” or simply
remove it from the group “Group Name"?

':_.E'_.,.‘ {_ Cancel ) i Delete ) E— Remave-ﬁorrr(-}mup')

* Figure 18-11: When you delete a user from a group, you
have to clarify your intentions.

Duplicating an existing group

If you want to create a new group that contains some
of the members of an existing group (like the imme-
diate family subset of your extended family group),
you might want to simply duplicate the existing
group and edit members accordingly. Here’s how:

1. Select the existing group in the Group listing
(the left column).

Choose Edit=>Copy or press 8-C.

Choose Edit->Paste or press 8-V to create a
copy of that group.

N WN

Rename the new group (called Old Group
Name copy) by double-clicking the group’s
name.

5. Edit the group’s members by using the steps
outlined in the preceding section.

Creating Smart Groups

Tiger has an entirely new way to create a group in
the Address Book: Smart Groups. They’re much like
the Finder’s Smart Folders, iPhoto’s Smart Albums,
or iTunes’ Smart Playlists. (Tiger is one smart
cookie.)

To create a Smart Group:

1. Choose Filec>"New Smart Group.

You can also Option-click the plus sign in the
lower-left corner of the Cards and Columns view.

2. In the resulting prompt, give the group a name
(see Figure 18-12).

Smart Group Name: Familv‘

Contains cards which match the following:

“Card 3 ] contains -3 ]

(+)

(2) @ Highlight group when updated (Cancel ) ( OK

¢ Figure 18-12: The smart group prompt.

3. Create as many conditions as you need to limit
your search (as shown in Figure 18-13).

Use the two drop-down lists and the text box to
add a condition, and then click the plus sign if
you want to add another condition.

Conditions can be based on virtually any piece of
address book information, including the person’s
name, the company for which she works, when
her birthday is, or in which state she resides.

Smart Group Name: Family

Contains cards which match Wany Tﬂ of the following conditions:

Name FH is %) uiiman

T' Dxmani

() (1)
= @&

“Name Tl is

‘.. Cancel ',\ —oBK—)

‘.:;\! ™ Highlight group when updated

* Figure 18-13: The conditions you create dictate what
people are in your Smart Group.

With multiple criteria, another drop-down list
appears, giving you the option to require any
or all of the criteria. If you select a/l, each con-
dition makes your search narrower. If you
select any, each condition makes your search
broader.

4. Click OK when you're ready to create the smart
group.

The Smart Group creates two groups of every
record that matches your conditions. Both
groups have the same name:

» A normal group with a normal icon

» A smart group (with the special smart group
icon) at the bottom of the group list (as
shown in Figure 18-14)



enNne . | Address Book
A E S Q,
Group | Name
Can (| Gary Beeler Larry Uliman
[ irectories [ | Isabel Beeler @5 Director of Digital Media Technology
I Books [ | Karen Beeler [me] DMG Insights, Inc
I Buddy || Brian Chilton
I Family ] Mark Chilton
i~ Group Name | Gina Currall (555) 555.5855
Me [ | Jessica Currall Ly Ulman@OMGInsioh
arryUliman: nsights.com
I NFL L] Darcy Ullman Larry Uliman@Mac Com
I PHP *| || David Ullman
Sports Pools I | Kay Uliman o www, DMCInsights.com
I Work Larry Ullman
JEITITR | [ Margaret Ullman Josera
] Michael Ullman Troutosty (Yahoo)
1800 Pennsylvania Avenue
Wiashingten DG 11111
United States
Edit 13 cards >

* Figure 18-14: Two Family groups are created: one normal
and one smart.

5. To edit the members of the group manually, use
the plain group.

Click the normal group’s icon and you can delete
and add records as you would any other group.

Deleting a record from the Smart Group
6 itself — the one with the special Smart Group
icon — deletes that record from the entire

Address Book. Deleting a record from the
plain group (the one created by the Smart
Group) is safe.

6. To edit the Smart Group criteria, Option-double-
click the smart icon and reuse the prompt.

) Because Smart Groups are so amazingly
(«a smart, they automatically update themselves
as your address book data changes. For exam-
ple, if your friend marries your brother and
you change her last name in Address Book,
her record is added to the Family group. If you
later add another person’s record (like when
your uncle finally gets a computer), that record
also is added to the group, if the Smart
Group’s conditions are met.

&

7. After changing a Smart Group’s conditions,
update the normal group by copying the con-
tents of the Smart Group into the plain group.

Other Cool Address Book Tricks
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Other Cool Address Book Tricks

Apple put a lot of thought into the Address Book,
and it has its fair share of cool tricks. Here are the
ones that you should know, in case you don’t:

v If you change your contact information, use the
Send Updates option (under the File menu) to
automatically e-mail your new information to
others. By selecting among the groups you have
already created, you can notify your friends and
family every time you move or change Internet
providers.

v Click the address link for a home page to go to
that site.

v Click the caption next to a person’s e-mail
address to open a contextual menu so that you
can send the person an e-mail (see Figure 18-15).

s lals) | | Address Book

EF=I'E-32 Q

Larry Ullman

=hat Director of Digital Media Technology

[me| DMC Insights, Inc.
{5565) A55-5555
s
d Send Email
th
L

Perform search with Spotlight
vd
e —

1800 Pennsylania Avenue
Washington DG 11111
United States
|_Edit | 122 cards (a]»] #

* Figure 18-15: The contextual menu for e-mail addresses.
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v C(lick the caption next to a person’s phone num-
ber to see it in large type.

v Add a phonetic field to records to remind your-
self how a name is pronounced. (It’s up to you to
master the International Phonetic Alphabet.)

v Click the caption next to an address to be given
the option of seeing a map for that address via

MapQuest.
v Print labels or envelopes by pressing 88-P when
you have one or more cards selected (see —— . coone 16
Figure 18-16). @ (o) (e 08.) (Adncnd Ok (Gt @D

¢ Figure 18-16: Address envelopes (including both the to
and from addresses) directly from the
Address Book.
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Save Time By
+* Using Stickies

v~ Putting stuff on the
Dashboard

v Making the most of
StickyBrain

can use to manage your miscellaneous information. You probably

already use Microsoft Office for word processing and spreadsheets,
and maybe you use iPhoto for your images, but where do you store that
important note or that quote you liked? Instead of writing this stuff down
and throwing it in a desk drawer where it’s never seen again, use the
tools that we cover here.

In this technique, we delve into just a few of the applications that you

The first application we discuss is Stickies, which has been around in
Mac OS X for a while now. Then we move on to the Dashboard’s own ver-
sion of Stickies. After that, we look into a commercial product called
StickyBrain. Finally, we list a few scrapbook-like applications that you can
use to manage and organize sporadic bits of information, create to-do
lists, make outlines, and so forth.

Storing Information as a Sticky Note

If you aren’t already using Stickies — an Apple application that comes
with Tiger — you’re missing out on a useful little tool for storing little tid-
bits of info. Stickies creates small text files with sticky note-like behavior.
Unlike using TextEdit, with Stickies you can create color-coded notes,
quickly make a note by using Services (see Technique 29), and keep a
note at the front of your screen while you’re using another application.

Some good Stickies tips include the following:

v In the Finder and any Cocoa application (such as Mail, Safari, TextEdit,
and the Address Book), create a new sticky note out of highlighted text
by pressing 88-Shift-Y.

v Change a note’s formatting based upon its purpose or category. You
can use many colors for your sticky notes, and you can change both
the note background and the font color. Use different colored sticky
notes for different purposes (even though Figure 19-1 is in grayscale,
you get the idea). You can change a note’s color by using the Color
menu, and you can alter the fonts by using the Font menu or the Font
palette (which you can access by pressing $-T).



152

Technique 19: Managing Information Effectively

Welcome to Stickies for Mac 05 X

What you can do with Stickies

‘The Mac 08 X version of Stickies has these improvements

This is my
default color for
WORK notes.

¢ Figure 19-1: You can assign colors to sticky notes to help
you remember whether they're personal,
work related, and so forth.

v When you find a note color and style that you
like, choose Noter>Use as Default option under
the Note menu. Then, when you create a new
note, it will automatically be formatted in your
preferred style (existing notes will not be
affected).

v Check the spelling in a note from the contextual
menu (Control-click a note) or choose Edit=>
Spelling.

v Stickies supports Services (see Technique 29),
meaning that you can access many different
shortcuts from within the Stickies application.
You can also interact with Stickies from other
applications that support Services, like Mail (see
Figure 19-2).

v Have a sticky note float above other applications
by clicking it and pressing 3-Shift-F or choosing
Floating Window from the Note menu. A floating

sticky note is never hidden by other applications:

It always appears at the “front” of the screen.

v Stickies can store more than just text. You can
also put images, videos, and sounds in them.
This capability makes Stickies much like the
long-gone Scrapbook application.

About Mail

Preferences... 3,

BBEdt

ChineseTextConverter
Hide Mail #H

! — CleverKeys
Hide Others "C3#H Disk Utility
Show All

Finder
Quit Mail ®q @ fFire

Font Book
Grab

YyYVYyVYYYYYY

Mail

Make New Sticky Note {ragY
Open URL

Open URL in RealPlayer

Script Editor >
Search With Coogle

Send File To Bluetooth Device...
Speech >
Spotlight

Summarize

TextEdit >

v

¢ Figure 19-2: Services provide quick access to common
tasks.

Stickies Lite: Using Dashboard

Dashboard, the widget-running tool that’s associated
with Exposé, has its own version of Stickies. The
main advantage of Dashboard Stickies is that you
can invoke it no matter what you’re currently doing.

However, Dashboard Stickies isn’t as feature-rich as
Stickies proper. A Dashboard sticky note

v Isn’t accessible via Services or the Make New
Sticky Note keyboard shortcut.

v Lacks a spell checker.

\

Has fewer font options.

v Can't float so that it’s available while working in
other applications.

But if these aren’t features you use or need, and
if what you really want is instantaneous access,

Dashboard is the tool for you. Here’s how to use
Dashboard Stickies:



1. Open Dashboard by pressing F12 or by using
an assigned hot corner.
You can set the keys and hot corners for
Dashboard in the Dashboard & Exposé System
Preferences panel. F12 is the Dashboard short-
cut by default. See Technique 15 for more.

2. Click the Stickies icon to create a new note (see
Figure 19-3).

* Figure 19-3: Create a new sticky note by using the
Dashboard control bar.

3. Type your text. (You probably could have figured
that out.)

Click the circle arrow in the lower-right corner
for formatting options (see Figure 19-4).

Paper Color:

vE § § § |
Font:

¥ Marker Felt
Helvetica Neue
Lucida CGrande
Futura
Optima
Gill 5ans
Baskerville
American Typewriter

Done

¢ Figure 19-4: The (somewhat limited) formatting options
for a Dashboard sticky note.

4. Click the Stickies icon again to create a new note.

5. Use the same keyboard shortcut (F12) or hot
corner to hide Dashboard.

You can click any non-Dashboard window, use
the Dock, or invoke the application switcher to
leave Dashboard.
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Stickies Pro: Using StickyBrain

Stickies Pro: Using StickyBrain

If you like Stickies, you'll really like StickyBrain, from
Chronos (www.chronosnet.com, $40). StickyBrain
takes the idea behind Stickies and turns it into a full-
fledged, potent application.

StickyBrain has basic sticky notes plus the following
enhancements:
v Calendars
To-do lists
Built-in templates and reference notes

Contextual menu and Services support

A W W WA

The ability to search through your notes to find
specific text

Chronos has released version 3 of this application,
which features
v A Mail-like interface (see Figure 19-5)
Integration with .Mac
Tabbed note viewing (like tabbed Web browsing)

v
.

v Faster searching
v iPod synchronization
v

The ability to search your sticky notes by using a
menu bar prompt

G Teckyban - AR Hoort =

+||e-

¢ Figure 19-5: StickyBrain’s main viewer window looks and
behaves a lot like the Mail application.
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Here are a few tips if you use StickyBrain:

1V

Keep your notes organized into appropriate fold-
ers (refer to Figure 19-5).

Choose a note category from the Library panel to
limit your searches to only those notes.

Use the StickyBrain Services in applications that
support Services. The StickyBrain Services allow
you to quickly generate specific types of notes
(see Figure 19-6).

Use the StickyBrain contextual menus in applica-
tions that don’t support Services.

Customize the main viewer toolbar, as you would
a Finder window.

.Mac members receive a free version of
StickyBrain 2! This is one of the many benefits
that come with your $100 membership. Check
out Technique 42 for more details.

Technique 19: Managing Information Effectively

About Safari
Report Bugs to Apple

Preferences ,
¥ Block Pop-Up Windows XK

Reser Safari..

Empry Cache. HE
[SSevces T >
Clevirkays *
Hide Safari xH Fidar i
Hide Others xxHl pe 5
Show all Crab »
Quit Safari ®a |
Mail >
Make New Sticky Note ™Y
Open URL
Opéen URL In RealPlayer
seript Editor »
Search with Google XL
Send File To Bluetooth Device... O XEB
Speech 3
StickyBrain > |

StickyBrain Grab To

Summarize
TextEdit
View In JavaBrowser %)

“New Note” in CALENDAR

“New Note” in FRIENDS

“Niw Note” in MISCELLANEOUS
“Mow Note” in PASSWORDS 3 U0
“New Note” in PERSONAL

“New Note” in RECEIFTS 3¢AC
“New Note® in TASKS

“New Note” in TEMPLATES

“New Note® in UNFILED  %X.C
“New Note” in WORK RELATED

¢ Figure 19-6: StickyBrain installs a number of great

Services.
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Technique

Save Time By

v Comprehending how
Tiger treats files

v Working with the Get Info
panel

+* Troubleshooting common
file problems

it, how to file it, and what to do with all the things that fill up a

computer. In this technique, we talk about files (as opposed to fold-
ers or applications) and Tiger. We should, therefore, talk a little bit about
how the operating system treats your stuff. Being able to comprehend
and make the most of this relationship (between the operating system
and your files) goes a long way toward being able to use your computer
more effectively.

This, the third part of the book, is all about your stuff: where to put

We begin by discussing a file’s properties. This includes Tiger’s naming
conventions, locking files, adding comments, and more. We conclude
with how to solve some common file problems that most users
encounter eventually. In the process, we get a little technical but not
overwhelmingly so. After all, the benefit of owning a Mac is that you
don’t need to be a rocket scientist to use it.

Understanding a File’s Properties

The files on your computer have many properties, such as name, exten-
sion, size, and type. You’ll work with filenames more than any other prop-
erty, but understanding and manipulating the other file properties
effectively is also important. Doing so can make the time that you spend
on your computer more efficient and secure.

Most of a file’s properties can be parameters for advanced searches
(see Technique 21).

You can discern some file properties, such as name, extension, size

(depending on how the window is customized), type, and default opening

application, just by looking at the file in the Finder (see Figure 20-1).
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* Figure 20-1: You can tell a lot about a file just by looking
at its name and icon in the Finder.

These and other properties are viewable and editable
in the Get Info panel. If you aren’t familiar with this
panel, it’s about time to become so. After you select a
file, you can bring up the Get Info panel by

v Control-clicking and choosing Get Info from the
contextual menu.

v Pressing 8-

v (Choosing File=>Get Info.

Hold down the Option key while using one of
these methods to open an Inspector panel. It's
almost exactly like the standard Get Info panel
except that it changes to represent the cur-
rently selected item. The standard Get Info
panel stays focused on the originally selected
item.

We discuss the Get Info panel extensively in this
technique (and you use it often in day-to-day Tiger
usage), so you really should get to know your way
around it. In this technique, we go through its sub-
parts and how they relate to you and your stuff.
Note that each item on the Get Info panel has a right-
pointing arrow next to it: Click that arrow to expand
its section and see more information, as shown in
Figure 20-2.

® O & tiger_fd.jpg Info
- tiger_fd.jpg
Modified: Today at 17:30

p Spotlight Comments:

80 KB

¥ General:

Kind: JPEC Image
Size: 80 KB on disk (75'160 bytes)
Where: [Users/livanage/Desktop
Created; Today at 17:29
Modified: Today at 17:30

Colorlzbel: (x| ®# @ © @ @ & @

£ Stationery Pad
[ Locked

P More Info:

B Name & Extension:

P Open with:

P Preview:

P Ownership & Permissions:

* Figure 20-2: Most of the Get Info panel’s subparts are
hidden until you expand them.

The General panel

The General panel shows you the basics, almost all
of which can appear in the list view mode of the
Finder window. The only three things that you can
change here are

v Stationery Pad: If you select the Stationery Pad
check box, the currently selected file becomes a
template with its own special icon (see Figure
20-3). When you open a Stationery Pad file, Tiger
creates and opens a copy of it, allowing you to
work with the copy without altering the original.



LTI,

(U E LR BTV O

USRS (A

* Figure 20-3: Template files use a slight modification of
the default file type.

v Locked: If you enable the Locked check box, the
file is safeguarded against changes or incidental
deletions. A locked file’s icon features a small
padlock (see the bottom file icon in Figure 20-4).
Locked files can be opened but not deleted nor
altered.

Lock a file to protect it from being changed or
removed.

v Label: New to Tiger is the ability to change an
item'’s Label by using the Get Info panel.
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——
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The locked icon

* Figure 20-4: Locked files have a little padlock on their
icons.

The More Info panel

Tiger introduces the More Info section (see Figure
20-5). Although there’s nothing for you to change
here, it can be very useful. Depending on the item
you’ve selected, the More Info panel might display
the following:

v The last time the item was opened

v Animage’s size in pixels (see Figure 20-5)

v The original source of a downloaded file (see
Figure 20-6)

v Copyright information (for applications)



75 8 Technique 20: Working with Files
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Modified: Today at 17:30 Modified: Sonntag, 19. Dezember 2004
; 05:06
Colorfabel: (%| @ @ 0 @ @ & &
Colorlabel: (x| @ @ O @ @ @ @

D Stationery Pad
M

"] Stationery Pad
Locked ) Locked
¥ More Info: ¥ Mare Info:
Dimensions: 100 112 Where from: http://homepage.mac.com/
Color space: RGB pixture/software [ficm-24.sit,
Profile name: Colormatch Wiley hitp:ff -blature.cora)

L d: Tod 17:30 macosx.php
e i : Last cpened: Today at 18:13

b Name & Extension: p Name & Extension:

b Open with: P Open with:
B Preview: B Preview:
B Ownership & Permissions: 4 P Ownership & Permissions: ’_,_
* Figure 20-5: The new More Info panel is below the ¢ Figure 20-6: Quickly find the origin of a downloaded file
General panel. by using the More Info section.
The Name & Extension panel 000 tiger_fd.jpg Info
You likely know what a file’s name is and what it tiger_fd.jpg B0 KB
means. (If you don’t, perhaps it’s time you pick up Modified: Today at 17:30

Bob Levitus’s Mac OS X Tiger For Dummies, Wiley
Publishing, Inc.) You can change a file’s name by S Coneral:

these three methods:
P More Info:
v Click the filename (not the icon but the actual W N5 Extensson:
filename) in the Finder and type the new name. tiger_fd.jpg
v Select the item, press Return, and type the new [] Hide extension
name. P Open with:
v Type the new name in the Name & Extension text B Preview:

box of the Get Info panel (see Figure 20-7).

P Ownership & Permissions:

* Figure 20-7: The Name & Extension section of a file’s Get
Info panel.




Tiger has very few rules for how to name a file, and
here they are:

v Filenames shouldn’t begin with a period.
Filenames can’t contain a semicolon.

Filenames shouldn’t contain a slash.

X Y\

The maximum filename length is 255 characters,
although you might not be able to see a filename
this large under many conditions.

\

Two files within the same directory can’t have
the same name.

Strangely enough, you can change the name
or even the location of a file without disrupt-
ing the Recent Documents listing in the Finder
and applications. This is because the operating
system uses a different method of referring to
files rather than the more obvious name and
location.

Although a file’s extension is an issue that has been
mostly hidden from Mac users over the years, it’s
critical for many reasons. The file’s extension (and
kind, which is related) dictates what application is
used by default to open it. (See “The Open With
panel” section.) You can change a file’s extension by

v C(Changing the file’s name in the Finder, if the
extension is also shown

Hide or show a file’s extension by checking
the appropriate box in the Name & Extension
panel (refer to Figure 20-7).

v Typing the filename and its new extension in the
Name & Extension section of the Get Info panel

When you change a file’s extension, Tiger displays a
prompt (see Figure 20-8) confirming whether you
truly want to make this change because it affects
what application opens it. Unfortunately, you can’t
avoid this prompt — Tiger is trying to behave in
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your best interest. Most commonly, you might
change the extensions on text files, Web pages, and
downloaded files. Doing so isn’t really a problem —
primarily it just affects what application opens the
file by default — and you can also change the file’s
extension back, if necessary.

Are you sure you want to change the extension
from “.jpg" to ".gif"?

u L If you make this change, your document may open in a
different application.

(" Use .gif b F—Keepv—_rpg-—-)

* Figure 20-8: Before you can change a file’s extension,
you must confirm the action through this
prompt.

The Open With panel

The Open With panel shows you what application
opens a file by default. The drop-down list also
allows you to change this setting for a particular file.
The Change All button lets you enact the change for
every file of this type. See Technique 25 for more
techniques for opening files.

The Preview panel

The Preview panel, as you might expect, shows you
a preview of the file. For many file types (such as
text files, spreadsheets, and Web pages), you see
only the file’s icon. For image file types, this panel
shows a thumbnail of the image itself (see Figure
20-9). With movies and sound files, you can actually
play them by clicking the Play button of the preview
(the right-pointing triangle, Figure 20-10).

The Preview panel of the Get Info panel is
replicated by the column view mode of a
Finder window, where the final column is used
for the preview.
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8.60.6 tiger_fd.jpa Info

tiger_fd.jpg 80 KB
Modified: Today at 17:30

» Spotlight Comments:

B General:

B More Info:

P Name &-l Extension:
B Open with:

¥ Preview:

. e hot e ol
Mac OS X Tiger

Timesaving Techniques

DUMMIES

B Ownership & Permissions:

* Figure 20-9: The preview of an image file.

@ T O 04 New Slang.m4a Info

¥ General:

4] 04 New S5lang.m4a
(MPECY
Kind: MPEG-4 Audio File
Size: 104 KB on disk (100,710 bytes)
Where: [Users/larryullman/Desktop
Created: Saturday, October 2, 2004 12:54
PM
Modified: Saturday, October 2, 2004 12:55
PM

Color label: |x| @ @ @@

[ Stationery Pad
[ Locked

P More Info:

b Name & Extension:

P Open with:

W Preview:
[ T ———————Ta

P Ownership & Permissions:

b Comments:

P Comments:

* Figure 20-10: The preview of an MPEG or MP3 allows
you to play the sound file.

The Ownership & Permissions panel

The Ownership & Permissions panel of the Get Info
panel is its most complex panel because it’s based
on a UNIX concept. (See the “UNIX permissions”
sidebar if you really want to know more.) The first
rule for this area is to leave it alone unless you really
know what you’re doing.

Permissions are a sticky subject. Toying with
them without fully understanding the ramifica-
tions can affect the security and operability of

your system.

UNIX permissions

The UNIX operating systems have an elaborate set of per-
missions for files and folders based on who owns a file and
who can do what with it. The first issue you can control is
the specific user and group that owns a file.

By default, the owner of a file is whoever created it — in
Tiger, that means your short username for most of your
stuff. Permissions are also based on groups. Again, by
default, this is the group that the owner is a member of. Of
course, a user can be part of many different groups, too, in
which case one of those groups will be used.

The UNIX command for changing an owner — which must
be entered by using the Terminal — is

chown owner filename

Of course, you need to be an administrative-level user to
do this. To change the group, you use either of the follow-
ing commands:

chgrp group filename
chown owner:group filename

The second controllable file permissions issue is who can do
what with the file. The options are read, write, and execute (for
a file) or search (for a directory). Each of these options can be
specified for the owner, for the group, or for everyone. The
options for a specific file are represented in the Terminal by a
string of eight letters, as shown in the figure here. Starting from
the left, the first letter represents owner write, and the string is
read across in the following order: read, execute; group write,
read, execute; and everyone write, read, execute. A w means
writable, - means readable, and x means executable/search-
able. A dash means that the permission isn’t granted, and an
initial d indicates that the file is actually a directory.



In the figure, for example, the file 558129 ch20.doc has
read permissions for everyone and write permissions for
larry. The owneris Tarry, who is part of the group Tarry.

806 Terminal — bash (ttyp1)

Larry-U | Lmans-Computer: /Docunent s/Baoks/05 X TT for Dummies/Part 3/Ch 17 lorryd ls -al 5
total 184
druxr=xr-x 6 larry larry 204 T Oot 16:48 .

druxr-zr-x 12 larey  larry 408 38 Sep 11:55 ..

~pwmp-p-= 1 larry larry 6148 24 Sep 17:31 .D5_Stere

~rusp=-r== 1 larry larry 36864 7 Oct 16:86 556129 ch1? copy.doc

~Pump=-p-= 1 larry larry 39936 7 Oct 16:48 558129 chl?.dec 4
druxr-xr-x 3 larry lorry 182 24 Sep 17:28 flgures v
Larry=Ul Lmans-Computer: */Docunent s/Backs/05 X TT for Dummies/Fart 3/Ch 17 larry}

Assuming that you have the permission to do so, you can
change permissions by using chmod. The syntax is

chmod permissions file

The permissions are assigned by using a three-digit num-
ber (although they can also be adjusted by using an alpha-
betic system). The first of the three numbers represents the
owner’s permission, the second is the group, and the third
is everyone else (others). Each nhumber is made by adding
up the write permissions (worth 4), read permissions (2),
and search/execute permissions (1). A file with 777 permis-
sions is writable, readable, and executable by everyone. To
give yourself write and read permissions and everyone else
just read permissions on a file, use

chmod 622 filename

For more information on any of these tools, type man
chmod, man chgrp, or man chown in the Terminal.

The Spotlight Comments panel

Adding comments to files, folders, and applications
has been part of the Mac operating system for years,
although most people don’t use them much. Tiger
has two features that can make them more useful:
finding files by words in their comments with
Spotlight and showing comments in a Finder win-
dow. As an example:

Select the file in the Finder.

Press 81 to bring up the Get Info panel.

1

2.

3. Click the arrow for the Comments box if it isn’t
currently pointing down.

4.

In the box, type any comments that you want to

add (see Figure 20-11).
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8008 tiger_fd.jpg Info
! tiger_fd.jpg 80 KB
Modified: Today at 17:30
¥ Spotlight Comments:

Tiger TST For Dummies Cover Page

p General:

P More Info:

B Name & Extension:
P Open with:

B Preview:

B Ownership & Permissions:

¢ Figure 20-11: Add comments to a file by using the Get
Info panel.

“

Close the panel by clicking the red Close but-
ton in the upper-left corner.

N

Set your window to list view by clicking the
icon in the toolbar or by pressing 3-1.

N

Customize the window settings by choosing
Viewr>Show View Options or by pressing 36-J.

In the list of options, enable the Comments
check box.

© ®

Close the View Options panel by pressing $8-J
or clicking the red Close button.

You should now see your comments in the
Finder window (see Figure 20-12).

8686 [ Desktop (=)
T Name Y| Size  Comments |-
A 04 New Slang.m4a 5.2 MB =
2 dashboardsdktiger8a294.dmg 10.6 MB -
» | Downloads 12.3 MB =
ficm-22.sit 536 KB = —
a FinderlconCM.dmg 540 KB -
; Larry Ullman's PowerBook G4 496 KB -
» I Tiger TST For Dummies 52 KB For stering all of this book's documents.
B tiger_fd.jpg 104 KB S
5 trout.jpg 84 KB -
» B untitied 48 KB o

* Figure 20-12: With Tiger, you can show comments in the
list view mode.

@ You can use comments to remind yourself of
e- { <@ the purpose or contents of a file. If a comment
& is too long to view in the window, hover your

cursor over it to view the whole thing in a
pop-up window.



162

Technique 20: Working with Files

Finding out about files via shareware

If you really, really get into manipulating a file’s properties
(you know who you are), check out these shareware appli-
cations to facilitate the process:

v Bare Bones's Super Get Info (www.barebones. com,
$20) makes altering a file’s type (or kind) easier. It also
lets you work with invisible files and empty the Trash
even when the Finder says you can't.

v piDog Software’s InfoDog (www.pidog.com/infodog,
$10 suggested) is similar to Super Get Info but also has
a file browser built into it.

v Marc likes File Buddy (www.skytag.com/filebuddy,
$40), which is like a Get Info tool and file utility all in
one. It not only helps you manage individual files but
also provides system-wide features and troubleshooting
techniques.

Solving Common File Problems

You likely won’t have too many problems when
dealing with files in your operating system, but they
will occur occasionally. Here’s your file-specific
troubleshooting guide:

You'll minimize some problems by using the
Repair Disk Permissions tool in the Disk Utility.
Run this monthly on the hard drive that con-
tains the operating system for smoother sailing.

Deleting locked files

As a security feature, locked files can’t be trashed.
There is absolutely no keyboard shortcut to over-
ride this. The only way to delete a locked file is to
unlock it first.

Select the file in the Finder.

-

Press 8-1 to bring up the Get Info panel.

Deselect the Locked check box to unlock it.

NWwN

Close the panel by clicking the red Close but-
ton in the upper-left corner.

4. Go ahead and delete the file as you normally
would.

If you don’t want to see the confirmation
prompt every time you go to empty the Trash,
disable the Show Warning Before Emptying
the Trash check box under the Finder’s
Advanced preferences.

Ejecting stuck disk images

A somewhat common occurrence is that you can’t
eject a disk image (whether a mounted hard drive, a
CD-ROM, or whatever). This usually happens because
Tiger thinks that the disk is currently in use. Even if
you promise Tiger that it isn’t, your options are lim-
ited. Here are three good ways of solving the problem:

v Quit all open applications and try again.

v Log out and log back in by using the Apple menu
or by pressing 38-Shift-Q (but not by using Fast
User Switching).

v Ignore the problem for now. The next time you
reboot, you'll be able to eject the image without
issue.

A file can’t be deleted if it's currently in use.
This is almost always because the application
that the file was being used in is still running
(and the file itself might still be open). Close
the file and application and try again.

Finding the original for an alias

If Tiger can’t find the original file that an alias refers
to, it gives you a prompt (see Figure 20-13) with
three options:

The alias "MyFolder” could not be opened, because
the original item cannot be found.

4

( Fix Alias... ) 0K )

(_ Delete Alias '_,I

¢ Figure 20-13: The error prompt for when Tiger can't find
an alias’s original file.



v Delete Alias: Obviously, this option gets rid of
the alias, which fixes the problem.

v Fix Alias: If you select what’s behind door num-
ber two, you are presented with a window (see
Figure 20-14) so that you can select a new origi-
nal for this alias.

06 Select New Original
Choose the item that you want alias “MyFolder” to open.
[=|m " | Documents F4) Q search

@ iDisk 1 & [ Deskwop >

Network
| Hard Drive | & Library !
@ larryuliman s Movies !
» & Music [
A Applications -l Pictures [
[ Utilities 1 # Public !
4 larryuliman P Shtes L
& Favorites
g Desktop
[y Documents
% Pictures < Ul Il . n
( Mew Folder ) ( Cancel ) )

y;

* Figure 20-14: You can use this dialog to navigate to the
file an alias should point to.

v OK: If you click OK or press Return, nothing
happens.

You can also select a new original for an alias
(whether there’s a problem with it or not) by
clicking the Select New Original button under
the Get Info’s General panel (see Figure 20-15).

Sharing files with another 0S

This technique isn’t really a problem-solver for Mac
users — because Tiger is such a great operating
system — but rather for those less fortunate souls
not running Mac OS X. While sharing files on other
operating systems (whether through a network or a
disc), you can ease potential conflicts by abiding by
these rules:
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v Use filenames that are shorter than 32 charac-
ters in length.

v Stick to alphanumeric characters in a filename.

v Avoid using spaces in the filename. (Hint: Use an
underscore instead.)

v Keep the file’s extension as part of the filename.

] The last point is important because many oper-
B> (@

ating systems used to or still do rely on a file’s
extension to know what application should be
used to open it.

&

866

U‘-’-‘f""" MyFolder 4 KB
= Modified: Today at 21:15

A

P Spotlight Comments:

¥ General:
Kind: Alias
Size: 4 KB on disk (782 bytes)
Where: /Users/liyanage/Desktop
Created: Today at 21;15
Modified: Today at 21:15

MyFolder Info

Original: fUsers/fliyanage /Desktop/
Timesaving Technigues Tiger

Colorlabel: (x| @ @ 0 @ @ @ @

{ select New Original. .. L]

[} Locked

B More Info:
P Name & Extension:

P Preview:

P Ownership & Permissions:

* Figure 20-15: You can change the original for an alias by
pulling up the Get Info panel while the alias
is selected.



Finding Things
in Tiger

Technique

Save Time By

v~ Finding files in a Finder
window

v~ Finding files with Find
v Making Smart Folders

v Finding stuff with
Spotlight

¢ Figure 21-1: The Finder
window Search
box.

of things you stay, you inevitably go looking for something that

you just can’t find. Old-school Mac users might be familiar with
Sherlock (the file detective), and Panther users should know about the
Find tool, but Tiger has taken looking for stuff to a whole new level.
Tiger has done away with Sherlock and incorporated the Finder’s Find
utility into a Finder window. On top of this, Tiger has added the truly
amazing Spotlight utility and the ability to save searches as Smart
Folders.

Regardless of how well you organize your stuff and how on top

The most frequently used search method is the Search box, present in
the Finder windows. This is an easy and fast way to locate what you
need. On a more advanced level, you can use the Finder’s Find tool,
which is an extension of the basic Finder window search. From there we
unfold Smart Folders, which are saved searches, like Smart Playlists in
iTunes. Next we introduce our latest love, Spotlight. Spotlight is to
searching what the Great Wall of China is to decorative lawn edging.

Basic Finder Window Searches

For simple searches, you can’t beat the Finder windows. Although the
search capability has been part of the Finder window for some time,
Tiger has added some new features. The Search box, by default, appears
in the upper-right corner of the Finder window (see Figure 21-1).

8086 A larryuliman -

® isk =

| . o i
M Network E | - | ﬂ
4 panther gk Documents Library
3 Tiger esktop
O swif

o | o | =1
Tropico MM - Disk 2 £ | J,,, J,é . :,L‘J

Movies Music Pictures
A Applications

£ larryullman i
—
3 Desktop | @

" Pictures

Public Sites

[—ﬂ 0S X Tiger TT for Dummies

8 items, 12.48 GB available 7




Use the Search box to perform a case-insensitive
search on the names of the folders, files, and appli-
cations located on your hard drives. The Finder win-
dow search turns up any match found anywhere in a
name. For example, searching for cat brings up files
such as Catalog.pdf, subcat.php, or Pictures of My
Cats. Even better, the search returns documents with
the word cat (or variations of it) in them!

If you can't see the Search box because the
window is too narrow — but you know it’s
there — click the double right-facing arrows

in the upper-right corner and then choose
Search from the menu that appears (see

Figure 21-2).
lalala) @ larryullman -
= = i@ G
EEos] e B @
@ iDisk
‘9 Network
=4 Panther E
= Tiger | |
=4 st e Desktop
(% Tropico MM - Disk 2 2 P -
” [ g :
#% Applications | | ’: b4
E RN 2
L & items, 12.48 GB available )

¢ Figure 21-2: If the Search box disappears, you can
retrieve it with the double arrows.

To use the Search box:

1. Click in the Search box and begin typing the
name of the file or folder that you want to
locate.

Alternatively, you can use the 38-Option-F key-
board shortcut to select the Search box.

If you don’t have a Search box in your win-
dow’s toolbar, you can customize the toolbar
to add it (see Technique 12). If the current
window doesn’t have a toolbar at all, choose
Viewr>Show Toolbar.

The Finder instantly begins searching your hard
drive. Even so, you can continue to type in the
full file or folder name.
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2. If you see the file that you’re looking for before
the search is finished, click the Stop button
(which bears an X) in the lower-right corner of
the window to stop the search.

While the Finder continues its search, it shows
the results in the top panel and the status in the
bottom of the window.

A new feature in Tiger is that search results are
now grouped by kind. So all the AppleScripts
that match the search are grouped together, as
are all the images, applications, and so forth. To
hide any kind of group, just click the triangle
next to the group name.

3. To cancel the search, click the Stop button (the X)
in the Search box.

Clicking the Stop button in the Search box stops
the search, wipes out any results, and returns
the Finder window to its previous directory.

4., After the search is completed or you’ve stopped
it, scroll through the results to see which files
matched the search (see Figure 21-3).

+ New Search =

werB@

{ Save J(+]

]
| 10 ir 02 Cath Som actaity_cateqony.qif banner_cats.gif

BO-CAT
ClinlJPG 026G thumbjpy

BO-CAT
026G thumbiipg

2 04 My Lover's Gone.mda
E 07 setfast Penquens and Catsi.map
£ 0 Cat Turned Blue.mp

ar's in the Cradle MP3

T/20/03 1218 PM
3/6/02 805 PM

rharine mpd

¥ Source code
L add_category.php 6403 441 PM
B/%/00 2 56 PM
3/1B/04 2:03 P :
.

& catadd.ehes
| ¥ caalaine php
P ¥ ¥y S

HI4 items @ﬁ

¢ Figure 21-3: The search results, organized by file type.

Attempting to scroll through the search
results, let alone open one of these files, while
the search is still going is a pain because the
window and its contents keep changing. We
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recommend either stopping the search if you
see what you were looking for or waiting for it
to complete.

When it comes time to review the search results,
keep these tips in mind:

v To limit your search to a specific area, click the
labels at the top of the results window (see
Figure 21-4). By default, you can search in three
areas: Servers, Computer, and Home. If you store
all your stuff within your Home directory (as you
should be doing), clicking the Home button
should appropriately limit your search.

ana + New Search =

0 “rB®

37279858-50C3 -1109-9ERS-00NADSACFFOEN2F- iealevera 1/13/05 136 PM0
™ 3P2CSCEA-5DC I | 108~ SE8G-000ASSACHFOERZF- icaltvent 113105 1136 P88
™ 3728084C-5DCT-11D9-9E86-D00ADSACFFOEXIF - icabevent
$7260FRE-50C 3-1109-5EA5- O0OAISACFFOEX2F - icabevent
P 3727F7E4-5DC1-1103- 9E8E-DO0ADS ACFFOENLF - bealevent
I B I7IREAGA-5DCT-1100-SFRG-O00ANSACFFORKIF- icabreant

1713705 136 P
1/13/05 136 P
1/13/05 1'36 M
1713705 136 M9

& mem B

¢ Figure 21-4: The results shown in Figure 21-3 have been
restricted to my Home folder.

v To find out more about a particular result, click
it once to select it. You see the item'’s location —
called its path — at the bottom of the search
window.

1 To get more information about most items, click
the Get Info icon on the right side of the window
(see Figure 21-5). The Get Info icon is the light
blue circle with a lowercase i in it. You'll see these
along the right side of window. Alternatively, if
you've added a Get Info option to your window’s
toolbar (see the solid blue circle with the white i
at the top of the window), you can click it.

v To see a slideshow of the matching images,
click the Play icon in the Images bar.

Image results can be listed in either icon or
list view, by using the buttons in the Images
title bar.
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il WS Audsa File
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¥ Source code
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¢ Figure 21-5: Use the Get Info icon to see more details
about a particular item.

v Open any file, application, image, or what-have-
you by double-clicking it.

v If you didn’t find the file you want, try a differ-
ent search term or use the Find window for a
more advanced search.

You can also further alter your searches by clicking
the plus symbol to the right of the Save button. This
lets you add criteria to your searches, turning this
into a more formal Find, which you discover more
about if you keep reading.

Using a Find Window

For more sophisticated searches, use Finder’s built-
in Find command. This has replaced Sherlock’s Find
Files feature (if you used Macs that far back). It’s
accessible by using the universal 8-F keyboard
shortcut or by choosing File=>Find in the Finder. Find
in Tiger just takes the simple window search several
steps further.

The Find tool lets you establish multiple parameters
for your search beyond just the file’s name or its



contents. You can even use ranges and conditionals
with many of the parameters, greatly expanding the
possibilities.

For starters, use the row of locations at the top
to choose what parts of the computer should
be searched (see Figure 21-6). By default, your
options are

00606 + New Search -
= il g = .
‘ - ‘ =0 ] g;’? g @ ; |
servers Home e W)
Kind o Any A =+
Last Opened 5 Any Date 3 =) (&
0 items ®

¢ Figure 21-6: The Find Finder window.

v Servers: Includes all mounted volumes, such as
CD-ROMs and even mounted servers.

1 Computer: Includes all the hard drives on the
computer.

v Home: This, sensibly enough, is just your Home
Directory.

If you don't specify an area to search, Tiger
searches every place it can think of. You can
limit your search to a specific folder by navi-
gating to that folder and then pressing 38-F.
That folder is then listed as an option label at
the top of the Find window.

Underneath the search locations are parameters you
can set. By default, the Find window opens with two

default parameters. You can easily add more by click-

ing the plus sign or subtract one by clicking the

minus sign. For each item, you use the drop-down list

to select your first criteria. Then, more drop-down
lists or text boxes appear, letting you add more
details to that search (for example, a part of a name
or a range for a date).

Using a Find Window ’6 7

The available criteria include

v Kind: The Kind drop-down list lets you limit the
search to whether the file is of a certain type.
The list of types is alias, application, folder, docu-
ment, sound (audio file), image, or movie.

The second Kind menu lets you choose spe-
@ cific kinds of items: documents, images, PDFs,
music, and so on. It also has an Others option,

where you can specify very particular kinds,
like an alias, a Photoshop gradient, or an iCal
To-Do item. These options are based on the
kinds of files and information found on

your Mac.

v Last Opened, Date Modified, or Date Created
Dates: If you have a sense of one of these three
dates as they relate to the desired item, this is a
great way to locate it. In the Find tool, you can
use

» The first drop-down list to select which date
you want to work with

» The second list to decide whether the file
should have a specific date or fall within a
range

» Use the third list (if given the option) for set-
ting that range

Using dates, you can search for a file whose rele-
vant date is

» Today

» Within a certain time period relative to today
(see Figure 21-7)

» Before a particular date
» After a particular date

» On a particular date

v Keywords: Keywords are what’s known as meta-

data, information used to describe a thing. A key-
word might be Image or Document.

v Label: If you use the Labels feature, you can also

search over whether the file has a particular
label. See Technique 11 for more.
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806 - New Search =
[C==E] O %Be
 Servers. Home

Last Opened &

: Within Last 2 weeks %
Last Opened : iﬁny’l}iale B2

¥ Folders
= = Panther Today at 8:05 AM
2 stuff Yesterday at 11:01 AM

= Tiger Today at 9:14 AM

L 4,609 items ® 7

¢ Figure 21-7: The date drop-down lists are very flexible,
allowing you to specify dates or a range.

v Filename: Unlike the window Search box, the
Name text box gives you the secondary option of
selecting whether the entered text should start,
end, exactly match, or simply be in a matched
filename (see Figure 21-8). With this, you can
more effectively fine-tune the returned results.

806 + New Search -

oo = |= A 3 e SR
[ ==Es] O RzB@ -
[ Server Home

Last Opened

0 Within Last 2 weeks 3

_Name Begins With ) Jcar 2 (&

¥ Source code
) catalan-iso-8859-1inc.php
) catalan-utf-8.inc.php

- ¥ Documents

9 cating 1/19/05 12:46 PM

cata.Ing 1/19/05 12:46 PM

1/19/05 12:46 PM

1/19/05 12:46 PM

1/19/05 12:49 PM
1/19/05 12:49 PM

| catadom.tab

catdom.tab

| 6 items @ j

* Figure 21-8: The drop-down lists let you further limit a
search.

v Contents: The Find by Contents feature searches
through the contents of a file (for example, a
Word document, a plain text file, or even an
HTML page) for matching text. This is clearly the
most exhaustive search that you can execute.

v Size: If you know the approximate size of the item
in question, you can add a size is greater than or
size is less than search criterion. Unfortunately,
you can’t add two size options at the same time
to create a range of acceptable values. The size
text box is listed in kilobytes but you can also

choose megabytes or gigabytes from the third
menu that appears.

v Other: This might be the most specific option you
can choose, but you have to really know what
you're looking for to use it. When you select
Other, a sheet appears with a vast list of criteria
(see Figure 21-9). From here you can factor in
such things as: the number of pages in a docu-
ment; the ISO speed that was used to take a digital
image with a camera; or a specific font. Note that
this Other is different from the Other in the Kind
drop-down list, which lists different kinds of files,
not their properties like this Other does.

Select a search attribute: Q Search

| Name &| pescription B B

' FNumber Diameter of the aperture relative to the effective focal |~
Focal length Focal length of the lens in millimeters (mm)
Fonts
Fonts Fonts used in this item

General MIDI sequence
Headline

Identifier

Instant mes...e addresses
Instructions

Whether the MIDI sequence contained in the file is setum
Publishable summary of the contents of the item
Reference to a resource within a given context

Instant message addresses associated with this item
Other information concerning the item, such as embar¢

IS0 speed 150 speed of the camera when the picture was taken
Key signature Musical key of the song in the audio file 1
Keywords Keywords associated with this item v
[ = - Ta|r
"] Add to Favorites Cancel )

¢ Figure 21-9: The Other options with which you can
search.

Because Other offers so many search attrib-
utes, you can literally search the Other search
list! Use the Search box in the upper-right cor-
ner of the Other sheet to quicken the hunt.
Mark any Other criteria as a favorite and it’s a
quick option in your list of search criteria.

The following section shows an example of a Find
search, which you then save as a Smart Folder.

Working With Smart Folders

All in all, Tiger is a whole lot smarter than Panther.
You now have Smart Mailboxes and Smart Albums
and Smart Groups (in the Address Book) and, in the



Finder, Smart Folders. Like anything else that’s
“Smart,” the premise is that you save a set of criteria
as the definition of that folder’s contents. As the
stuff on your computer changes, the contents of this
folder are dynamically updated to represent the cur-
rent status.

Pay attention to this little detail: Smart Folders
contain aliases to stuff that’s located elsewhere
on your computer. It doesn’t contain the actual

stuff. So, if a Smart Folder tracks images of a
certain size, the images that fit the size range
appear in the Smart Folder, but those are just
aliases. You still find the real images in their
original location on the computer.

Smart Folders are just saved searches, so this exam-
ple shows you how to create a Smart Folder that
lists the most recently viewed Microsoft Office
documents:

1. Open a Find window by either pressing 8-F in
the Finder or choosing File=>Find.

2. Click the Home button at the top of the window
to narrow the search.

3. For the first criteria, select Kind and
then Documents from the second list (see
Figure 21-10).

You could also select Other from the second list
and then specify a document type, such as
Microsoft Word document.

4. For the second criteria, select Last Opened
from the first list and select This Week from the
second list.

5. Click Save.

6. At the prompt (see Figure 21-11), save the
search by taking the following actions:

a. Give it an appropriate name.
b. Save it where it makes the most sense.

c. Decide whether you want this Smart Folder in
your Sidebar.

Working With Smart Folders

800 + New Search -
= - o~
[==Es] O %ZzBO
= Servers Computer  @LLD -m@
Kind ¥ Documents B =) &
Last Ei_peneﬁ % Any_ Date & =) [+,
- s ”

8.jpg 9.Jpg 10jpg 11jpg
240 % 18 240 % 18 240 % 18 40 x 18

12ipg

1,570 more

v PDF Documents
Cocktailo01.pdf
Cocktail002.pdf

11/12/04 6:02 PM
11/12/04 6:03 PM =

1,583 items @

* Figure 21-10: Use the Kind criteria to search specific
documents.

Specify a name and location for your Smart Folder

Save As: Recent Office Documents| v

Where: [ saved Searches i ]

K Cancel ) E—&nﬂn—)

™ Add To Sidebar

* Figure 21-11: Use this prompt to create your Smart
Folder.

] By placing the most useful Smart Folders in
e- { - the Sidebar of your Finder windows, you make
) them universally accessible. With this method,

your Smart Folders also appear in the Open/
Save dialogs in any application.

7. To change the criteria for a Smart Folder, open
it in the Finder, and then click the Edit button.
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Searching for Things
with Spotlight

The final tool we cover for performing searches is
also new to Tiger: Spotlight. Spotlight has a number
of benefits over a simple Finder search. It

7 d

X Y\

\

Searches through your e-mail
Searches through your Address Book
Scours your iCal calendars

Finds matches based upon songs in your iTunes
library

Is always available no matter what application
you're in

The Spotlight tool is accessible through the little
blue magnifying glass in the upper-right corner of
your display (at the end of the menu bar). But
enough talk. Start using it!

1
2.

3.

4.

Click the Spotlight icon.

Enter a term (or terms) in the Spotlight Search
box (see Figure 21-12).

Assuming you found what you were looking
for, you now have two options:

» Quickly selecting it by clicking the item in
the list.

» Clicking the Show All link to bring up the
Spotlight results window (see Figure 21-13).

The next time you click Spotlight, the previous
results are still there, so click the X to clear them.

It’s really that simple! But you can improve upon
your Spotlight success by doing these things:

7

Memorize the two keyboard shortcuts to
quickly access Spotlight. By default, you can
launch and access Spotlight by pressing 38-Space.
You can go straight to the Show All search results
window by using -Option-Space.

Spotlight

B Show All (355)

Top Hit [ marc

[T 579630 ch31.doc
[7] 579630 ch19.doc
[T 579630 ch19.doc
[7] 579630 ch19.doc
o ReadMe Firstl.refd

Documents

Mail Messages | _*| Re: Last Chapter!
| Big awards, standard safety ...
__*| Winter Finally Hits Washington

Contacts  [- | Ali Van Doren
|- | Marc Liyanage
Events & To Do's : Marc Liyanage's Birthday
Images | menu2.psd

= ncaa.psd

PDF Documents |#] Picture 2
¥ reading_004.pdf
¥ MeasureOfCulture.pdf

Music  [#] Sex And Candy
[ I'd Like That
[# London Calling

Spotlight preferences...

* Figure 21-12: The search results are organized by type of

item found.

v Open the Spotlight preference panel and cus-

tomize its behavior. You can open Spotlight
Preferences by choosing this last item from the
basic search results window. You can also access
it by going to the Spotlight System Preferences
panel. If you don’t want Spotlight searching for
certain things (such as Applications, Movies, or
System Preferences), deselect the appropriate
check boxes here to exclude those items from
searches (see Figure 21-14).

Change the Spotlight keyboard shortcut if it
conflicts with exiting software. Third-party
launching tools, like QuickSilver and LaunchBar,
use the 8-Space keyboard shortcut. If you use an
application that already looks for 38-Space,
change the assigned shortcut either in that appli-
cation or for Spotlight, again using the System
Preferences panel.



v Restrict Spotlight access to specific directories
by using the Privacy pane. Also under Spotlight’s
System Preferences (see Figure 21-14) is a section
where you can tell Spotlight what folders it
shouldn’t search. If you don’t want items in certain
directories showing up in searches, don’t give
Spotlight that option.

v Alter search criteria in the Show All search
results box. The Spotlight search results are dis-
played by group, as they are in a Finder window
search. By using the labels on the right side of
the screen, you can further adjust the search
results (see Figure 21-13).

ene Spatlight: marc
355 mesuits (Q, mare

R0 more

™. dare Livanage's Birthday

mare

& more

ST9E30 chil doe Yesterday [ETET
T 79630 chl19.doc Frigay r50m
T 79630 chlt.dos Friday 150
T STOEI0 chlfdoc Friday 150m
% Readbe Fiestt i Thursday 1057 PM

Jmsgary 13

Marc Livanage Today TA6AM
Tonputa P Thursdey SIEM

= 930 Chab Winn Wednesday £21 M

“ Marg Liyanage 5o M Wednesday 01

%] Larry Uilman &2 Wednetday  1IIPM i ,,,:
Al Van Doven Tussday 400 Where:
Maic Livahage Tuetday 400 Homy

129

— merd. gl May 2001
[ neaa psd Murch 2001 Tropics MM - Disk 2

* POF Documents e

¥ Picture 2 Tuesday 1rmsm

@ reading 004 pdf Jeeary 18 A5IPM

@ MeasureOfCubire pdf December 1 10700 P

# Peachon word e pdf Agril 22 1120 AM

# Peachpit word listpdf gl 12 1020 M

F Sx And Candy December 2001

7 Td Like That Ausgutt 2003

z

# Lendan Calling At bl

£

B Mime Juby 3001 >~
F Goletiowm Juty 2003 i

* Figure 21-13: View every item that applies to your search

by clicking the Show All link.
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Searching for Things with Spotlight

880 Spotlight

<) (| a

o

Spaotlight helps you quickly find things on your computer. Spotlight is
located at the top right corner of the screen.

sults | Privacy
Drag categories to change the order in which results appear.
Only selected categories will appear in Spotlight search results.
.1 [ #A Applications
] & System Preferences

E |4 Documents

# [0 Folders

# # Mail Messages

# | Contacts

# of, Events & To Do Items
# i Images

]
=]

VN W R W N

¥ PDF Documents

=B
(]

5 Movies
] A Fonts
] ¥ Presentations

e
W
)

# Space B
E Spotlight window keyboard shortcut: | 3™ Space B

ESpotlight menu keyboard shortcut:

* Figure 21-14: Customize Spotlight’s search behavior by
using the System Preferences panel.



Slimming Down
Vour Hard Drive

Technique

Save Time By

v~ Avoiding installing unnec-
essary applications

v+~ Deleting junk from your
hard drive manually

v Using third-party applica-
tions to remove the dead-
weight

v+ Understanding what not
to throw away

fill up is suddenly gone. Sadly, that’s just as true whether you’re talking

about a new house, apartment, or that 60GB hard drive that you
believed would allow you to download the whole Internet to your com-
puter. Eventually, the time comes to either clean house or upgrade.

It never fails to happen: All that extra space you thought you’d never

Knowing what you can get rid of and how to do it saves you the time and
expense of upgrading a hard drive (and makes your computer perform
slightly better). This begins with doing nothing: that is, not installing
applications and files that you won'’t use. After that, you need to look at
getting rid of the files on your hard drive that you no longer need. You
can do this manually with a little prudent knowledge. Third-party appli-
cations are also available to help you remove the hidden system files you
no longer need. Finally, we send up some warning flares to remind you of
the things that you absolutely, positively shouldn’t get rid of.

Avoiding Unnecessary Installations

During the Tiger installation process, you can customize your installation
so that only the features you need are installed. A new Tiger installation
can take anywhere from a few hundred megabytes to multiple gigabytes.

Because you can'’t easily uninstall parts of Tiger, you're better off not
installing them in the first place — assuming you won’t need them, that
is. The worst offenders, in terms of hard drive space, are

v Printer drivers: Tiger supports many common printers — which is
great — but it does so at a huge cost of hard drive space. Installing all
the printer drivers would take nearly 1GB. This is definitely one area
where you should use some judgment about what to install and what
to leave out. Three good options are

» If you don’t have a printer, don’t install any printer drivers.

» If you have a printer, see whether the manufacturer provides a
driver for your specific model by checking the support, software, or



Weeding Your Hard Drive: Manually Deleting Files

drivers section of its Web site. That driver
might be only a few megabytes in size and
therefore much smaller than the one-size-fits-
all driver provided by Apple for that manufac-
turer’s printers.

» If the printer manufacturer doesn’t provide a
driver for your specific model, install only the
drivers for your make of printer.

v Language Translations: Language Translations
allow your Mac to display system controls (menus
and such) in languages other than English.
Although it’s great that Apple recognizes the
global, multilingual community, if all the people
using your computer speak the same language,
avoid Language Translations. These take 400 or
more megabytes.

v Fonts: Tiger can install fonts for you to use a
dozen non-Indo-European languages with your
Mac. These fonts enable you to read Japanese,
Chinese, Korean, and other languages in your
applications. Naturally, if you don’t see that
happening, you don’t need to install these
fonts.

Be prudent when installing applications. Most
installers give you the option of customizing the
installation process (as Photoshop does in Figure
22-1) so that unnecessary pieces don’t clutter up
your computer. As a general rule, hard drive-hogging
applications — for example, Adobe Photoshop or
Apple’s Final Cut Pro — give you more flexibility to
customize installation.

B dictate what gets installed. If you won’t use
something, don't install it. If you later realize
that you need something you didn’t install,
you can always add it by running the installer

again.

2 Many installers, including Tiger, allow you to
-

&

173

Photoshop Elements 2 Tryout

066

Custom Install Iy

O Photoshop Elements 2.0

Mac 05 ¥ Tune-Up

Helpers
HTML Palettes
Flug-Ins
Presets
Previews
Recipes

O samples

[ settings

O Tutorials

goodgoo| o

T e e Y o R T

[ Online Help

Dk space available: » 4GB
— Install Location

#pproximate disk space needed : OK

(auit )

'!'-' © The folder " Adobe Photoshop Elernents 2™ will be created
|l % in the folder “A&pplications" on the disk “Main”

Install Location: | Main ] :] “Install-

* Figure 22-1: Many installers let you customize the
installation itself.

Weeding Your Hard Drive:
Manually Deleting Files

As a general rule, Mac OS X doesn’t use uninstallers
for the operating system or for individual applica-
tions. Thus, after you've installed the junk. . . er,
files ... on your computer and realize that you no
longer need them, you must delete them manually.
You might want to do some judicious weeding in
these four general areas: your Home folder, the
Applications folder, the System folder, and other disk
drives and partitions.

Use 38-Delete to send a selected item (or items)
to the Trash.

Back up the contents of your computer before
going hog-wild deleting items that you believe
to be unnecessary. A good backup makes
restoring items a snap if you inadvertently
delete something important in your house-
cleaning frenzy. See Technique 49 for every-
thing you need to know about backups.
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Pruning your Home directory

Your Home directory is where you’re most likely to
get rid of extraneous stuff. Fortunately for you, it’s
generally the safest place to make cuts as well.
Here’s what you can do:

v C(lean up the contents of your Desktop folder.

v Delete anything that you no longer want in the
Documents folder.

v Free up some space in the Movies, Music, and
Pictures folders.
L/ If you actively use iPhoto, your Home direc-
- («s& tory can quickly fill up with pictures. When
you have 650MB or more of photos, burn a
CD (or two, for safe keeping) of your albums,
and then delete these files from your hard
drive to save space.

&

v Get rid of anything that you don’t want in the
Public folder unless it’s still needed by others on
your computer or network.

v Remove files from the Sites directory. The Sites
directory is where you store Web pages. These
directories become easily cluttered with old ver-
sions of files. Remove them to save some room
here and there.

If the contents of the Movies, Music, or Pictures
folders are managed by iMovie, iTunes, or
iPhoto, you'll be better off deleting these files

from within those applications because they
have associations with the physical files.

The archive alternative

If you like the idea of keeping all your stuff on your Mac
but don’t like how much space it requires, try archiving
old files. Any file that you don't access frequently but still
want kept around can be compressed by using the Finder’s
Create Archive tool (under the File menu). If you later need
to access an archived file, double-clicking the archive
expands it for you.

Technique 22: Slimming Down Your Hard Drive

Although an archive can cut down on the amount of space a
file takes up, it won't work on every type of file. Specifically,
PDFs, movies, and some image types are not compressible.

Thinning out no-longer-required applications

Applications can take up a huge amount of space on
your computer. If you're actually using the applica-
tions, it’s no big deal. But after you've stopped play-
ing a certain game or found a better alternative to an
application, you might want to get rid of it. Because
you normally won'’t find an uninstaller for an applica-
tion, here are the steps to take:

1. Locate the application’s file or folder within the
Applications directory.

Simple applications are wrapped in a single icon,
which can be deleted (such as Internet Explorer).
More involved applications have their own fold-
ers (for example, Netscape Navigator).

2. Move the file or folder to a temporary location.

Instead of deleting the files immediately, we rec-
ommend temporarily setting them aside as a
just-in-case measure. You can either

» Create a folder on the Desktop for this purpose.
» Move them onto an external driver or CD.
3. Open the Library folder of your Home directory.

If you really want to clean house, get rid of the
corresponding application stuff that was placed
within your directory. This includes supporting
materials and preferences.

4. Check these folders folder for files associated
with the application and move any applicable
items to the temporary folder:

» Application Support: Only a few applications
have files here, but if you want to be thorough,
it’s worth checking out.

» Preferences: Pretty much every application
adds at least one file to your Preferences
folder. Although these files are small, they’re
still worth getting rid of.
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5. Wait a few days. Then, if you don’t see any
problems caused by moving these files, delete
the temporary folder.

A fast way to max out your hard drive is to
perpetually download and install demos and
shareware. Game demos are particularly large.
Personally, we don't install shareware or demos
of applications that we don’t reasonably expect
to buy. Doing so only wastes time and clutters
up the hard drive.

If you installed an application, you should be
able to safely remove it. Applications installed
by Tiger shouldn’t be messed with. This

includes items in the Applications folder such
as System Preferences and Internet Connect.

Cleaning out your System and Library folders

If you check out the size of your system files, stored
both in the Library and the System folders, you’ll see
that they take up a lot of space (in Figure 22-2). That
being said, you don’t want to go traipsing through
there to remove files. The reward for clearing up some
room is normally slight, but the risk that you take will
be grave. As the worst case, you would trash some-
thing that renders your computer inoperable. For the
most part, you're better off leaving these files alone.

Some applications also store resources in the
/Library/Application Support folder.
Although you need to be extra careful when
deleting stuff from this directory, doing so can
pay off. For example, GarageBand — which we
love having but rarely play with — takes up
55MB for the application itself and 2.1GB (!")
for sound files in the /Library/Application
Support folder.

However, here’s one thing that you can do with sys-
tem files: If you performed an Archive and Install
installation of Tiger, the installer creates a Previous
Systems folder to store the old system files. If every-
thing’s running okay with the new operating system,
you can delete this entire folder.
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en6

= | System 2.15 GB
h// Modified: 31.03.2005 23:21

P Spotlight Comments:
¥ General:

Kind: Folder
Size: 2.15 GB on disk (2'054'144'909
bytes)
Where: [
Created: Samstag, 13. Juli 2002 06:49
Modified: Donnerstag, 31. Marz 2005
23:21

Color label:

System Info

_| Locked
- More Info:

B Name & Extension:

P Preview:

P Ownership & Permissions:

* Figure 22-2: A minimal installation of Tiger can put at
least 1GB of files in the System folder.

Don’t remove anything (anything!) from the
System or the Library folders unless you really,
really know what you're doing and have backed

up the entire computer.

Cleaning other volumes

Some computer users have already established multi-
ple volumes for their computer. This is accomplished
by either

v Installing extra hard drives

v Partitioning larger hard drives into separate
volumes

If you've done this, you're probably using the other
volumes purely for storage purposes (because the
main volume is running the operating system and
should have your Home directory). Your other
volumes, therefore, are a good place to get rid of
no-longer-needed files.
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Classic and OS 9

If you're still running Classic or dual-booting into OS 9
(gasp)), you can trim down files particular to that operating
system. Some considerations include the following:

v Drop OS 9 applications for which there are good OS
X alternatives. There’s no reason to keep two applica-
tions that do the same thing.

v |If you're using Classic, there are many system exten-
sions that you won't be using. For example, if you
won't be using QuickTime or a printer within Classic,
you can drop many megabytes of deadwood. Getting
rid of these saves space and makes Classic launch
faster.

v Keep all your files within your OS X Home directory.
You can still access them from OS 9.

v Best of all, get rid of OS 9 and Classic as soon as pos-
sible, and then delete all those files!

Diet Tools: Third-Party
Applications

If you'd rather spend your weekend cleaning the

attic and not your hard drive, you can invest in one
of many third-party applications that facilitate the
process. (The process of cleaning up your hard drive,
that is. You're on your own when it comes to cleaning
up the attic.) In truth, these applications make more
of a quantitative than a qualitative decision. Whereas
you might know that you no longer need a particular
document or no longer like a particular song (an MP3
file), the following tools earmark files whose size and
lack of use might merit removal:

Technique 22: Slimming Down Your Hard Drive

v+ OmniDiskSweeper, by the good people at the
Omni Group (www.omnigroup.com, $15), offers a
good bang for very little buck. It basically repli-
cates the process of going through the Finder
and removing large files but gives you a nicer
interface. It also warns you about deleting poten-
tially critical files.

v mrclean (http://arcobaleno200l.interfree.it,
free) searches your computer for duplicate files
(based on filename, file size, type, and so on).
Often these are sizable documents such as MP3s,
images, and movies.

Be certain to check out the utilities that Technique
54 lists. Besides performing routine maintenance,
many help with disk bloat by weeding out hard-to-
find system files and logs.

Hands Off: What Not to Trash

You might be the type who'’ll gladly spend a day tin-
kering just to clear up a little space, but here are
some rules that you should never break:

v Don’t delete or rename the Applications or
Utilities folders.

v Don’t delete or rename your Home folder.

v Don’t delete or rename the Desktop or Library
folders in your Home directory.

v Don’t touch the System or Library folders.

The consequences of doing one of the mentioned
Don’ts range from an inability to launch an applica-
tion, to an inability to login, to an inability to boot
into your Mac! Do you want to take that risk? We
thought not.
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Improving Application
Performance
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Launching
Applications Fast

Technique

Save Time By

v Launching applications
automatically when you
login

+* Knowing the many ways
to open an application in
the Finder

v Becoming familiar with
shareware launching
tools

you want to say it) an application is so simple that you couldn’t

possibly improve on it. But surprisingly, you can use many tech-
niques and tools to improve on this common procedure. Putting some
time and effort into mastering the easiest ways to open applications goes
a long way toward expediting how you use your computer.

You might think that opening (or launching, starting, or however

The first timesaving technique is to have Tiger automatically open an
application when you log in to the computer. Then we go over the multi-
tude of ways you can launch applications (such as from the Finder or
Dock), some of which you probably already know. Finally, you read about
a couple shareware tools designed to open applications in faster ways.

Auto-Launching with the Accounts Panel

The Accounts panel, which is part of your System Preferences, does
more than just allow you to manage the computer’s users. You can also
pop open the Accounts panel to adjust some of the computer’s behavior
for their accounts. The relevant subsection for opening applications is
the Login Items panel. Follow these steps to access it:

1. Select System Preferences from the Apple menu.

This opens the System Preferences application.
2. Click Accounts under the System heading.

This opens the Accounts panel, where you want to be.

3. Click your account in the left column of the Accounts panel to
select it.

4. Click the Login Items tab (see Figure 23-1).
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Technique 23: Launching Applications Fast

eeon Accounts
4, b Show All Q
Wi A | Password | Picture | Loginitems | Parental Controls |
Larry Uliman
Admin These items will open automatically when you log in:
Other Accounts Hide | Item Kind
Marc Liyanage @ & Snapz Pro X Application
Standard [ |screenshot Helper Application
] % sBEdit Application
O @ iTunes Application
O @ safari Application
i @ System Preferences Application
To hide an application when you log in, click its Hide checkbox.
[+[-]
‘m Login Options
BE
d D
d_ Click the lock to prevent further changes. )

* Figure 23-1: Use Login Items to automatically launch
applications.

Technique 2 includes a brief introduction to

@ using Login Items. Because it's such a useful
idea, we cover it again, and more thoroughly,
here.

To make a program launch automatically when you
log in to your computer, add it to the Login Items
list. You can add items to the Login Items list in two
ways:

v The slow way:

1. Click the plus button at the bottom of the
panel to access an Open dialog.

2. Navigate to the application you want to add
and select it (see Figure 23-2).

3. Click the Add button or press Return.

v Drag an application’s icon from its folder onto
the Login Items panel.

] The quickest way to add applications to the
(8 («a Login Items panel is to drag them there from
& the Finder.

I5 ] Q search

fm) ' [ Applications

4| >

@ iDisk B & address Bl Y 2
(s Network [ Agplescript ’ ¥

~ {T—— W Automator

== B BBEdit

[ 80GB Firewire| | [ calculator

[ 40 GB Firewire| | Chess
| | | "] DVD Player
" W anr Book Name: Address Book

[ Utilities « Graphing Calculator 5 6 MB

‘f‘ larryullman fil ical Kind: Application

@ Favorites © ichat Created: 10/27/04 5:12 W

52 Image Capture AM
& Desktop © Internet Connect _ Modified: 10/27/04 5:12
[y Documents & isync T _ AM v
1 Opened: - 1

| Pictures M iTunae
R el
(Canee)

¢ Figure 23-2: This is the slow way to add applications to
Login Items.

After you add an item to this listing, you can choose
to have it open in hidden mode by marking the
check box next to its name (as shown in Figure 23-3).
Hiding a Login Item just means that the application
will be hidden when you log in. Essentially, it will be
as if you opened the application and then selected
Hide Application from the application menu. This is a
good option for behind-the-scenes utilities that you
don’t need to be aware of.

Hide  [tem Kind
& Snapz Pro X Application

W
1 Iscreenshot Helper Application
[ %@ BBEdit Application
[ &iTunes Application
= &5 Safari Application
™

“ System Preferences Application

To hide an application when you log in, click its Hide checkbox.

¢ Figure 23-3: Enable an application’s check box to hide it
after it’s opened.



To remove an application from the Login Items panel,
you have only one method:

1. Select the item in the list by clicking it.

2. Click the minus button at the bottom of the
window to remove the item.

You might be wondering, “How do I decide what
applications to automatically start?” The answer to
this depends on what kind of computer you have
and how you use it.

If you have a laptop, you probably don’t want to
overdo it with Login Items. But most Mac users will
benefit from these rules:

v Add utilities and shareware that provide perpetu-
ally necessary services (for example, LaunchBar
or system clock replacements).

v Add applications that you’ll always use first thing
on your computer (such as Mail or Eudora).

If you set your e-mail client to open first and
you have an always-on Internet connection
(cable, DSL, whatever), your Mac can download
your e-mail while it's continuing to open other
applications. When all is said and done, your
apps will be up and your mail will be waiting
for you.

v Include applications that you use every day (like
Safari or iTunes).

» Add utilities that you should run on a daily basis
(maybe Virex or Backup).

v Add applications that take a long time to load
(like Photoshop) if there’s a good chance you’ll
use them on a nearly daily basis.

Many applications, such as Virex, have options
within their preferences panels (see Figure
23-4) that have a similar effect to adding the
application to the Accounts panel Login Items
listing. Use the preferences panel to add these
to your Login Items list (because, in this particu-
lar case, the item being added is the VirexLogin
utility, not Virex itself).
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06 e Virex 7.2
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> Clean S
fou Iy 1 i
Ples _| Remove macros from potentially infected files
ou [ Automatically delete infected files
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Advanced Scan

Eﬂ Perform an advanced scan of applications and
macros for previously unknown viruses
Detects unknown viruses by analyzing files for possible !

N virus-like characteristics. An advanced scan takes longer
than a normal scan.

Virus Update
@ Check for new virus definitions at launch
] Customize my eUpdate server settings

( Reset to Defaults ':ZI

¢ Figure 23-4: You can set up virus utilities to automatically
scan at startup.

Launching with the Finder

Even though you can launch applications in the
Finder, knowing all your options can go a long way
toward speeding up this very common task.

] The fastest way to open an application is to
never shut it down. Because of how Mac OS X
) handles memory, you'll notice very little per-
formance loss by keeping applications open,
and you'll never have to wait for the applica-

tion to launch again.

The most common (but not necessarily the most
convenient) way of opening an application is to use
Finder windows. You can either

v Navigate your way to the Applications directory.

v Set up your preferences so that the Applications
folder is automatically listed in the Finder win-
dow’s left-side section (see Figure 23-5).
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* Figure 23-5: Among the locations that can be listed in the
Finder window Sidebar is the Applications
directory.

Technique 12 has instructions on customizing the
Finder windows and Sidebars.

After you find your way to the application and select
its icon, you can launch the application in many
ways. Here are your options, listed from easiest to
most time-consuming:

Double-click the icon.
Press 3-0.
Press 38-l.

A W W WY

Control-click the application and choose Open
from the contextual menu.

\

Choose Open from the Finder’s File menu.

<€)

If you add an application’s icon to the Finder
window’s toolbar (such as BBEdit, Safari, and
Word in Figure 23-6), you can launch the
application by clicking the icon, which then
appears in every Finder window by default.
You can place applications in the toolbar by
dragging their icons to it from the Finder (see
Technique 12).

%
e
&

ene @ larryullman -

[«-EE=o)+] @[F BOW o

* Figure 23-6: Add icons for critical applications to your
Finder window's toolbar.
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You can launch an application by opening a
file that uses that application as its default, by
dragging the file onto the application’s icon, or
by using the contextual menu’s Open With
prompt. We go into great detail about ways to
open files in Technique 25.

Here’s a common sequence for easily opening an
application by using only the keyboard:

1. Navigate to the Finder by pressing 38-Tab.

Press 38-Shift-A to bring up the Applications
directory.

Type the first few letters of the application’s
name to highlight it.

2.
3.
4. If necessary, press Tab to go to the next appli-
cation (if it wasn’t highlighted in Step 3).

5.

If you need to open the application’s folder,
press -0 (in icon view mode) or $-— (in list
and column view modes).

6. After you select the application, press $-O to
open it.

Launching with the Dock

The Dock can serve many purposes (such as linking
files and folders or displaying the Trash), but the left
side of the Dock is strictly for your applications.
This area is where open applications reside (flagged
by an upward-pointing triangle, as shown in Figure
23-7), as well as any other application that can be
permanently linked there.

QAN%E

¢ Figure 23-7: The Dock indicates open applications with a
black triangle.




Here are two things to consider with respect to
applications and your Dock:

v What applications to dock there

v How best to arrange the docked items

As a general rule, dock every application that you
use on a frequent basis. Considering all the ways you
have to access applications, making sure the right
applications are docked should be obvious to you.
What’s more important is the organization scheme
you choose. Larry prefers to organize his Dock this
way, as shown in Figure 23-8:

LRI RBOQ THENY

* Figure 23-8: Larry’s Dock (in case you're curious).

v Keep perpetually running, but infrequently
accessed, utilities on the far left.

v Keep applications with similar uses grouped
together (such as Web development tools or
multimedia software).

v Place the applications that you use most often as
close to the middle of the Dock as possible.

v ltems in the center of the Dock seem to have a
more stable location. When the Dock expands
and contracts, these items move around less on
your screen.

Marc has the following suggestions (see Figure 23-9):

kclcons UEBRRIRRY POHCEW
* Figure 23-9: Marc’s Dock.

v Dock a select few items that are always running,
such as System Preferences, CPU Monitor, and
LaunchBar.

v Dock the essential iApps from Apple: Safari, iCal
(whose Dock icon also reminds you of today’s
date when the application is open), Mail, and
Address Book.

v Add the productivity applications, depending on
what kind of work you do with your Mac. Because
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Marc is a software engineer, the productivity
applications that he uses most often are the
Terminal, BBEdit, Xcode, and so forth. If you're a
graphic designer, you’d probably have things like
Photoshop, lllustrator, or InDesign here instead. If
you're working with the bread-and-butter applica-
tions, it’s the place for Word, Excel, PowerPoint,
and so on.

v Dock entertainment applications, such as iPhoto,
iTunes, and iChat.

Marc’s main goal is to have stable positions for the
items that he needs to reach most often. After a
while, you get a feeling for where in the Dock a par-
ticular application is located, and you can find it
instinctively with the mouse, just like menu items on
the menu bar.

Here’s what you need to know about working with
the Dock:

v To dock an item, drag its icon to the Dock from
the Finder.

When you do so, the other Dock items make way
for their new roommate.

v To remove any Dock item — particularly all
those that Apple installs there by default — drag
its icon off the Dock (while it isn’t running).

v You can add any currently running application to
the Dock by dragging its icon from one location
to another or by Control-clicking the Dock icon
and selecting the Keep in Dock option from its
contextual menu.

v* The Finder icon will always be on the far-left side
of the Dock. It can’t be moved nor removed. The
same applies to the Trash on the far right.

v Running applications that aren’t always part of
your Dock will be added to the right side of the
Dock.

If you remove an icon from the Dock while the
application is running, the item will be removed
from its permanent location in the Dock even
though it will look like it’s still there (because it's
running).
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Other Ways to Launch
Applications

Although the Finder and the Dock are the most fre-
quently used way of launching applications, they
certainly aren’t your only options. Favorites, aliases,
and Recent Items are all timesavers for this task.

Favorites and aliases

Another way to launch your applications is to create
aliases of them and place those aliases in convenient
locations. This is the principle behind Favorites, a
feature worth using. (Check out Technique 17 for
coverage of Favorites and aliases.)

If you add a slew of applications (perhaps organized
by purpose) to your Favorites, you can then dock
your Favorites folder and quickly launch these apps
(see Figure 23-10).

A" Backup

- BBEdit

3l Calculator

. Documents >
3 1Sync

& JewelToy

£8; Photoshop Elements 2.0

W Sites >
% Snapz Pro X

~ Stickies

% Super GameHouse Solitaire
A Terminal

Show In Finder

VW

* Figure 23-10: The Favorites folder functions as a
hierarchical menu in the Dock.
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Recent Items

After you close an application, you can reopen it
from the Recent Items submenu under the Apple
menu (see Figure 23-11). To adjust how many items
are listed here, use the Appearance panel under
System Preferences.

About This Mac
Software Update...
Mac OS X Software...

System Preferences...

Dock [ 2

Location [
>

Recent Items

NOHED

o €2 iChat

F t Find
orce Quit Finder & Mail
Sleep

Restart...

Shut Down... Clear Menu

Log Out Larry Ullman... {3¥Q |

¢ Figure 23-11: Recently used applications are listed in the
Recent Items menu.

Launching with Shareware Tools

Many third-party applications exist explicitly for the
purpose of launching other applications.

LaunchBar (www.obdev.at/products/launchbar, $20
for personal use, free for limited use) is a utility
designed to always run on your computer. The first
time it runs, it logs every application on your hard
drive (along with your files, Safari bookmarks,
Address Book contacts, and more). To launch an
application, you simply

1. Press 38-spacebar to bring up LaunchBar.

88-spacebar is also set to launch Spotlight. If
@ you've changed the LaunchBar shortcut, use

your new one instead.



2. Type the keyboard shortcut for the application
in question (what you type will appear in the
LaunchBar prompt).

For example:

» M for Mail

» ME for Microsoft Excel
» S for Safari

» BB for BBEdit

» PH for Photoshop

3. Select the application that you want to launch
from the list if it isn’t already highlighted (see
Figure 23-12).

4. Press Return to launch the application.

L & Mail — /Applications M=

1l Microsoft Word Applications

H

tl Mozilla Applications
4 Maclago Applications .
! Maclanitor Applications T

* Figure 23-12: LaunchBar presents a list of potential
candidates.

Launching with Shareware Tools ’85

Alternative launching utilities

Here are some popular alternatives to LaunchBar that offer
similar functionality. Although we adore LaunchBar, you
might appreciate the lower price (sometimes free) and dif-
ferent feature sets of these applications.

v HimmelBar (http://softbend.free.fr/
himmelbar/index.html, donationware) creates a
menu bar icon that provides customizable lists. With it,
you can access applications and more without going
through Finder windows.

v Quicksilver (http://quicksilver.blacktree.
com, free), like LaunchBar, provides keystroke access
to applications and other things on your Mac.

v XBar (http://macosx.syr.edu/spotted
software/XBar.html, free) is like a mini-Dock
whose sole purpose is to launch applications.

v DragThing (www.dragthing.com, $29) also dupli-
cates the Dock but on a very advanced level, letting
you create multiple, customized Docks so that each
can serve a different purpose (like list a different set or
category of applications).

v Namely (http://homepage.mac.com/asagoo/
namely/index.html, free) is like a more minimal
version of LaunchBar, letting you launch applications
by entering very simple abbreviations.

v F10 Launch Studio (http://chronosnet.com, $29)
is strictly an application-launching utility but automati-
cally finds your applications and has a beautiful
interface.
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useful — but still something you’ll probably do only once a day

per application. You’'ll probably spend a lot more time switching
among open applications, hiding them, and (when the time is right) quit-
ting them.

Understanding how to launch applications (see Technique 23) is

In this technique, we take you through the best, fastest, and easiest ways
to work with your open applications. We begin with switching: how to
effectively toggle from one application to another. After that, we quickly
address hiding open applications (which overlaps a bit with switching)
and quitting them.

Switching among Open Applications

Because you’ll probably have about a half-dozen applications open at all
times, being able to quickly switch from one to another is a critical skill
to master. Several methods for application switching are built into the
operating system, and you can also make use of third-party tools to
expand the possibilities.

Switching apps with Tiger

Perhaps the best way to switch from one open application to another is
to use the 38-Tab keyboard technique. We cover this in other techniques,
but it bears repeating:

1. Press and hold down the 38 key.

2. While continuing to hold down the & key, press the Tab key once to
bring up the list of open applications (as shown in Figure 24-1).

Microsalt Word

* Figure 24-1: Pressing 8-Tab presents you with a list of open applications.



3. Continue holding down the 38 key and tab to
the application you want:

» Press Tab to sequentially highlight each open
application (they’ll be in order of most
recently on down). Each time you press Tab,
the next application is selected.

In Figure 24-2, the Finder is highlighted.

AR W@ B K 5 o

* Figure 24-2: The currently highlighted icon is surrounded
by a white border and displays its name
beneath it.

Using the 38-Tab technique cycles through the
open applications in the order of most recent
usage. The application that you were using
before the current, active one is highlighted
first . . . then the one before that and so forth.
If you just want to switch back and forth
between two applications, quickly press and
release 38-Tab once.

» To select an application in reverse order,
press Shift-Tab.

4. After you highlight the application that you
want to switch to, release the 3 key to make it
active.

To abort the application switching, press the
Escape key at any time while still holding
down the 88 key.

Mac OS X also has a nice variation on the 38-Tab
trick that uses the mouse.

1. Press and hold the $ key.

2. While continuing to hold down the 8 key,
press the Tab key once to bring up the list of
open applications.

3. While still holding down the 3 key, move your
cursor over the application that you want to
switch to (it’s highlighted).
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4. Release the 38 key to make that application
active.

E/ Use the cursor with 38-Tab to quickly access
s> («a another application. If you have a dozen or so
& applications open, this might be faster than
continuing to press Tab until you reach a more
latent app.

Alternatively, these keyboard shortcuts work after
you press 38-Tab once, while continuing to hold the
88 key:

v Press the End key to go to the last item.
v Press the Home key to go to the first item.

v Press the tilde (~) to go backwards (same as
88-Shift-Tab).

The other preferred method for switching among
open applications is to use Exposé. Technique 15
covers this tool in detail, but here’s what you really
need to know:

v Exposé shows all the windows (either docu-
ments or Finder windows) for every open and
unhidden application with just one keystroke
combination or hot corner. (The keystroke or hot
corner varies, depending on how you’ve set your
preferences.)

v Exposé shows all the windows for the currently
active application with a different keystroke and
hot corner.

v A third key combination or hot corner takes you
to the Desktop.

v A fourth key combination shows you the
Dashboard (see Technique 15).

Although Exposé focuses on windows and documents,
it can easily be used to switch from one application to
another. Just do this:

1. Trigger Exposé by using the key combination
or hot corner to bring up every non-hidden
document or window (see Figure 24-3).
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* Figure 24-3: Every visible document and window is
revealed by Exposé.

2. Move the cursor over each document image to
view its name (see Figure 24-4).

@ Word e 05 Veew e Fomal Fom Tosh Tabk Window e Fels

¢ Figure 24-4: When you hover the mouse over a
document, its name becomes visible.

3. After you select the document in the applica-
tion that you want to switch to, click the docu-
ment with your mouse button or press the
spacebar.

Technique 24: Switching, Hiding, and Quitting Applications

By using the mouse, two other easy ways to switch
from the current application to another are available:

v Click the second application’s icon in the Dock.

v C(lick a visible window (for example, a document)
in the second application.

Switching apps with shareware

If you want validation that switching among open
applications is a critical concept, just look at the
number and variety of third-party applications
designed for this very purpose. A quick search on
VersionTracker reveals many utilities, such as
LiteSwitch X (www.proteron.com/1iteswitchx, $15).

The following applications aren’t necessarily switch-
ers. They’re actually advanced launching tools that
allow you to assign keys to open particular applica-
tions. Because of this, they can also be used to
switch to another application:

v LaunchBar (www.obdev.at/products/launchbar,
$20 for personal use, free for limited use)
v DragThing (www.dragthing.com, $29)

v Keyboard Maestro (www.keyboardmaestro.com
free for the Lite version, $20 for the full)

v QuicKeys (www.cesoft.com, $100)

We discuss these programs and others, partic-
ularly LaunchBar, in more detail in Technique
23 and elsewhere in the book. Google or

VersionTracker turn up many launching and
switching applications for your consideration.

Hiding Applications

Being able to hide an application is a more impor-
tant concept than you might initially think. Hiding or
minimizing an application that you're temporarily
not using makes for a less cluttered Mac, which
makes you more productive.



- 2ﬂ Hidden applications appear in the 88-Tab appli-
A cation listing but not in Exposé.

Here are several ways to hide active applications:
v While the application is active, press 8-H. This

works for most, but not all, applications.

v While the application is active, choose Hide
ApplicationName from the application’s menu
(see Figure 24-5).

About BBEdit

Preferences 3,
Set Menu Keys...
Enter Serial Number...

Services [ 3
Hide BBEdit H#H
Hide Others THH
Quit BBEdit #$0Q

* Figure 24-5: Every application should have a Hide option.

v While in any application, click and hold on
another application’s Dock icon (see the BBEdit
icon in Figure 24-6). Then choose Hide from the
contextual menu that appears.

v While in most applications, press 38-Option-H to
hide every other application. You can also hide
every other application by using the Hide
Others option in the application menu (refer to
Figure 24-5). Hiding every application but the
currently active one really cleans up your
screen. It’s very helpful when your active appli-
cation has a lot going on (like many windows,
palettes, and documents).
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v [ new_in_tiger.txt

Keep In Dock
Open at Login
Show In Finder

Hide
Quit
By
a

* Figure 24-6: You can hide applications that aren’t even
active just by using the Dock.

If you're switching to another application, you
can hide the application that you're currently
in by holding down the Option key while
clicking the second application’s Dock icon or
document window. If you hold down both the
& and Option keys while clicking, every other
application is hidden.

v Press and hold down the 38-Option keys while
clicking the Desktop or the Finder icon in the
Dock to go to the Finder and hide every other
application.

You can also hide an application by using the 38-Tab
switching technique:

1. Hold down the 38 key and press Tab once to
activate the switcher.

2. Highlight the target application with one of
these actions:

» While still holding down the 8 key, press Tab
(or press Shift-Tab) until the target application
is highlighted.

» Put the cursor over the icon.

3. While still holding down the 3 key, press H.

)

Release the 88 and H keys simultaneously.
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Ouitting Applications

You might be thinking, “Why do I need to read about
quitting applications? I know how to do that.”
Although you probably know at least one way to quit
your applications, you might not know the easiest or
best way. Here’s a quick rundown of your options:

v While the application is active, press 8-Q.

v While the application is active, choose Quit from
the application’s menu.

v While in any application, click and hold the appli-
cation’s Dock icon (see Figure 24-7). Choose Quit
from the contextual menu that appears.

v | BBEdit User Manual.pdf (348 pages)

Keep In Dock
Open at Login
Show In Finder
Hide

Quit

@‘ /j}' U E

* Figure 24-7: Every application provides a Quit option in
the Dock’s contextual menu.

You can also quit an application by using the 88-Tab
switching technique:

1. Hold down the 88 key and press Tab once to
activate the switcher.

2. Highlight the target application with one of
these actions:

» While still holding down the 38 key, press Tab
(or press Shift-Tab) until the target applica-
tion is highlighted.

» Put the cursor over the icon.
3. While still holding down the 38 key, press Q.

Release the 38 and Q keys simultaneously.

)
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Force-quitting

If an application is stuck, quitting it the usual way simply
won’t work. Instead, you need to use Force Quit. You can
force-quit an application in either of two ways:

v Press 38-Option-Escape to bring up the Force Quit
window.

v Choose Relaunch from the contextual menu. You can
bring up the contextual menu either by holding
Option-Control and clicking the Dock icon or by hold-
ing the Dock icon and pressing the Option key.

Fortunately, applications rarely freeze up, so you shouldn’t
need to use these techniques very often.

Logging Out and Shutting Down

The most drastic way to quit every application is to
log out, restart, or shut down your computer. If you
choose one of these options, Tiger automatically
closes every open application, assuming you don’t
have unsaved documents still open.

v Pressing 88-Shift-Q logs you out but asks you for
confirmation (see Figure 24-8).
v Pressing 8-Option-Shift-Q logs you out without

asking for confirmation.

If you log out with Fast User Switching, all your
applications remain open.

; Are you sure you want to quit all
| applications and log out now?

‘*;;}" If you do nathing, the system will log out
automatically in 120 seconds.

(" cancel "_,I (—l:ag-ﬁut—)

* Figure 24-8: You can avoid the confirmation prompt by
holding down the Option key when logging
out.
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efficiently, and this number increases tenfold if you add third-party

tools such as LaunchBar to the mix. In this technique, you see sev-
eral ways to achieve the same end result. Like most timesaving techniques,
many options are available; it’s really up to you to determine which works
most efficiently for your computing habits.

The Macintosh operating system has many ways to open your files

Opening Files with the Finder

As you probably already know, you can open any file by double-clicking
it, in which case it automatically opens by using the default application
for that particular file type. If you’d rather open the file without your
hands leaving the keyboard, press 38-O instead.

7 If you use an input device with programmable buttons (such as a
- (ﬂ trackball or a multi-buttoned mouse), program one of the buttons to
& behave as a double-click. This button saves a step (literally a click)
whenever you need to open a file. Check the software or manual that
came with your input device to see whether it's programmable — and
if so, how.

Entering a file?

Here’s one place where we think Windows users have an advantage. To open a file
in Windows, a user simply selects the file and then presses Enter (the Mac Return
key equivalent for PC users). When Mac users press Return, they can rename the
file. This makes little sense because, frankly, files are opened much more often than
renamed. But we'd be surprised to see Apple make this change — and the conces-
sion to Microsoft — after so many years.

However, clicking once on a file and pressing Return is the fastest way to rename it.
The alternative — clicking once on a file, and then clicking again on its name but not
so quickly as to be a double-click — is much slower and often inadvertently opens
the file.
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Opening Files with Specific
Applications

Double-clicking a file in the Finder usually works just
fine for opening files, particularly when the file is set
to open in the application of your choosing. However,
the default application often isn’t the one that you
want to use in a specific instance. For example, you
might normally open HyperText Markup Language
(HTML) files in Safari, but maybe you want to edit a
particular HTML file in BBEdit. Likewise, images open
in Preview by default, but maybe you want to use
Adobe Photoshop to tweak a particular image. Here
are some steps to automatically open files with a spe-
cific application. At the end of this technique, we
reveal how to set the default application for a file or a
file type. This is helpful if you often need to change
the application used to open a type of file.

Using the Finder Window toolbar to open files

In Technique 12, we demonstrate the how’s and
why’s of tweaking the default Finder window setup.
One recommended addition is to put the most com-
monly used applications there (see Figure 25-1). This
makes opening a file with that application a simple
case of dragging and dropping the file onto the icon.

808 4 larryullman o ‘

[« »|[s]= m][ 2] ou“{b'@é@w -

* Figure 25-1: By placing an application in the window’s
toolbar, you can quickly open a file by
dragging it onto the icon.

A neat trick that results from Tiger's window
structure is that the folders in the Sidebar
spring open if files are held over them.
Therefore, you can drag a file onto the
Applications icon, which in turn opens the
Applications directory. Then you can drop the
file directly onto the appropriate application.

Using the Dock to open files

Another easy method of opening a file with a partic-
ular application is simply to drag the file onto the

application’s icon in the Dock. For this method to
work, the application must either

v Permanently reside in the Dock

v Beopen

Technique 13 provides guidelines for creating
an efficient Dock.

Out of kindness (or maybe insolence), the
Dock tries to make room for the files that you
drag there, moving your application’s icon out
of the way in the process. To prevent this
behavior, hold down 38 while dragging your
files, and the Dock remains motionless.

Using Favorites to open files

If you place a link to your Favorites in the window’s
toolbar, you can pop that open and find your
favorite application, just like we suggest you can by
using the Applications folder. (Technique 17 shows
how to set up your Favorites folder to contain your
most-often-used applications, files, and folders.)

The spring-loaded folder technique works with
folders in the Sidebar but not with those in the
Dock. So although you might keep the
Favorites folder docked, trying to drag a file
onto it doesn’t work.

If you haven’t yet customized your Favorites
@ folder, run — don’t walk — to Technique 17
and do it now.
Opening files with a contextual menu

This method of opening a file in a specific applica-
tion is perhaps the best. Control-click a file’s icon,
and you’re prompted by a contextual menu that
offers a list of common actions that you can do with
the file, such as get info about it and archive the file
(see Figure 25-2).
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¢ Figure 25-2: A contextual menu provides quick access to
a wealth of common tasks.

One of these menu items, Open With, gives you
immediate access to other applications with which
you might want to open the file. The resulting sub-
menu (see Figure 25-3) lists the current default
application at the top along with the other poten-
tial candidates. If the application that you're look-
ing for isn’t listed, choose Other (at the bottom)
and use the resulting Open dialog to find and select
the right app.

- recommend programming one of the buttons
as a Control-click, allowing you to access a
contextual menu with just the one hand. By
default, most two-button mice use the right
button (also referred to as the second mouse

button) as a Control-click.

2 If you have a programmable input device, we
)

&
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* Figure 25-3: The Open With submenu lists logical choices
for handling a file.

Using LaunchBar

LaunchBar (www.obdev.at) is far and away one of our
favorite third-party applications for the Mac. Its ease
of use, impressive speed, and very reasonable cost
($20 for personal use; free for limited use) make it a
must-have in our minds, particularly if you want to
shave seconds off common tasks. By following these
steps, it can quickly open files in the appropriate
application:

1. Press 3-spacebar to activate LaunchBar.

2. Type the shortcut for the application that you
want to open a file with (the keys you enter will
appear in LaunchBar’s prompt).

In this example, the letter B represents BBEdit
(see Figure 25-4).
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* Figure 25-4: The first two steps in using LaunchBar bring
the required application to the launch pad.

3. From the Finder, drag the desired file onto the
launch pad.

4., From the pop-up menu that appears, select
Open with Application (in this case, Open with
BBEdit; see Figure 25-5).

L {#* Dropped File: Technique ... @ -|

Put on the bar g1 jications M
Add to configuration  F2 g oo

. i 2l Utilivy
Open with BBEdit F3 B Acsistant — Api~

¢ Figure 25-5: LaunchBar offers three choices of actions
after you drop a file onto it.

L/ Set LaunchBar to automatically open a file
e  -a) dropped onto it instead of presenting a list of
& options. To set this preference, click the Drag
& Drop tab under the LaunchBar preferences
and use the pop-up menus found there.

Opening Files within an
Application

If you have an application open, you can expedite
opening files from within it. For starters, every appli-
cation uses the 88-O shortcut to bring up the Open
dialog (shown in Figure 25-6).

The standard navigational keyboard shortcuts (such
as 88-D for the Desktop) work within the Open dialog.
You also can click the folders and files in the Sidebar
for immediate access to commonly used directories.

O Open: Microsoft Word
Enable: | All Office Documents s j
=|m "' Documents ) Q search
@m;;;k | ® E'I'Jesktop | L Microso...ser Data |
Network '
=} Hard Drive [ ¥ Library P
@ larryullman # Movies ]
\y Office 2004 - & Music ’
5 - Pictures L
A Applications o 3 Public )
|7 utilities 23 Sites \
A larryullman
' Favorites
[@E Desktop
% Documents h f 4
B Fietores < [ — I
Open: | Original | :]
l:_ New Folder ";l |;" Cancel ','l Open
Y

¢ Figure 25-6: Microsoft Word default Open dialog.

If using list view is more natural to you than
column view, click the list view icon in the dia-
log. (Unlike Finder windows, Open dialogs
don't offer an icon view option.)

7 A few shareware applications allow you to set
the default folder for applications to use (such
& as Default Folder X; www.stclairsoft.com/
DefaultFolderX/index.html, $35). Using
one of these saves you from navigating to the
appropriate folder when opening or saving
a file.

7
)

Many OS X applications include their own tools for
finding files more quickly. In Microsoft Word, you can
click the Find File button at the bottom of the Open
dialog (in older versions of Word) or the Search win-
dow (in Office 2004) to help locate the file. BBEdit
provides an Open File by Name option (under File)
that locates files for you.

Recalling Recent ltems

After you access a file, it becomes much, much eas-
ier to bring it up again. Tiger has (or can have) a
memory of your actions in the Recent Items menu,
found in the Finder and in many applications.



Recalling files from the Apple menu

The Apple menu has gone through many changes
over the years. In OS X, it’s more or less off-limits to
user customization. However, one tweakable feature
that remains is the Recent Iltems submenu (see
Figure 25-7).
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|7 Technique 23talu.doc
M yscanx

Clear Menu

* Figure 25-7: The Apple menu can track recently used
applications and files.

The number of items listed here can be set from the
Appearance System Preferences panel (see Figure
25-8). You can have your Mac show up to 50 recent
documents and 50 recent applications. The Apple
menu keeps each type of item (applications, docu-
ments, and servers) separate and also lists them
alphabetically (not by date or by time).

Recalling Recent ltems 195
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¢ Figure 25-8: Set how many recent files and applications (if
any) are remembered from the Appearance

panel.

If you don’t use many applications and have
your Dock, Finder toolbar, and Favorites well
organized, you probably won't need to recall
recently used applications. If that's the case for
you, set this value to 0 (zero) in the Appearance
System Preferences panel and save the valuable
Recent Items real estate solely for files.

One caution about using the Recent Iltems menu:
Tiger can’t track files that you open through certain
methods. For example, Tiger records something
opened from the Finder or by using an application’s
Open option, but it most likely doesn’t notice a file
that you open by using an application’s Recent Files
menu (see the next section).

Recalling files from application menus

This might be a chicken-or-egg debate, but either the
Apple menu inspired similar behavior in many appli-
cations, or vice versa. Regardless, most of Tiger’s
commonly used applications include their own
Recent Items menu. Examples include BBEdit,
Acrobat Reader, and Photoshop. Usually, you find a
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Recent Items (or similarly named) submenu listed
under the File menu. Some applications, such as the
Microsoft Office products, just list the recent files at
the bottom of the File menu instead.

Setting the Default Application
for Files

The default application to be used when opening a
file is indicated by the file’s icon in the Finder. Each
application has its own look for corresponding files.
As usual, double-clicking (or using the keyboard
equivalent, 8-0) automatically opens the file in the
assigned application. But what if you want to change
the default application? In Tiger, you can manage file
types by using the ubiquitous Get Info window by
following these steps:

1. Select the file in the Finder.

2. Click the file and press $8-I (or choose Filer>Get
Info) to bring up the Get Info window (see
Figure 25-9).

3. Click the arrow next to Open With to expand
that panel, if it isn’t already visible.

Reach the Get Info window by Control-clicking
the file and selecting Get Info from the con-
textual menu that appears.

4. Select the default application to use from the
pop-up menu.

If the application isn’t already listed, select Other
at the bottom and navigate to the appropriate
application.

5. (Optional) Click the Change All button to set
this application to always open files of this par-
ticular type.

® O M new_in_tiger.txt Info
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new_in_tiger.txt
Modified: Jan 26, 2005 12:54 PM
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w General:

Kind: Plain text document
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Created: Thursday, September 2, 2004
1:13 PM

Modified: Wednesday, January 26, 2005
12:54 PM

Color label: (x| & @ B B

| Stationery Pad

| Locked

P More Info:
B Name & Extension:

¥ Open with:

/ TextEdit f

A
e

Use this application to open all [
documents like this.
Change All

b Preview:

P Ownership & Permissions: ,

* Figure 25-9: The Finder’s Get Info window details — and

allows you to administer — a file’s properties.

If you have only a file or two that should
always be opened with a specific application
(such as a really large PDF that you want
opened with Acrobat Reader instead of
Preview), don't click Change All in the Get Info
window.

A few applications — Adobe Acrobat Reader
and Microsoft Internet Explorer, just to name
two — can automatically associate certain file
types with themselves. Peruse the application’s
Preferences for the appropriate setting.
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¢ Figure 26-1: Tiger’s Save As
sheet as it appears

in Microsoft Word.

Saving and Printing
Files

his part of the book is all about your applications — not what they
specifically do, but those common elements that you’ll run across in
every application. This includes saving and printing your documents.

Although you probably know what you're doing when it comes to these
issues, in this technique you might find a better way to do those common
tasks. We begin by discussing how to navigate and use Save dialogs
quickly. Then we go into printing your documents. Finally, we cover how to
turn any document into a PDF file, which is a widely accepted file format
for sharing documents on Macs and PCs alike.

Saving Files

Regardless of what application you're using, when you go to save an unti-
tled document, you're presented with a Save As dialog. (See one in Figure
26-1.) The Save As dialog appears as a sheet, meaning that it drops down
from the top of the document window.
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Format: Word Document |-¢-]
Description
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Windows, and Word 98 through Word 2004 for Mac.
Learn more about file formats
# Append file extension
(Options... ) (_ Compatibility Report... ) | Compatibility check recommended
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The keyboard shortcut for Save is 88-S. Some
applications have a shortcut of 38-Shif